Assessment User Guide

e Synergy

Education Platform

Edupoint’
N



The Edupoint software and any form of supporting documentation are proprietary and confidential.
Unauthorized reproduction or distribution of the software and any form of supporting documentation is strictly
prohibited and may result in severe civil and criminal penalties.

Information in this document is provided in connection with Edupoint Educational Systems, LLC. products. No
license to any intellectual property rights is granted by this document.

The screens, procedural steps, and sample reports in this manual may be slightly different from the actual
software due to modifications in the software based on state requirements and/or school district
customization.

The data in this document may include the names of individuals, schools, school districts, companies, brands,
and products. Any similarities to actual names and data are entirely coincidental.

Copyright © 2015-2019 Edupoint Educational Systems, LLC.

Edupoint, Synergy Student Information System, Synergy Special Education, Synergy Assessment,
TeacherVUE, LessonVUE, StudentVUE, and ParentVUE are registered trademarks of Edupoint Educational
Systems. Inspect is a registered trademark of Key Data Systems. Google and the Google logo are registered
trademarks of Google Inc. Apple and iPad Pro are trademarks of Apple Inc. Microsoft and OneDrive are
trademarks of the Microsoft group of companies.

Other names and brands may be claimed as the property of others.

Copyright 2015-2019 Edupoint Educational Systems, LLC.



Assessment User Guide | 3

About This Manual

Edupoint Educational Systems, LLC. develops software with multiple release dates for the software
and related documentation. The documentation is released in multiple volumes to meet this
commitment.

This document serves as a reference for Edupoint's recommendations and Best Practices for
Synergy processes. Due to the complex nature and myriad configurations possible within the
Synergy software, it is not feasible to include every possible scenario within this guide.

Conventions Used in This Manual

« Bold indicates user interactions such as a button or field on the screen.
« [talics indicate the option to select or text to enter.
« Notes, Tips, References, and Cautions appear in the margin to provide additional information.

{ N )
Notes provide additional information O T'ES suggestfadvanceipptlzns or
about the subject. w ot er ways of approaching the

subject.

\. J \. S

{ N/ N
References list another source of Cautions warn of potential problems.

information, such as another manual Take special care when reading
or website. these sections.

7 N\ 7

Before You Begin

Before installing any of the Edupoint family of software products, be sure to review the system
requirements and make sure the district's computer hardware and software meet the minimum
requirements.

Copyright 2015-2019 Edupoint Educational Systems, LLC
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Software and Document History

Document Release Software

Version Date Release POCET
Updates:

« Creating Assessments
« Updated the Settings information
« Updated Assessment Items information

« Creating Items - Added Item Types

« Scheduling an Assessment:
« Updated Instance Settings

20 May 2017 2018 « Updated Grade Book Settings

« Viewing Student Assessment Results

« Added instructions for overriding a student's
score

« Added Exporting Student Results

« Added Exporting Student Responses to
Constructed Response Items.

« Previewing Assessments - Added Print Options.

« Passages - Added filters.
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Document Release Software Describtion
Version Date Release P

8.0

Dec 2017

2018.01

Updates:

« Reorganized order of chapters and topics.

« Updated Creating Assessments for Assessment Info,
Sharing, Settings, Accommodations, and Attributes

« Updated Scheduling an Assessment for
Accommodations, Item Detail Options to exclude
student responses, and unlocking an assessment
marked complete

« Updated Formatting Window with new functionality

« Updated Viewing Assessment Results

« Updated Viewing Student Assessment Results
including additional print options when printing student
results and SBAC Claims and Targets

« Updated Viewing Teacher Assessment Results
including SBAC Claims and Targets

« Updated Viewing School Assessment Results including
SBAC Claims and Targets

« Updated Creating Items and Adding Items to an
Assessment with a note about how Assessment
handles previous standards.

« Added using custom attributes to Creating Items

« Added Quick Assessments to Creating Assessments

« Updated Working with Responses for Constructed
Response items

« Added Taking Assessments
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Document Release Software Describtion
Version Date Release P

Updates:

« Added Logging into Assessment and updated topics with
the Synergy SIS navigation to Assessment screens for
support staff

« Updated Taking Assessments for Launching
Assessments in Chromebooks and Full Feedback in
Viewing Assessment Results and History

« Updated Scoring Constructed Responses for new layout
« Added Test History Analysis

« Updated Creating Items with new functionality and
9.0 Jun 2018 2019 removed Short Answer

« Moved Item Bank filters from Creating an Item Bank to
Assessment Filters

« Added Previewing Items in a Bank in About Item Banks

« Updated Working with Responses and Viewing Student
Assessment Results for additional Print Options.

« Added Assessments
« Added Viewing Test History

« Added Moving Assessments to a Bank to Creating a
Bank

« Added Piloting Items in Creating Assessments

Edupoint Proprietary and Confidential
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Document Release Software Describtion
Version Date Release P

Updates:

« Added functionality to Working with Transferred
Students

« Added teacher and school functionality to Analysis
Basics

« Added gap functionality to Analysis Basics
« Added functionality to Viewing Assessments

« Added Score Lock functionality to Text Entry and Inline
Choice

« Added Underscript to Formatting Window
« Added Passage options to Printing Student Results

« Added Link Assessments to Grade Book Assignments
functionality to Pushing Scores to Grade Book

« Added Connecting Assessment Scores to Assignments
to Viewing Student Assessment Results

« Added filter functionality and new display functionality to
Using the Assessments Screen

« Added Using the Student Activity Log to Working with
Responses

« Added Editing Bank Details Using View All to Using
Item Banks (renamed from Creating an Item Bank)

« Added Using View All or View Just Mine
« Added Using Scoring Bands

10.0 Dec 2018 2019.01

« Added Preferred Score Type to Viewing Scheduled
Assessments, Viewing School Assessment Results
(District Users Only), Viewing Student Assessment
Results, and Viewing Teacher Assessment Results
(District Users Only)

« Added Text Drag and Drop and Key Data Systems
Integration to Creating ltems

« Added additional detail options to the Assessment
Results screen in Viewing Assessment Results

« Added Connecting to Test History to Test History
Analysis

« Added Reports chapter

Copyright 2015-2019 Edupoint Educational Systems, LLC
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Document Release Software
Version Date Release

11.0 Jun 2019

2020

Description

Updates:

Updated Viewing Assessment ltems

Added a tip to Viewing Passages

Updated Graphic Drag and Drop

Updated Hot Spot

Updated Creating Quick Assessments and added
Student Testing

Added a note about Text-to-Speech functionality in
Creating Full Assessments

Added Alternate Pronouncing to Formatting Window

Updated Student Access in District Users
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Overview of Synergy Assessment

Synergy Assessment allows school administrators and teachers to build, manage, and deliver
formative and summative classroom assessments online.

You can:

« Create new assessments with standards-aligned items such as True/False, multiple-choice,
single answer, and essay items. Answers to short answer items can be scored automatically;
however, the teacher or admin user scores constructed response items.

« Monitor assessments, schedule future assessments, and access real-time performance data
from the Assessment Dashboard.

« Create breakout groups directly from the Assessment Results screen.
Because Synergy Assessment is fully integrated across the Synergy Education Platform,

assessments are built directly from Grade Book, delivered to students within the StudentVUE
module, and centrally stored for district-wide access.

You can view assessment scores in the Grade Book alongside assignments, quizzes, and tests,
making it easier to recognize performance patterns and adjust instruction to meet your student’s
needs. Assignment scores are available in ParentVUE and StudentVUE.

The main functions within Synergy Assessment are:

« Dashboard — Allows the user to view a list of scheduled assessments to be taken by students
and view more details about an assessment. It also reports overall data on completion of the
assessment.

o Assessments — Allows the user to view or schedule assessments available to them and to
create or edit assessments.

« Items— Allows the user to view items (questions) available to them and to create new or edit
items.

« Passages — Allows the user to view passages available to them and to create new passages.
« Item Banks — Allows the user to view item banks visible to them and to create new item banks.
« Item Grading — Allows the grading of Constructed Response items answered by students.

é )
The focus selector is not used with Synergy Assessments.

Synergy* Home -  Streams
TeecherVUE
E Dashboard
1 (¥R} Growan, R 1/2 Multi-Age(0-8) SEC:2nd grd-001 / Q3 ~
TeacherVVUE Screen
\ J

Each module has filters to locate assessment items and information easily.

-
E The filters remain set while the user is logged in.

\. J/

Copyright 2015-2019 Edupoint Educational Systems, LLC
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Logging in to Assessment

How you log in to Assessment depends on your role.

» Teachers and Staff with TeacherVUE access — Log in to Assessment through TeacherVUE.

See the Synergy SIS - TeacherVUE User Guide for login
L] .
instructions.

« Support staff who do not have TeacherVUE access — Log in to Assessment through
Synergy SIS.

Staff without TeacherVUE Access

1. Enter your Login Name and Password.
2. Click Login.

A

Demo School District

Excellence In Education

Please enter your login name and password
below to access the application.

Login Name

| LLogin Mame

Password

Substitute Teacher Login

@ Synergy Contact Us | Check For Popup | Add Thie Page fo My Favorites Edupoi nt"

Copyright & 2002-2015 Edupoint Educational Eystems. Al rights reserved.
Education Platform

Synergy Log In Screen

3. Navigate to Synergy SIS > Assessment > Assessments to view the Assessment screen.

Edupoint Proprietary and Confidential
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Assessment Filters

Item Filters

To help manage finding items that are in the Item Bank, use filters for selecting a item in the ltem
Bank or an Assessment. Some screens have a different filtering look, but the method is the same.
When you select filters on one screen, they remain selected on other screens.

Clear Filters CETlAER
System &
System Bank ID %
Bank % Grade % Evact Match

ck to Search - Click to Search Bank Name %

Depth Of Knowledge ®  Paper/WWeb X
to Seardh + | | click to Search - Assessment ID X

AudioMideo ¥ ltem 1D %
Assessment Name %

Import ID % Item Type % Assessment Creator %

Status % Course % Schedule Status %
Reserve ltems %
Subject % Paszage Title % __ .
Imported ¥
Standard Code ¥ Standard Tree % lick to Search -
Shared %
ltem Preview % Promotion Status % lick to Search -
- Subject %
Equation Tool ¥ Click to Search -
ck to Search - Grade %
District Created Click to Search -
Level X Text Property % Course X
Bank Screen
Assessments Screen

District Created filters are functional when users have defined District
E Properties for items.

Imported filters are functional when you are using an imported item bank.

« Select afilter and drag it to a new location

« Click * to hide the filter. You can still search using the hidden filters and any selections made
from hidden filters show at the top of the list.

« Click * to clear afilter.

Copyright 2015-2019 Edupoint Educational Systems, LLC
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o Click ﬁ' to view the Hidden Filters. Click ¥ to return the filter to the list.

System &

Sl

Hidden Filters€

ltem 1D 4+

Item Bank Screen

« The Smarter Balanced Assessment Consortium (SBAC) filters display if the district uses

INSPECT ltem Bank:

« SBAC Claims — One overall claim encompasses the entire content area and specific

content claims at each grade level within mathematics and ELA/literacy.
« SBAC Content Categories — Sub categories to SBAC Claims.

« SBAC Targets - Maps Common Core State Standards onto assessment evidence

that is required to support the SBAC Claims and Content Categories.

[\
You can filter INSPECT items by Subject and Grade.

Other Filters

Assessment filters help you narrow results when viewing assessments in the Assessment

Dashboard screen.

Filters
Nams v
Owner v
Access v
Settings
Limit Teacher Sharing € oN

Update Advanced Answer Data

Filters £

Exact Match
Schedule ID
Assessment ID
Text Search
Assessment Name
Math Q
Schedule Name

Q
Start Date

Q
End Date

Q
Select Search
Schedule Level
Scheduled By
Subject
Grade
Course

Clear
Active Filters
Assessment Name: Math
Dashboard Screen

Item Bank Management

Edupoint Proprietary and Confidential

Filters
F‘_assaule 1D

Import Identifier

Title

Passapge

2 £ L L

Bank

Lexile Range

Flesch-Kincaid Grade Level

Assessment Passages Screen




o Click 'a' to define the filters that display by selecting the options.

Filters £F

Exact |# assessmentID
?cheﬂ_u_le_ # Schedule ID
~ " @ Assessment Name
Assessm
Evact Mal © Schedule Name
# Scheduled Start
Text St seheduled Ena
Assessm g gohedule Level
Math |
¥ Scheduled By
Schedule
| ¥ Grade Level
Start Dats ¥/ Subject
oy
End Date

a

Dashboard Screen

Assessment User Guide
Chapter 1: Overview

. Select the filters to use and click & The list automatically updates when the filter is applied.

+ Clear the field and click Q to remove the search criteria.
« Clear allfilters by clicking Clear in the blue filter box above the list.

Active Filters

Item Bank: Edupoint TEI

| Clear

Assessment Items

E You can filter INSPECT items by Subject and Grade.

19
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About Banks

Assessment items, passages, and assessments are stored in banks. Multiple banks may be
available for the district for each type of item that is stored. For example, the district may have:

« Purchased banks
« District created banks
« Teacher created banks

Items can be associated to standards that your state uses. These standards are imported to Grade
Book by the district. You can associate assessment items with specific courses and assignments
that pertain to specific academic standards.

When working with a purchased banks, you cannot change the imported items except to link
standards to the item. However, you can add and change items to the banks that you create.

Previewing Items in a Bank

When you view a bank, the items display in a locked item preview with the correct response
indicated by:

« A gray highlight for simpler items

Form 3 Question 1

o Answer A
b Answer B
G Answer C
Q Answer D

Item Bank Screen

« A green checkmark for more enhanced items

. A factored form of the function jix) is [le) = 3le — 2)(x +4) . What
Title Yes Mo are the zeros of e 7

Cats D : . o
L @B+ B+ o o0

Dogs,] 4 A 2 <A1 0 1T 2 3 4

1

Item Bank Screen

Copyright 2015-2019 Edupoint Educational Systems, LLC
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« Boxes with point values for Graphic Drag and Drop Item Types

Answers

\ Parietal Lobg | +1

Tempecral Lo

Occipital Labé [ +1

Item Bank Screen

« Yellow boxes with point values for items with advanced scoring that are not Graphic Drag and
Drop Iltem Types

Match the dog name to the owner

Leia Maizey Milo

—j o 0
Ryan
o

Jason
0

Travis

Item Bank Screen

Edupoint Proprietary and Confidential
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Using Item Banks

Banks are repositories for items, assessments, or passages.

Creating a Bank

1. Access the Bank Details screen.

o Fromthe Assessment menu

a. Select Bank Management (Create & Edit Banks) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessment Banks.

Aszseszment » RTlI - Admin -

tem Bank (Create & Edit ltems)
Dashboard (Authorize Students & View Resuliz)
Azzessments (Create & Scheduls Azssssments)

Bank Management (Create & Edit Banks)

Constructed Response Grading
Passages (Create & Edit Passages)

Assessment Menu

b. Click+NEW.

o From the Assessments screen, select Bank from New.

List ¥ Asssssment ¥ m

Full Azsessment
& CQuick Assessment

Assessments Test History £ Settings

¥ Algebra | CCSS Summative Assessment
2015-2018

Aloabea | s ke,

al Assessment [D: 1011 ag io il Bank

il A SIlwan1n

Assessments Screen

2. Enter anltem Bank Name and Description.
Select Visibility. (District Users Only)
« Private —Visible only to the person who created the bank.
« Public—Visible to all users with access to Synergy Assessment.

4. Selectif the District Item Bank is shared so All District Admin users are treated as
owners of the bank. (District Users Only)

E This option does not display for imported ltem Banks.

Copyright 2015-2019 Edupoint Educational Systems, LLC
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Bank Details

Banks are storage containers for assessments, items and passages. Here you can create, edit, and share banks.

Date Created: Created before date tracking
Date Modified: Last medified before date tracking
Advanced Dats Run: Mo advanced data avsilable

Name

Display Name

Description

Visibility

Private ¥

District Admin Bank

All District Admin users will be treated as owners of this bank.

Sharing

To share this with other people in your district start by typing 8 keyword into the search box below. Results will appesr based on the keyword you
enter. Click the result or results that comespond to the group you would like to share with. The groups for school and grade level will be treated as
filters when other types are added. For example, if you want to share your page with the entire English department at your school site only, you
would type english in the search box, click English department from the results. Then type the first name of your school site in the search box and
select it from the results arsa.

Sharing Search Shared With

Search @ v x &

ent Groups, and Users

rades, Courses, Subjects, User

@

Item Bank Details Screen For District Users

Bank Details

Banks are storage containers for assessments, items and passages. Here you can create, edit, and share
banks.

Date Created: Created before date tracking
Date Modified: Last modified before date tracking
Advanced Data Run: No advanced data available

Name

Display Name

Description

Sharing

To share this with other people in your district start by typing a keyword into the search box below. Results will sppear based on the:
keyword you enter. Click the result or results that comespond to the group you would like to share with. The groups for school and grade
level will be treated as filters when other types are added. For example, if you want to share your page with the entire English
department at your schoaol site cnly, you would type english in the search box, click English department from the results. Then type the
first name of your school site in the search box and select it from the results area.

Sharing Search Shared With

Search @ T x i

Item Bank Details Screen For Teachers

Edupoint Proprietary and Confidential
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5. Set Sharing options:

a. Enter Search criteria. The list is filtered.

b. Make a selection.

c. Click ™ to set options that are available to user who have access to the shared ltem
Bank:
« Allow Editing — Users can edit the items already existing in the bank

« Allow Adding — Users can add new items to the item bank

Sharing

To share this bank with other people, start by typing a keyword into the search box below. Selectables results will appear based on the
keyword you enter. Click the result or results you would like to share with. The groups for school and grade level will be treated as filiers
they are added. For example, if you want to share your bank with an entire depariment at your school site only, you would type in the
name of the depariment and then click that depariment from the results. Then search for and select your school from the resulis arsa.

*fou may also grant each shared group or person editing and adding privileges to the bank. These groups will be able to add items to,
edit items within, and archive items within this bank. You may change this access at any time.

Sharing Search Shared With
Search € Government 3 i
Government Government Shared
Allow Editing @
Departments Allow Adding
Item Bank Details
( )

Allow users to share by the following options in Banks:

« School

o User Group
E » UserRole

« Grade Level

« Individual User

You can also share multiple assessments at the same time.

6. Click Save.

Copyright 2015-2019 Edupoint Educational Systems, LLC
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Moving Assessments to a Bank

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

RTl -~ Admin -

Assessment -

It=m Bank (Create & Edit liems)
Dashboard (Authorize Students & View Resulis)

Assezsments (Create & Scheduls Azzsssments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Lomsomprbmm

Assessment Menu

2. Select List and Grouped.
3. Select a Bank to view the assessments in the bank.
4. Move the assessment.

« Use Move to Bank to move one or more assessments at one time.

You can only move assessments that are in folders that you
own ( i').

a. Select the assessments to move in a folder. The selected assessments highlight
in green.

b. Select the bank to move the assessments to in Move to Bank. The
assessments move immediately into the selected bank.

Edupoint Proprietary and Confidential

Assessments  TestHistory  &F Seftings List ¥ | Groupsd | Move to Bank... v | m
Move to Bank...
Sort by ID | Sort by Name ¢ Inspect liemBank
— 1= Item Bank for Admin User
m Inspect ltemBank Bank I 2 Test Jptionz -
-— . Test
Ml |tem Bank for Admin User BankID: 3 e Options =
il Test Bank ID: & 1 Assessment Ootion: -
iTest BankID: 7 0 Azsessments Cotionz -
'®\/\ithout a Bank 213 Assessments
Sort by ID | Sort by Mame
% Algebra | CCSS Summative Assessment il Assessment I0: 1011 Qptions -
2015-2016
¥ Algebra | CCSS Interim Formative all Assessment ID; 1012 Options v
Assessment Green 2015-2016
% Algebra | CCSS Interim Formative all Assessment ID: 1014 Options ~
Assessment Pink 2015-2016
Assessments Screen
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« Usedrag and drop to move one assessment at a time.

Hover over the # for the assessment you want to move.

b. Drag and drop the assessment into a bank. The bank displays a green box
Assessments Test History £ Settings List ¥ Grouped v m
i Inspect ItemBank Bank[D:2 1 Assessment Options +
il Item Bank for Admin User BankID: 3 1 Assessment Optians =
Algebra | End-of-Year Assessment 2015-2016 [Bank1D:6 4 Assessment Options
Asgsessment ID: 1015
Optionz BankIC: 7 0 Assessments Options +
'®VVithout a Bank ) 210 Assessments
1o e
Assessments Screen
Editing Bank Details Using View All
( )

as owners of this bank option is not selected for the Bank.

Use this functionality when the All District Admin users will be treated

Bank Details

Banks are storage containers for assessments, items and passages. Here you can create, edit, and share banks
Dste Created: Created before date tracking

Date Modified: Last modified before date tracking

Advanced Data Run: No advanced data available

Name

Item Bank for Kathy Jackson

Display Name

Description

Visibility

Private ¥

District Admin Bank

# All District Admin users will be treated as owners of this bank.

Bank Details Screen

Copyright 2015-2019 Edupoint Educational Systems, LLC
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1. Login as an administrator.

2. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Assessment ~ RTlI ~» Admin -

Item Bank (Create & Edit liems)

Dashboard (Authorize Students & View Resulis)

Aszsezsments (Create & Scheduls Azzsssments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Creats & Edit Passages)

T}

Assessment Menu
Click View All to have access to assessments and banks based on applied security settings.
Navigate to a user with banks created.
Select the Bank Name to open the Bank Details.
Click Edit to modify the details of the bank viewed.

Bank Details (3]~

Banks are storage containers for assessments, items and passages. Here you can create, edit, and
share banks.

o ok~ w

Dsate Created: Crested before date tracking
Dste Modified- 12 Dec 2018
Advanced Data Run: Ne advanced data available

Name
Item Bank for Jeff Lewis
Display Name

Description

Bank Deletion

‘You cannot delete banks which you do not own.

Bank Details Screen
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7. Editthe Name, Display Name, or Description, if needed

8. Selecta Bank Owner to assign a different user.

[\
All ltems, Assessments, and Passages remain in the bank.

Name

Display Name

Description

Cordova, Katie

Bank for Katie Cordova

Bank Owner @

Admin Options

Bank Details Screen

9. Click Save to save the changes or click Return to go back to the Assessments screen.

Deleting a Bank

Deleting an Item Bank completely removes it from the database and removes any shared access. If
the Bank contains any items, they must be moved to another Bank before you can delete the Bank.

[\
Only the owner of the Bank may delete it.

1. Select Bank Management (Create & Edit Banks) from the Assessment menu or navigate to
Synergy SIS > Assessment > Assessment Banks.

- RTI =~

Item Bank (Create & Edit ltems)
Dashboard (Authorize Students & YWiew Results)

Aszessments (Create & Schedule Assessments)

Bank Management {Create & Edit Banks)

Constructed Response Grading

Paszsages (Create & Edit Passages)

2. Select the Bank to delete.

Assessment Menu
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3. Move items, if needed.

a. Select Item Bank to move the items to another Item Bank.

b. Click Move Items.

[tem Bank Deletion

items.

Select Item Bank

To delete this item bank, you must first move all items within. Select an item bank below and click the button to move these

Item Bank Screen

4. Click Delete this Item Bank.
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About Items

District users can create assessment items (questions).

« The district has the option of making the items available for use in assessments created by
teachers.

« The district can choose to not make the items available to teachers. Not allowing teachers to
view or use the items prevents the students from previewing district assessments.

« Any district staff with editing permission may change district created assessment items.

Teachers can create items that are different from the district items to use in their assessments.
Teacher can make their item banks visible to only them or to other teachers.

Item Details

When viewing items in an ltem Bank, the Item Details provide information about the item.

ltem ID: 148653

Version: 2

Owner: User, Admin

Bank: Edupoint ltem Bank
ltem Type: Multiple Choice
Subjects:

Grades:

Depth of Knowledge: 1. Recal
Language: English

Status: Live

Standards:

Render Engine: XML

Item Bank Screen

Display Mode

There are two display modes in Synergy Assessment: All and Simple. Each uses different methods
of navigation to move through the following sections to create an item:

Use the toggle switch on the right side of the screen to switch between display modes.

Display Mode: OR Display Mode: Simple

Assessment Item Creation Screen
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All

The All display mode allows the user to scroll through all of the components to create an item or
assessment. Navigation is available on the left hand side to jump to the various sections of an item.

X (S1) Jackson, K Psychology {1} SEC:0168 / Frogress Period 1 «

Important Settings

Important Settings

ltem Stem

Other Properties

Standards

Assessment Item Creation Screen

Simple

The Simple display mode allows the user to page through the components to create an item. There
is a separate screen for each section. The sections include buttons to move sequentially through the

creation components.

Creating Items

You can create items in an Iltem Bank or when creating assessments.

( B
If the teacher does not have an Item Bank when creating items, one is
created automatically.

Q The Assessment ltem window displays in Simple display mode when
creating items from an assessment. Click Add/New when you are

L finished entering the item. )

1. Select Item Bank (Create & Edit Items) from the Assessment menu.

Assessment ~ RTI - Admin -

tem Bank (Create & Edit ltems) L

| Dashboard (Authorize Students & View Resulis)

Azzezsments (Create & Schedule Az=essments)
Bank Management (Creats & Edit Banks)
Constructed Response Grading

Pasz=sages (Create & Edit Passages)

3o i

Assessment Menu

2. Click NEW.
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3. Complete the sections based on the information below.

4. Click Save when all sections are complete.

Important Settings

1.

Important Settings

Item Type

Muttiple Choice + 9

Bank Status Advanced Scoring (5] Total Points

ltem Bank for Admin User ¥ Live {Available for Use) v % Use Advanced Scoring

Assessment Item Creation Screen

Select the Iltem Type you are creating.

-
When a district creates the item, the district chooses whether the
teacher or district scores the response.

Some ltem Types are only for online assessments. A note displays
E in the description.

An Equation Tool selection tile displays when you select
Constructed Response and Text Item where you can select the
default Equation Tool that displays and you can Edit Equation
Tools.

\.

J

« Constructed Response — The student enters a short essay answer that a person

scores.

« Evidence-Based Selected-Response — EBSR items consist of two parts. where the

first item leads the student into the second.

Scoring for EBSR is unique in that if the student misses the

E first part, the entire item is scored as incorrect. Create EBSR
items using Multiple Choice, Multiple Select, and True/False
items.

o Graphic Drag and Drop — The student organizes items into Hot Spots. (Online
assessments only)

o Hot Spot— The student selects from spots on an image to answer the item. (Online

assessments only)

» Hot Text—The student is presented a writing sample where they are tasked with
selecting sentences or words based on a prompt you provide. (Online assessments

only)
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« Inline Choice — The student is presented a writing sample where they can make drop-
down selections from within the text. (Online assessments only)

o Matching — The student matches multiple responses to multiple statements.
o Multiple Choice — The student selects an answer from multiple possible answers.

o Multiple Select— The student selects all correct responses from multiple possible
answers.

« Multi-Part — Consists of two or more assessment items that are combined into a single
item.

« Use existing items from your item bank or construct new items.
« Each part can be assigned a different point value.
« Scores are combined for an overall score.

« Use this option to tied multiple items to a passage.

4 R
The assessment module defaults to a binary scoring structure.
As aresult, Multi-Part items score as Correct or Not Correct. If
the student answers one part of the item incorrectly, the entire
Multi-Part item is marked wrong.

N The district may enable partial credit scoring where you score
each part of a Multi-Part item independently.

If the student did not answer correctly, all parts and the full
item highlight in red. If the student receives full points, all parts
and the full item highlight in green. If the student answers only
some parts correctly, those highlight in green, the rest
highlight in red, and the full item has a gray highlight.

\.

o Number Line — The student interacts with a Number Line or plots points to create a Line
Plot. (Online assessments only)

« Select Point— The student selects a point on an uploaded image, selects points on a
coordinate plane, or creates lines, segments, rays, or shapes. (Online assessments

only)

o Text Drag and Drop — The student drags interactive text items into a sentence or
phrase. (Online assessments only)

o Text Entry— The student is shown blank spaces to complete. (Online assessments
only)
» True/False — The student selects if the statement is true or false.
2. Select a Bank to contain the question.
3. Selecta Status.

« Live—Available for use in assessments (Default setting)
« Draft—Not available for use in assessments
« Archive — Not available for use because they were intentionally disabled

4. Select Use Advanced Scoring to customize the point value for the possible responses.
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5. Enter the Total Points for the item. The defaultis 7.

( )
You can change the Points for a item when adding existing items to
an assessment.

True/False, Multi-Part, Text Entry, Hot Spot, Hot Text, or EBSR

E Total Points is available for Multiple Choice, Multiple Select,
Item Types.

Select Use Advance Scoring, if needed. Total Points no longer

. displays. See Advanced Scoring for more information. )

6. Selectthe Equation Tool students use to answer.

Defining Equation Tools

There are seven default Equation Tools with basic functionality. You cannot edit those default tools,
but you can create a copy and edit the tool.

1. Select an Equation Tool.
2. Click Edit Equation Tool.

Equaticn Tool €

Grade 3 ¥

Add Some Variable Buttons

7 8 9 =+ =&

4 x ()

1 2 3

0 o
> 0= <

Edit Equation Tools

Assessment Item Creation Screen

Edupoint Proprietary and Confidential



Assessment User Guide 37
Chapter 3: Create Items

3. Click Create a New Equation Tool based on this tool.

Equation Tool Setup

Equation Tool

Grade 3 T

Equation Tool "Grade 3"

Iput Preview

Equation Tool

Primary
« » o @&
7 8 9 £ H
45 x ()
1 2
0 -

> = <

Edit this eguation tool. &

I Create a new equation tool based on this tool. I

Browse/Edit Bution Functions Browse/Edit Key Bindings

Assessment Item Creation Screen

Copyright 2015-2019 Edupoint Educational Systems, LLC



Assessment User Guide

38 Chapter 3: Create Items

4. Modify the Equation Tool.

"la After you copy an equation tool, you click Edit this equation tool
==t/ to modify the copy of the tool.

« Change the Equation Tool name, if needed.
« Dragthe desired Available Buttons to a key location.

« Usethe =~ and toaddandremove rows and columns as needed.

« Hoveranduse * toremove keys.

« Click Browse/Edit Button Functions and Browse/Edit Key Bindings for more
information.

Equation Tool Setup

Equation Tool
Grade 3 v

Equation Tool " Copy of Grade 3 "
Toal Available Buttons

| | Absolute Value
= | Approximate
Equation Tool

arcees ArcCos

arcsin | AreSin

Prlmal’y arctan | ArcTan
< | S N ) 4 Arrow Left
* | Arrow Right
7 8 9 = =
<¥l Backspace -
4 5 6% ()
1 2 3 +
0 =
= = <

Browse/Edit Button Functions Browse/Edit Key Bindings

Assessment Item Creation Screen

5. Click Save.
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Item Stem

Enter the Prompt under the ltem Stem.

a The options depend on the Item Type selected.

Iltem Stem °|

Define your Multiple Choice item

Prompt

How many columns for the answers?

>
=]
@
=
g
r

Q Answer 4

+ Add Chaica

Assessment Item Screen

Copyright 2015-2019 Edupoint Educational Systems, LLC



Assessment User Guide

40 Chapter 3: Create Items

Optional Features

Adding Passages

1. Click ° to access the Optional Features.
2. Click+Add a Passage.

Passage

Search Existing Passages
Search Subject

Assessment Item Creation Screen
3. Click Create Passage to create a new passage or select an existing passage.

« Enter Search criteria to search for an existing relevant passage.

Select a Subject to filter the passages.

Clear the Search fields to hide search results.

« Click Remove Passage to delete the selected passage from the item.

« Click Show Passage to toggle whether the passage shows or hides in Item view. The
full passage displays to the students when taking an assessment.

[ E See Passages for more information. J
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Adding Verbal Instructions

( N
Using Verbal Instructions in an item is optional. For example for emerging
readers or ELL students.

Select the picture that has the same short a sound as map.

\. J

1. Click 0 to access the Optional Features.
2. Click +Add Some Instructions.

3. Enter and format the instructions.

Inztructions

Selectthe picturethat has thesameshort a sound as map.

Assessment Item Creation Screen
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Advanced Scoring

You can use Advanced Scoring for these Item Types.

« Graphic Drag and Drop « Matching

« Hot Spot « Multiple Choice
o HotText « Multiple Select
« Inline Choice « TextEntry

Each response can have a customized point value applied. This allows users to customize the Max
Points possible and the Min Point to allow for penalties when students guess.

When using Advanced Scoring each response has its own point value.

1. Select the option to Use Advanced Scoring.

Important Settings

ltem Type

Multiple Choice v e

Bank Status Advanced Scoring €

Inspect ltemBank v Live (Available for Use) A ¥ Use Advanced Scoring

Assessment Item Creation Screen

2. Select 0 to modify the Max Points, Min Points, or Default Points.

« Max Points — The highest point value that a student can earn for the item. This can be
different from the calculated total points and can be a scalar value.

« Min Points — The lowest point value that a student can earn for the item.
« Default Points — The value applied to incorrect responses on Graphic Drag and Drop

Item Types.
Item Stem o
Define your Graphic Drag and Drop item. Oplional Features
+ Add a Passage
4 Add Some Instructions.
Prompt
Max Paints €
Win Points €
Default Points &

#' Show Max Uses to Student €&

Assessment Item Creation Screen
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Advanced Scoring Display

» Avyellow star indicates the Total Points for correct responses.

a genic grants how many wishes  Dropdsva=l v

Dropdouwn #1 e
Add 2 new opton
Points: 0 Points: 0 Points: 1

one X two X three X

Points: 0
four %

Points: 1

Total Points: /1(

Assessment Item Creation Screen

« Item Types, such as Hot Spot, that have correct and incorrect responses use yellow stars for
correct response point values and the red stars for incorrect response point values.

Draw the Hot Spots

+ Upload a Different Image

Rectangle Polygon Circle Clear Hot Spots

Which is the C key?

Total Pomts:/sr

Assessment Item Creation Screen
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Item Definition

Define the Item Content:

« Constructed Response « Hot Spot « Multiple Choice « Number Line
« Evidence-Based o Hot Text « Multiple Select « Select Point

Selected-Response o Inline Choice  « Multi-Part « True/False
« TextEntry » Matching

Graphic Drag and Drop

Constructed Response

1. Enter and format the item.
2. Select Spell Check to enable for the student.

3. Select in the formatting toolbar to insert an equation into the Prompt, if needed.
Equation Tool
alrlvw@ @ All Functions
Common Math
7 8 *] = \.-"'T Common Operations
; Groupings
4 5 6 |%x H .
1 2 3 =+ Symbols
- Greek Alphabsat
0 - = Calculus
Operations -

Assessment Item Creation Screen

You select the Equation Tool the student uses in Important
=  Settings.
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Evidence-Based Selected-Response or Multi-Part

Embedded ltems New ltam

Measured Standards

This list includes sl standards that are part of the selected azsessment items. You can click to toggle thess
standards on or off. Your changes here will be shown in the Standards panel after saving.

Mo items with standsrds have been added yet.
0 items

No Assessment ltems Selected

Assessment Item Creation Screen

1. Select Embedded Items:

« Toadd existing items from the item bank:

E If you selected to use an existing passage, only items
associated to that passage display for selection.

« For Multi-Part Items:
a. Click Add Items.
b. Enter the search criteria and select two or more items to embed.
c. Click Done Selecting Items.

« ForEBSR Items:
a. Click Add Items.

b. Enter the search criteria and select two items to embed.
c. Click Done Selecting Items.

You can only use Multiple Choice, Multiple Select, and
True/False Item types for EBSR Items.

« Tocreate new items:
a. Click New Item.
b. Create the new item.
c. Click Done Adding Items.

2. Select Measured Standards, if needed.

{ E Standards highlighted in green are assessed, those in red are not. }

3. Click © toeditthe Point Value or Sequence of selected items, if needed.
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Text Entry

[ i’ Works best for items that have exact matches.

1. Enter and format the item.
2. Click Text Entry to insert a blank in the item.

3. Select Ll inthe formatting toolbar to insert an equation into the Prompt, if needed.
Equation Tool
« r @ T All Functions

Common Math

Greek Alphabet

7 = o Common Operations
N
Groupings
4 A 5 Trig
1 2 3 - Symbols
0

Calculus

Operations

Assessment Item Creation Screen

You select the Equation Tool the student uses in Important
=  Settings.
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4. Enter the correct answers for the Text Entry.

« Clear Exact Match to allow any of the listed answers.

« Click to add another answer.

Assessment User Guide
Chapter 3: Create Items

Text with Blanks to Fill

Humpty Dumpty satona Text Eniry ID 795

Text Entry 1D 240

Text Entry 1D 796

% case Sensitive + Exact Match

, Humpty Dumpty had a great

¥ case Sensitive

Text Entry ID 240

+' Exact Match

a
fall [+ |
#x
wall
Assessment Item Creation Screen
« Select 54 and create the equations students select as the correct answer, if you

selected an Equation Tool in Important Settings.

Text Entry ID 674

| Case Sensitive ¥ ExactMatch

Ba

Assessment Item Creation Screen

S

Text Entry items have Score Lock applied if an item was

—| presented to students. This Score Lock prevents editing the

Prompt of Text Entry items.

47
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Graphic Drag and Drop

1. Enter and format the Prompt.

2. Select Show Max Uses to Student, if needed.

[ When enabled, if set to more than zero (0), the information displays ]

to the student.
Prompt
BI USx L= «xn]H= 2=l ==
m=0W
Styles - MNormnal - Arial - Size - Spacing || A~ - ®

Drag the parts of the spider onto the correct spot on the picture.

Graphic Drag and Drop Options

' Show Max Uses to Student @&

Assessment Item Creation Screen

3. Click First Upload an Image to select the Primary Graphic

4. Define the Hot Spots using the Rectangle, Polygon, and Circle options that act as the
drop area for students to place their answers.

« Click Edit Hot Spots to resize, copy, move, or delete a hot spot.
« Use Clear Hot Spots to remove all Hot Spots.

o Entera HotSpot Name and a define How many items can be dropped here (0 for
no limit).
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This text displays with the student response on the Data Table and
== inthe Database.

Rectangle  Folygon  Circle Clear Hot Spots

e TNy M® TN MO TNy TN SN ® o
(o

TsortIH )

prefixes SUffixes

5

\unhﬂf happ Hmsp:‘jspm Name

| disappear' ") K grate) o s oo goses
ettt

undo ° strong .
impossiblé* i | hopel¢

f
i

{vm. TN M ® ¢ TNy M ® y TN M TN® g e TN ¢

0®e TN MO g0 i Oy WO WO TN WS oW .t}

Assessment Item Creation Screen

Upload the Draggable images.
Enter a Draggable Name.

N\
This text displays with the student response on the Data Table and
in the Database.

Define the Max Uses.

N\
The default Max Uses is set to 1which allows the student to use the

— draggable once. There is no limit to the number of times the student
can use the draggable item If you enter 0.

Define the Min Uses.

Draggable Name

Max Uses Min Uses

1 0

Delete

Assessment Item Creation Screen
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9. Define the correct answers by dragging the images to the correct hot spot location.

Draw the Hot Spots

+ Upload & Different Image

Rectangle Polygon Circle Clear Hot Spots

Parietal LobS} [
/

Occlpital Lok%

N

Temporal Lot {

Draggables | 4 Uplosd Draggables.

&= o= 2
Occipital Lobe Parietal Lobe Temporal Lobe |

Total Points: f3L]/

Assessment Item Creation Screen

10. Click ﬁ' to define the Points for the correct answer.

Occlpital Lok 24 ,1
Vi

Points
1
i

Assessment Item Creation Screen
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Hot Spot

1. Enter and format the Prompt.

Prompt

Identify the part of the flower that provides suppoert and transports nutrients to other parts of the plant.

Assessment Item Creation Screen

2. Click First Upload an Image to select the Primary Graphic.
3. Define the hot spots using the Rectangle, Polygon, and Circle options.

Draw the Hot Spots

+ Upload a Different Image

Rectangle  Polygon | Circle Clear Hat Spots.

Assessment Item Creation Screen

« Click Edit Hot Spots to resize, copy, move, or delete a hot spot.
« Click the correct hotspot to enter a HotSpot Name and select Correct.
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This text displays with the student response on the Data Table and in the
Database.

« Use Clear Hot Spots to remove all Hot Spots.

Rectangle Polygon Circle Clear Hot Spots

HotSpot Name
Hotspot03

« Correct

oo
afes

Assessment Item Creation Screen

You can select multiple hot spots.

Select the hot spot again to clear the selection.
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Hot

1.

Text

Enter and format the Prompt.
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Find the misspelled words in the sentences below.

Prompt

2. Enter and format the Item Content.
3. Create the Hot Text:

Assessment Item Creation Screen

a. Highlight the text that the student can select.

b. Click ™ .

B I USH® XX L|A-B-||:=

= [¥ . -

S -

& 2z

QEH® Styles ~ || Normal ~ | | Aral - | | Size -

Spacing -

[The [surfice Jof the planet is [approximatly]71% water and [contains]five oceans, including the [Artic), Atlantic,

Indian, [Pacific, and [Antartic|

4. Selectthe Correct Answers:

Assessment Item Creation Screen

The
and

f the planet is [@pproximatly }71% water and [contains Jive oceans, including the [Arid, Atlantic, Indian, [Pacific]

Answer Details

Assessment Item Creation Screen
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Inline Choice

1. Enter and format the item.
2. Click Inline Choice to insert a drop-down in the item.

ltem Stem

Define your Inline Choice item.

Inline Choice Content

There are | Dropdown=1 v bones in the human body.

Assessment Item Creation Screen
3. Define the drop-down lists:

a. Enterthe answer selections for the Dropdown.

b. Click + or press Enter to add additional selections.

s

—  Click x to remove an answer.

Dropdown #1

| 207 +

Click the correct answer

212 % 206 % 209 %

Assessment Item Creation Screen
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4. Selectthe correct answer. A yellow star displays.

Dropdown #1
Add a new option +
Click the correct answer

R g
212 % 206 7Y 209 % 207 %

Assessment Item Creation Screen

Inline Choice items have Score Lock applied if an item was
presented to students. This Score Lock prevents editing the Prompt

E of Inline Choice items. Inline Choice items include a Partial Lock on
responses which allow for altering the correct response but
prevents the removal of responses.
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Matching

1. Enter and format the Prompt.
2. Select Show Max Uses to Student, if needed.

When enabled, if you set max values to more than 0, this
information displays to the student.

ltem Stem

Define your Matching item.

Prompt

Identify the polygons in the chart.

¥ Show Max Uses to Student @

Create the Interaction

x x
Click to Edit o Click to Edit

x
Click to Edit O O

s

Click to Edit

Assessment Item Creation Screen
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« Select Click to Edit to enter Matching ltems and Answer Choices.

Use the editing tool to format text, insertimages, equations, etc.

x

Click to Edit o Click to Edit

x

Editing For Answer Choices

Click Add Item to insert additional matching items.

Click Add Choice to insert additional answer choices.

Define your answers by selecting the correct responses as a student would.

Click ﬂ' to enter Max Uses for the Items and Answer Choices.

Multiple Choice

The default Max Use is set to 0, that places no limit on the
number of times the student can the use the choice. For
example, if you enter 1, the student can use the choice once.

By default, Assessment creates four available choices.

o Click to add another answer.

« Selectthe answer and click to remove an answer.

1. Enter and format the item.

2. Select “4l inthe formatting toolbar to insert an equation into the Prompt, if needed.

Equation Tool

o= a0~

=

All Functions

Commaon Math
Common Operations
Groupings
Trig
Symbols
Greek Alphabet
Calculus

Operations

Assessment Item Creation Screen

¢

You select the Equation Tool the student uses in Important J

Settings.
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3. Select the number of columns to display the answers.

ltem Stem

Define your Multiple Choice item.

Prompt

How many columns for the answers?

One Two Four

Answer 1

Answer 2

9, ©

+ Add Choice

Assessment Item Creation Screen

4. Enterthe possible answers.
5. Select correct response.

Answer 1
# Correct Answer
Rationale
%

Assessment Item Creation Screen
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Multiple Select

By default, Assessment creates four available choices.

Q o Click to add another answer.

« Selectthe answer and click to remove an answer.

\. v

1. Enter and format the item.

2. Select the number of columns to display the answers.

ltem Stem °

Define your Multiple Choice item.

Prompt

How many columns for the answers?

One Two Four

Answer 1 I

9O

Answer 2 I

Assessment Item Creation Screen

3. Enter the possible answers.
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4. Select correctresponse.

Answer 1
¢
+' Correct Answer
Rationale
P

Assessment Item Creation Screen

Number Line

1. Enter and format the Prompt.

2. Selectan Interaction Style.
o Points on a Line — Allow students to plot on a Number Line
« Line Plot— Allow students to create a Line Plot

Number Line Options
+ SnaptolLine @

Interaction Style Maximum Points on Line orneimiy
& 0
Line Plot v
Line Width ©@ 600 Title €@ Your Line Title
Step Distance @ 1 Starting Vaue @  -10
Label Distance @ 1 Ending Value @ 10

09 8.7 65 4321012345267 80910

Your Line Title

Assessment Item Creation Screen
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3. Make selections for the settings of the Number Line:

Assessment User Guide
Chapter 3: Create Items

« Snap to Line —When enabled, students can only plot on specific line values as

defined.

o Maximum Points on Line —When a value is entered, students can only create that
number of points or plots on the line, 0 is the default and acts as no limit.

« Line Width — Determines the width of the line in pixels.

« Title — Creates a title for the number line. Leave blank if you do not want a title.

« Step Distance — Determines the values students can select as defined on the number

line.

« Starting Value — Determines the starting value or smallest number displayed on the

number line.

« Label Distance — Determines the values displayed on the number line points.

« Ending Value — Determines the ending value or largest number displayed on the

number line.

Select the values that make the statement true

x=|-2

Number Line Options
' Snap to Line @

Interaction Style

Points on a Line =

Line Width @ Title ©
Step Distance @

Label Distance @ | 2 Ending Value ©

Maximum Points on Ling o nosm

Starting Value @ | -10

M0 8 6 4 2 o 2 4 [ 8

Number Line with even values

10

Assessment Item Creation Screen

61
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4. Interact with the Number Line to create the correct Responses.

Use Clear All to remove all points.

N\
Select existing points and an * displays to remove individual
responses.

BIUSSXx I ;=i W ESA

Stes = Format - Font - s - A-@

Jane recorded the laps she did around the track. Represent this data on the line plot below

[Day [Laps
fonday B
[Tuesday
Wednesday
[Thursday
[Friday

LB IS R

Number Line Options
" Snap to Line @

Interaction Style Maximum Points on Line (o nome
Line Plot 0
Line Width @ 600 Title @ Number of Laps
Step Distance @ 1 Starting Value @ | 0
Label Distance @ 1 Ending Value @
[ Ceor 4
X
X
X x X
1] 1 2 3 4 5

Number of Laps

Assessment Item Creation Screen

5. Enter aTolerance in pixels to determine how correct a student’s plot position must be in
order to be marked correct.

Scoring Options

Determine what criteria are used for scoring a response.

Tolerance

If you are using Snap to Line these settings are less important, but should still
be used for tiny differences. Without Snap to Line, the larger the numbers on
your graph the higher the tolerance should be.

Tolerance @:  0.25

Assessment Item Creation Screen

Use this setting when you do not enable Snap to Grid.

« With Snap to Grid, these setting are less important, but
O should use for tiny differences.

« Without Snap to Grid, the larger the numbers on the graph,
the higher these numbers should be.
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Select Point

1. Enter and format the Prompt.
2. Select an Interaction Style.
« Points on an Image — Allow students to select specified points on an uploaded image.
« Points on a Graph — Allow students to plot specified points on a coordinate plane.
« Lineson a Graph— Allow students to plot specified graphing tools on a coordinate
plane.
3. Enter the Maximum Choices the student can select and still be correct.
4. Make selections for the settings:
o Points on an Image:
a. Click First Upload an Image to select the Primary Graphic.

b. Define the points using the Rectangle, Polygon, and Circle options that define
the area where students must select the correct answer.

Click Edit Hot Spots to resize, copy, move or delete a hot
spot. Select the created shape to view options specific to that
hot spot.

Use Clear Hot Spots to remove all Hot Spots.

Options
Interaction Style Maximum Choices @ orne imi)
Points on an Image v 1
Draw the Hot Spots
=+ Upload a Different Image

Rectangle Palygon Circle Clear Hot Spots
|

Assessment Item Creation Screen
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o Points on a Graph:

a. Select the options:

« Maximum Points — Enter a value to define the number of points on the
graph the student creates. The default is zero (0) and acts as no limit.

« Snap to Grid —When enabled, students can only plot on specific points

as defined on the grid.

o Graph Width/Height — Determines the width/height of the graph as

defined in pixels.

« Starting X/Y Value — Determines the starting value or the smallest value

displayed on the horizontal and vertical axis.

« Ending X/Y Value — Determines the ending values or the largest value
displayed on the horizontal and vertical axis.

« X/Y- Axis Step Distance — Determines the values the student selects on

the graph.

« X/Y- Axis Label Distance — Determines the values displayed on the

graph.

« X/Y- Axis Title — Creates a title for the horizontal/vertical axis. Leave
blank to not display a title.

Graphing Interaction Options

Configure Graph

Graph Width @
Starting X Value @

Ending X Value @

X-fods Title @

Define Answers

Determine how the student interacts with your graph

' Snap to Grid @

Choose the options for drawing your graph. You also define your acceptable answers using graphing tools.

X-fois Step Distance @
X-Axis Label Distance @

Answer your prompt as you expect the students to answer.

Graph Height @
Starting ¥ Value @
Ending Y Value @
Y-Axis Step Distance @
YoAxis Label Distance @

YoAuis Title @

R 4 | 2 2 4

Assessment Item Creation Screen
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b. Interact with the Graph to create the correct Responses.

« Use Clear All to remove all points.

« Select existing points and an * displays to remove individual responses.

c. EnteraTolerance in pixels to determine how correct a student’s plot position must be
in order to be marked correct.

Scoring Options

Determine what criteria are used for scoring a response

Tolerance

If you are using Snap to Grid these settings are less important, but should still
be used for tiny differences. Without Snap to Grid, the larger the numbers on
your graph the higher these numbers should be. Slope and intercept
calculations can easily be significantly different without Snap to Gnd

X Tolerance @ 0.25

Y Tolerance @ 0.25

Assessment Item Creation Screen

? « Without Snap to Grid, the larger the numbers on the

Use this setting when you do not enable Snap to Grid.

« With Snap to Grid, these setting are less important, but
should use for tiny differences.

graph, the higher these numbers should be.

Slope and intercept calculations can be significantly different
without Snap to Grid.

o Lineson a Graph:

a. Select the options:

Maximum Lines/ Shapes — Enter a value to define the number of
lines/shapes on the graph the student creates. The default is zero (0) and
acts as no limit.

Snap to Grid — When enabled, students can only plot on specific points as
defined on the grid.

Use Line Tool — When enabled, students plot a Line. This is the default
tool.

Use Ray Tool — When enabled, students plot a Ray.

Use Line Segment Tool —When enabled, students plot a Line Segment.
Use Shape Tool —When enabled, students plot a multi-sided shape.
Graph Width/Height — Determines the width/height of the graph in pixels.

Starting X/Y Value — Determines the starting value or the smallest value
displayed on the horizontal and vertical axis.
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« Ending X/Y Value — Determines the ending values or the largest value
displayed on the horizontal and vertical axis.

« X/Y- Axis Step Distance — Determines the values the student selects on
the graph.

« X/Y- Axis Label Distance — Determines the values displayed on the
graph.

o X/Y- Axis Title — Creates a title for the horizontal/vertical axis. Leave
blank to not display a title.

Define Answers
Answer your prompt as you expect the students to answer.

& o—o o— []  cear 1]

+-10

Assessment Item Creation Screen

b. Interact with the graph to create the correct Responses.

Use Clear All to remove all points.

E Select existing points and an * displays to remove individual
responses.
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c. Selectdesired Line Scoring Methods

« Score on exactness of point placement — The student’s response must
match exactly the starting and ending points to the defined answer.

« Score on correctness of the intercepts and slope — The student’s response
must match the slope and intercept of the defined answer.

« Enter a Tolerance in pixels to determine how correct a student’s plot position
must be in order to be marked correct.

Scoring Options
Determine what criteria are used for scoring a response.

Line Scoring Methods Tolerance

& Score on exactness of point placement @ If you are using Snap to Grid these settings are less important, but should still
. be used for tiny differences. Without Snap to Grid, the larger the numbers on
e e your graph the higher these numbers should be. Slope and intercept
calculations can easily be significantly different without Snap to Grid

X Tolerance @: 0.25

¥ Tolerance @: 0.25

Assessment Item Creation Screen

? Enter a Tolerance when you do not enable Snap to Grid.

Text Drag and Drop
1. Select Show Max Uses to Student to allow students to see the maximum number of times a
response can be used.
2. Enterthe Text Drag and Drop content in the Text Drag and Drop Content field.

Use the editing tool to enter text, insert images, equations and to add the Drag and Drop
Blank space to which students will drag their response.

+" Show Max Uses to Student @

E |9 E}g

==} m=EQ d DD Blank Styles - | | Normal ~ | | Font - || Size ~ || Spacing - | ENt

= 9] 7. 22-

BIUSZXXx x| LT A-B:

_ Arizona
_ California
. Virginia

. Georgia

Assessment Item Creation Screen

4. Define the text responses for students to drag into the sentence.

a. Type the response in the text area and press Enter or select the &4 button to add the
response.
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« Hover over the response to add Max Uses for the response.

Atlanta

| a |
[Phoeni)?1‘)[Sacramentc?ﬂ;RichmonIc'i\]'?—ZI

Answer Options

|
" pints: " 4,
Max Uses: ‘l‘ - J/

Other Properties

Assessment Item Creation Screen

5. Drag the responses to the corresponding Drag and Drop Blank to mark the correct
responses. The drag and drop blank area appears green when selected.

« Hover over the response to set the point value for the response.

Aflanta

[+
[Phoeni)iﬂSacramentoﬂRichmona?

Total Points: /4«1/

Text Drag And Drop Content Window

If using Advanced Scoring, total points appear next to Total
==l Points.
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True/False

1. Enter and format the item.

2. Select the correct response. The correct answer is shown in a green.

ltem Stem @

Define your True/False item.

Prompt

All frogs are amphibians.

What is the correct answer?

True  False

Assessment Item Creation Screen

Key Data Systems Integration

Users can create item alternates, browse for alternates, and select alternates when creating
assessments. Three different alternate types are available:

« Language alternates provide the same item in a different language.

« Modified alternates provide the same item with modified language in the question stem.

« Randomizer alternates provide randomized alternates of the same item.

Users can also provide feedback to Admin users and to Key Data
==/ Systems onitems.

Creating Alternate Items

You can create alternate items on the Item Creation screen for items you own.
1. Create anew item.

Below Item Stem, choose )

Define the Item type settings.

> oD

Enter an Alternate Name.

69
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5. Selectthe Alternate Type.

a. Ifselecting Language, enter the Language Name.

Alternate Type

Language v

Alternate Name

Language
- Available a or students
Polynomials You will +  Modified \guage is
Randomizer 2
Assessment Item Screen

6. Click Open Parent Item to return to the parent item.

i@ Import Lock

Assessment Item Screen

Alternate items appear on the Data Table only when a student
submits a response for the alternate.

Viewing Alternate Iltems

You can view alternate items below the original item stem on the ltems screen.

1. Click onthe Item ID bar to open the Alternate item.

statement is true?

G John's car uses 37.6 gallens of gas to drive 1 mile in the city.

o John's car uses 1 gallon of gas to drive 37.6 miles in the city.

o John's car uses 42.3 gallons of gas to drive 37.6 miles on the highway.

Q John's car uses 37.6 gallons of gas to drive 42,2 miles an the highway.

Alternates

Meim I 7. M 10: 1471770
Bmport 100 &0 7HEL
Types Modfied
Teacher |nstructions Teacher Instructions
TEACHER READS: TEACHER READS:

Read the quetion to
yoursell and select the
best answer,

ltem Body Iten Body

John's car gets 42,3 John's car gets 37 miles

miles per gallon of gas = per gallen of gas In the =
Assessment Item Screen
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Enabling User Feedback on Items (District Users Only)

Admin users can allow all users to provide feedback on items created by the admin user and on Key
Data Systems items. Feedback on imported items is submitted to the provided email from the import
partner.

1. Loginasan Admin user.
2. Navigate to Synergy SIS > Assessment > Assessments.

a. Selectthe Settings tab.

« Selectthe users allowed to give feedback on items.
« Allow users to give feedback on imported items.

User Feedback on ltems @ User Feedback on Imported Banks @

- ]

Assessments Screen (Admin User)

3. Navigate to Synergy SIS > Assessment > Assessment Banks.

a. Selectthe Settings tab.
b. Select Staff Provide Feedback to enable it.

Name

District
Display Name
District ltem Bank

Description

This item bank includes all items created by district administrators.

Gather User Feedback for Bank Partners

Sends to email
+" staff Provide Feedback @

Assessments Bank Screen (Admin User)
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{
Teachers see the Provide Feedback button and a text field to enter
feedback.
Feedback for admin users is visible on the Items screen.
Feedback to import partners is submitted to the provided email from the
import partner.
L 4
e 1D: 92301 ‘Which of the following is NOT an example of
= St alliteration?
- o Frosted Flakes G Cookie Crisp
G Cap'n Crunch ‘? Cocoa Puffs V
e Provide Some Feedback
Items Screen (Teacher User)
\_
Other Properties

"a Completing the properties in this section is optional. It helps with
==l classification, organization, and filtering of the items.

1. Selectthe Grade Levels for this item.
2. Selecta Subject.
3. Selectthe Course.

a. Enter akeyword.

b. Select from the options displayed.
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4. Enterthe Depth of Knowledge for this item:

« 1. Recall-The student demonstrates that they can recall a fact, information, or
procedure.

o 2. Skill/Concept— The student demonstrates that they can respond using information or
conceptual knowledge.

« 3. Strategic Thinking — The student demonstrates that they can reason and define the
answer by developing a plan or sequence of steps. In some cases, more than one
answer may be correct.

« 4. Extended Thinking — The student demonstrates that they can investigate and use
complex reasoning to plan or develop an answer.

Other Properties

Additional information used for organization, and filtering.

System
Grade Level Subject Course Depth of Knowledge

Select One v - None

District Created

Rich Text

Text Entry Text Entry Mutti Drop Down

+ SelectOne v

Drop Down Multi Select

Assessment Item Creation Screen
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5. Select District Created properties.
[ Your district might require you to set the District Created properties.]

These custom properties display after the System Properties.

« Rich Text — Enter and format complex details for the item.

oo T |

BIUSH®xXxx|L| | A-BO-
EIEEID] EXE] . E
=
= H=o0@oe

Styles ~ || Momal ~ || Font ~ | | Size ~

Spacing ~

Assessment Item Creation Screen

« Text Entry — Input simple text details, such as keywords, for the item.

Text Property

Assessment Item Creation Screen

o Text Entry Multi — Input multiple keywords for the item. Press Enter or click * to
create another entry.

Text Property
)
{ Math__] Numbers

Assessment Item Creation Screen
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o Drop Down - Select from the provided options.

Iath

Select One v

Select One

Algebra
Trigonometry

Assessment Item Creation Screen

« Drop Down Multi Select — Select from the provided options.

Advanced Math

Calculus
Pre-Calculus

Algebra/Trig

Assessment Item Creation Screen

Rubrics for Constructed Response Iltems

Constructed Response items use rubrics for scoring.

o Assessment Item Rubric — This rubric is created during the item creation process. They
apply to the item they were created for and cannot be used with any other item.

« Grade Book Rubrics — These rubrics are created in Grade Book.

[\
Grade Book Rubrics are view-only and cannot be edited.

Rubrics

Configure Constructed Response rubrics.

Scoring Rubric

You can use Grade Book Rubrics here if you have a rubric you like that can be used across many assessment
items.

None Specified v

Assessment Item Creation Screen
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1. Selecta Scoring Rubric.

« Grade Book Rubric — Select a rubric from the available Grade Book Rubrics. The
Grade Book Rubric displays.

Rubrics

Configure Constructed Response rubrics.

Scoring Rubric

Grade Book Rubric  Assessment ltem Rubric

You can use Grade Book Rubrics here if you have a rubric you like that can be used across many assessment
items.

| Debate Rubric v

Factual Information

Used many facts to support all arguments. Score: 4
Used some facts to support all arguments. Score: 3
Used few facts to support arguments. Score: 2
Did not present facts to support arguments. score: 1

Comprehension

Demonstrated thorough understanding of information Score 4
Demonstrated accuraie understanding of important information Score: 3
Demonstrated minimal understanding of information. Score: 2
Demonstrated misunderstanding of the information Score 1

Assessment Item Creation Screen
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« Assessment Item Rubric — Enter the rubric Criteria Name, Rating Description,
and Score.

Assessment Item rubrics are ONLY for the item they are
created with and cannot be used again

« Click New Rating to add a rating to the criteria.
« Click New Criteria to add criteria to the rubric.

Rubrics

Configure Constructed Response rubrics.

Scoring Rubric

By creating a rubric here, this item will have a rubric that you can modify at any time without changing any others,
making it unique to this assessment item.

¥ sample Criteria Name

" Sample Rating Description Score:
0

" Sample Rating Description Score:
]

Mew Rating

New Criteria

Assessment Item Creation Screen

Constructed Response Items that have a rubric attached display the
rubric in a condensed version when viewing the items in the ltem

Bank.

2. Enterthe Total Points.

The Total Points of the item must match the values of the Scoring
Rubric.
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Standards

p
Completing this section is optional, but highly recommended.
. After updating standards in Synergy SIS, previous standards, whether
—| assigned by import or selected by users, are visible. Any new imported
standards automatically align and are visible on each item without user
input.
.

Select standards using the Standards Search by keyword or Add by Standard Tree.

Standards

Align the item to one or more standards

Standard Search Add by Standard Tree

Selected Standards

No standards selected

Assessment Item Creation Screen

The selected standards display.

Add by Standard Tree

Standard Seanch Add by Standard Tree

key means of 3sserting and

For studen
defending

ngi

wing what they knaow about a
=ying what they have experizncad
thought, and felft. Te be college- and carear-
15, studants must take tazk, purpose, and
careful consideration. choosing words,
information, structures, and formats defberatzly. They

- o All Standards
- Other Content Standards (MM)
NGA Center/CC550-Common Core State Standards- - Early Childhood
B e fal Grade P2
Subject: English Language Arts/Literacy Code: PS.P21
Grade: College- and Carser-Resdiness Anchor Standards 5 f Sacial/Emoticnal: Demonstrate effective personal and

social gkillz

Code: P5.P22
Cognitive: Participats a2 active and sfzctve leamers

Code: PS.P22
Communication: Communicate optimally and effectively
7 @ variety of sefings

Code: PSP24
Motor: Us= their bodies optimally to explers. negatiate
and manipulate the environment

Code; PS.P25
AdaptiveSelf-helo: Demenstrate optimal indepandence
n areas of daily lifz

Assessment Item Creation Screen
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Click *

to remove the standard.

Assessment User Guide
Chapter 3: Create Items

Standards

Align the item to one or more standards
Standard Search Add by Standard Tree

Selected Standards

Report Card Standards

Assessment Item Creation Screen

Passages

You can do the following things with Passages:

« Create new passages from items or from the Passage Bank.

« You can select multiple items for a Passage.

« Edit existing passages from the Passage Bank. Creators can only edit passages that they
created.

[\
Administrators can edit all passages in the District Passage Bank.

Creating Passages

From the Passage Bank

1. Select Passages (Create & Edit Passages) from the Assessment menu or navigate to
Synergy SIS > Assessment > Assessment Passages.

Aszseszment » RTlI - Admin -

Item Bank (Create & Edit ltems)

Bank Management (Create & Edit Banks)

Constructed Response Grading

! Passages (Create & Edit Passages)

Dashboard (Authorize Students & View Resuliz)
Assezsments (Creste & Scheduls Azssssments)

Assessment Menu

79
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2. Click NEW.

View Archive
Filters Assessment Passages
Passage ID
Exact Match Q 11010 of 1,257
Import Identifier
£xact Matrh Q Details Passage
Title
Q Passage ID: & Read the passage and answer the question(s) that follow.
Passane Inspect ID: Matt had a dog named Bud. Bud was a fun dog. He came every time Matt said ta come. One day, Matt took
Q Item Owner: Imported Bud to the pet shop to get a bath. Bud did not like the bath. The next day, Bud did not come when Matt called. He
Bank Item Bank: Inspect ltemBank  hid in his doghouse. Matt did not like it when Bud hid. He threw the ball for Bud. Bud liked to play ball. Bud and
FleschKincaid: 06 Matt played all day
Word Count: 78
Lexile Range Syllable Count: 81
. Sentence Count: 11 “
Flesch-Kincaid Grade Level @ ‘d

Passage Bank Screen
3. Enter and format the Passage Title.
4. Enter and format the Passage.
5. Selecta Status.

« Live—Available for use in assessments (Default setting)
« Draft—Not available for use in assessments
« Archive — Not available for use because they were intentionally disabled

6. Selectthe Bank to contain this passage.

E If you do not have an Item Bank available to you, the passage is
placed in a new bank.

7. Selecta Subject.
8. Click Save.

From an Iltem

1. Click 0 to access the Optional Features.
Click el
Click Create a .

Enter a passage Title.
Select an Iltem Bank.

© ok~ w0 N

Select a Subject.
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7. Enter and format the passage.
8. Click Create.

Iltem Stem
Define your Constructed Response item.

Create a Passage
Title Bank Subject

District N Social Studies

Body

New Assessment Item Screen

Viewing Passages

1. Select Passages (Create & Edit Passages) from the Assessment menu or navigate to
Synergy SIS > Assessment > Assessment Passages.

Assessment ~ RTI - Admin -

Item Bank (Create & Edit liems)

Dashboard (Authorize Students & View Resuliz)
Azzezsments (Create & Schedule Az=essments)
Bank Management (Creats & Edit Banks)

Constructed Response Grading

! Pasz=sages (Create & Edit Passages)

Assessment Menu
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2. Use thefilters to display the passages based on the selections made.

a4 )
You can search by Passage ID number. The Passage ID number
displays on the passage Details.

Details Passage

Tmport ID: by Barbara McCauley
Item Owner: Imported

Bank: Certica ltem Bank

| he was small not ready yet
Flesch-Kincaid: 42.9 frantic
Word Count: 100
under the hedge

- Z::‘:’:i:z::; Sf” I caught him took him home
& S my father wasn't sure

‘wild birds he said

we've tried so many times

buthe ate

‘what we made for him

and in three days

could fly

around the liviag toom

it’s time my father said

you have to let him go

Passage ID Number On Passage Details
\ v

3. Select the passage you want to view.

« Imported passage preview

Preview m

This is an imported
passage and cannot

Matt and Bud be edited.
Read the passage and answer the question(s) that follow.
Matt had a deg named Bud. Bud was a fun deg. He came every time Matt said to come. One day, StatS
Matt took Bud to the pet shop to get a bath. Bud did not like the bath. The next day. Bud did not come ]
when Matt called. He hid in his doghouse. Matt did not like it when Bud hid. He threw the ball for Bud. Items Using B®

Bud liked to play ball. Bud and Matt played all day.

Selected Options @)
Status

Live

Iltem Bank

Inspect ltermBank
Inspect ltermBank

Subject

English Language Arts

Passage Preview Screen
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The imported passage screen displays:

« The owner of the passage. (1)
« The number of items using the passage. (2]

« The information for the passage. ©

o Created passage preview, click Preview.

Stats

Kara's Talent Show

o . S . . e Items Using
Kara's neighborhood was filled with many children her age. She new everyone on her street. She also knew how taleted
many of them were

Preview

She could hear her neighberJoanne playing her guitar every afternoon when they get home from school. Kara loved it
when Joanne played her faverite coutnry song.

Selected Options 9
Status

Live

ltem Bank

Subject

Reading

e

Imported Passage Preview Screen

The screen displays:
« Click Edit to make changes. (1)
« The number of items using the passage. (2]

« The information for the passage. ©
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4. Click @ to view items that use the passage.

« Click Passage to see a preview of the passage. (1]

« Click NEW to associate the passage with a new item. (2]
The Assessment Item screen opens with the passage section populated.

I

7 3 Lock Sign Out Support Help

Passage | Assessment liems

Assessment ltems

trems 9 e
ltem Bank  ltem Details Item Preview

Passage Title
Inspect Item Type: Muttiple Choice TEACHER READS:
ItemBank Subject English Language Arts
Grade Levels:
Course: Ni&
Depth of Knowledge: 1. Recall
Status: Live
Item1D: 1854
Inspect 1D: 600026

Mattand

Follow along as | read the story to you, and be prepared to answer the question(s). Bud

Matt and Bud
Matt had a dog named Bud. Bud was a fun dog. He came every time Matt said to come. One day, Matt took Bud to the pet shop

to get a bath. Bud did not like the bath. The next day, Bud did not come when Matt called. He hid in his doghouse. Matt did not like it
when Bud hid. He threw the ball for Bud. Bud liked to play ball. Bud and Matt played all day.

o¥

Passage Screen

Archiving Passages

., Passages are not deleted; they move to the Archive section where they

—| continue to display. You cannot edit or copy passages once they are
archived.

1. Select Passages (Create & Edit Passages) from the Assessment menu or navigate to
Synergy SIS > Assessment > Assessment Passages.

Assezzment -~ RTl - Admin -

tem Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Resulis)
Assezsments (Create & Schedule Aszessments)
Bank Management {Create & Edit Banks)

Constructed Response Grading

Passages (Create & Edit Passages)

For 13

Assessment Menu

2. Use thefilters to display the passages based on the filters.
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3. Click * on the row ofthe passage to archive.

Assessment Passages

2 items 4+ NEW

Item Bank: * Tom Smith

itle| Passage click to select this row Item Bank

ow
%‘Th& House Tom Smith kem Bank

Passage Bank Screen

The icon displays on the row.

Assessment Passages
srems m G CANCEL
Item Bank: Tom Smith

Title Passage ltem Bank

m The House Tom Smith tem Bank

Passage Bank Screen
4. Click Save. A confirmation message displays.
5. Click OK. The passage is archived.

. Click View Archive in the Passage Bank to view archived
passages.

Click View Current to return to the active assessments.

Copyright 2015-2019 Edupoint Educational Systems, LLC



86 Assessment User Guide
Chapter 3: Create Items

Formatting Window

This section describes the formatting window used to create assessment items. It is used to create
teacher instructions, items, answers, and passages.

[ E The formatting tool bar displays when you click inside the text entry box. ]

BIUSXxx®¥TILY¥ A-B === E(9EIE EEHTM

= 223

E-

i

) Cd ® Styles ~ || Mormal ~ | | Font ~ | | Size ~ || Spacing ~

How does the sun affect water on Earth?|

Formatting Window

The formatting and editing tools available are:

. B I US Bold, Italic, Underline, or Strikethrough — Formats the selected text as
bold, italic, underline, or strikethrough

° X

x' ¥ Subscript, Superscript, or Underscript — Inserts subscript, superscript, or
underscript text

4 )
The underscript option has a gray bubble that you can type in to
make the field visible during editing. The text displays to usersin a
default gray color. You can modify this text color using the editor.

E Underscript is best used with the Line Spacing feature, which
increases the amount of space between lines of paragraphs. The
default spacing allows you to use this feature but is more difficult to
read. You can hover over the annotated word to get a large view of

L the text, independent of the spacing. )

« T Remove Format - Clears all formatting for the selected text

.0 Alternate Pronouncing — Inserts alternate text to be read with Text-to-Speech

« 2= == Insert/Remove Numbered or Bulleted List — Formats the selected paragraphs
as numbers or bullets

“E “E Increase or Decrease Indent, Outdent — Indents or outdents the selected
paragraph
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Blockquote — Indents the paragraph on both sides

Align Left, Center, Align Right, or Justify — Aligns text per the setting

Text Direction From Left to Right or Right to Left — Aligns text per the setting

— Insert Hyperlink or Remove Hyperlink — Inserts or remove a link to a website or

email address
FA Table — Inserts a table
Insert Horizonal Line — Inserts a horizontal line

C2 Insert Special Character — Inserts a special character such as a copyright mark or
currency symbol

Cal Image — Inserts a picture from a file

=" Text Style — Selects a built-in format for the selected text

Normal

' Paragraph Style — Selects a built-in format for the selected paragraph

" " Font - Selects a font for selected content

Size -

Size — Selects a font size for selected content
===r2 -] Spacing — Selects single, double, or triple spacing

A~ Text Color - Applies the selected color to the text

a- Background Color — Highlights the text with the selected color

®IRecord Audio — Records audio using your device's microphone. Click ] to stop the
recording.

87
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. Equation Tool — Opens an equation tool
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Promoting Items for District Use

If the district allows teachers to promote Items or Passages for district use, the Nominate to
District field displays on the screen.

The item or passage must be saved before the Nominate to Districtis a
link.

Submitting Items for Promotion

89

Teachers submit items for promotion.

Select Item Bank (Create & Edit ltems) from the Assessment menu.

Aszezement -~ RTI - Admin -

Item Bank (Create & Edit ltemsz)

| Dashboard (Authorize Studentz & View Results)
Assezsments (Create & Scheduls Azzessments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

AT e

Assessment Menu

2. Selectanitem.
3. Click Nominate to District. A success message displays.

Important Settings

ltem Type

True/False AL ]

Bank Status Total Points

ltem Bank for Kathy Jackson v

Nominate to District | €@

Live (Availlable for Use) v

Items Screen
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Click Cancel Nomination to remove the item from district consideration.

Bank

[tem Bank for Kathy Jacksen »

Cancel Nomination | €

Items Screen

= Open the item to see if the Item was approved in the Important Settings.

Bank

Itern Bank for Admin User

¥ Nominated for Promotion by Kathy Jackson }iew current teacher version

Items Screen
\. y

Approving Items for Promotion (District Users Only)

The Nomination for Promotion tab displays on the ltems screen of district users when ltems are
nominated for district use.

1. Select Iltem Bank (Create & Edit ltems) from the Assessment menu.

Azzezsment ~ RTlI ~» Admin -

Item Bank (Create & Edit ltems)

| Dashboard (Authorize Students & View Resulis)
Assezaments (Create & Scheduls Azzsssments)
Bank Management {Create & Edit Ganks)
Construcied Response Grading

Passages (Create & Edit Passages)

b

Assessment Menu

2. Selectthe Nomination for Promotion tab.

o ¢Semng5 m
o rer
System .
Bank X All frogs are amphibians.
Item ID: 136676
- Owner: Jackson, Kathy 1
- Bank: Item Bank for Kathy Jackson T

tom Tyne % Ttem Type: True/False rue

em lype Status: Live

Click to Search h o Fa|se

Items Screen
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3. Select and review the item.
« Toapprove the item:

a. Select the Item Bank.

b. Select Approve. 1 copy of the item or passage is created in the selected ltem

Bank.
« Todenytheitem:
a. Provide an explanation for the denial. (2

b. Select Deny. ©

Assessment User Guide
Chapter 3: Create Items

Important Settings

Item Type

TruefFalse

Bank

Item Bank for Kathy Jackson

fo copy this item to. If the item needs corrections before you can af
the user using the text field below.

If denying the request, please provide a reason below.

This question needs more detail |

=6

This item has been nominated for promotion by Kathy Jackson to a district-level item bank. If you choose to approve, select an item bank
ve, or you cannot approve for other reasons, provide feedback to

Item Bank for Admin User ¥ 0

Status Total Points
Live (Available for Use) 1
Items Screen

91
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Resubmitting Items for Promotion

If an item is denied, the teacher can modify the item and resubmit for approval.

1. Select ltem Bank (Create & Edit Items) from the Assessment menu.

KTl -~  Admin

Azzessment

-

Item Bank (Create & Edit ltems)

Daszshboard (Authorize Students & View Resultz)
Assezsments (Create & Scheduls Asssssments)
Bank Management {Creats & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

-~ ik

Assessment Menu

2. Selectthe Nomination for Promotion tab.

3. Select the item.

Important Settings

Item Type

True/False

Bank

approval.

District says

Status

Live (Available for Use)

Item Bank for Kathy Jackson v

Re-submit to District | @ 9

You have received feedback for your nomination. If desired, you may make changes and re-submit for

This question nesds more detail o

Total Points

v 1

Items Screen

4. Review the reason for denial. @

5. Make the requested changes.

6. Click Re-submit to District. &
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Copying Items in the Item Bank

[\,
This option is not available for imported ltem Banks.

Items can be copied from ltems or the Archive.

1. Select Item Bank (Create & Edit Items) from the Assessment menu.

Assessment ~ RTlI ~ Admin -

Item Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Resultz)
Azzezsments (Creste & Schedule Azzessments)
Bank Management (Creats & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Coaenebemn

Assessment Menu
2. Select the item to copy.

3. Click Copy assessment item. The copy of the item displays with a copy successful

Important Settings Return
Important Settings
ftem Stem I Copy assessment item I
Tew Hem preview
Other Properties
Item Type
Standards . o Stats
i ’ Hem ID- 136675
Total )
Correct:
Total [
Bank Status Responses
Mezn Score: 0%
Item Bank for Kathy Jackson v Live (Available for Use) v
% This item successfully promoted to District. View current district version Display Mode: [IEIH
Total Points

Assessment Item Creation Screen
4. Editthe item if required.
5. Click Save. The copied item stores in the selected item bank.

93
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Archiving Items from the Item Bank

Scheduling Assessments with Archived or Omitted Items

The ability to schedule assessments with archived or omitted items is restricted.

p
Archived items used in assessments:

ﬁ « Display a message on the assessment preview and on the
assessment.

« Are highlighted in red on tests and on the Assessment screen.

can override the setting and schedule the assessment.

the assessment by one of these methods:
» Change the point value of the archived or omitted items to 0.
- « Remove the items:
1. Make a copy of the assessment.
2. Remove the archived or omitted items.
3. Use replacement items if needed for future testing.

The schedule button does not display on the assessment preview. You

Before using an assessment that uses archived or omitted items, modify
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Archiving Items

1. Select Iltem Bank (Create & Edit Items) from the Assessment menu.

Assessment ~ RTlI » Admin -

ltem Bank (Create & Edit liems)

| Dashboard (Authorize Students & View Results)

Azzezsmenis (Create & Schedule Azssssments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Assessment Menu

2. Click Archive.

Items MNomination for Promotion m

All frogs are amphibians.
Ttem ID: 136676

Owner: Jackson, Kathy
Bank: ltem Bank for Kathy Jackson T
Item Type: True/False rue

Status: Live
o False

Assessment Item Bank Screen

3. Click OK. The item moves to the item bank archive.
Only owners can move their items to the archive for teacher created
items.

0 District staff can move all district created items to the archive.
= Click View Archived Items to view the item bank archive.

To use a item from the archive, make a copy of the item to save it to
the item bank.
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Assessments

You access assessments from the Assessments screen. Use the tabs and drop-downs to change
what displays on the screen.

The assessment screens use these icons:

— Online only assessment #'_ Quick Assessment

©_ Test history ¥ _Useto drag and drop assessments
® _Bank you own * _Hides afilter or indicates a denied promotion
— Bank you do not own (shared or + _ Add filter to filters list

imported)

) © _ Assessment promoted to District

Z _ Imported assessment s

. — Assessment approved for promotion to
h_ Paper only assessment district
niZ=) or =79 _Hides or displays filters

Using the Assessments Screen

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Asseszment ~ RTI -~ Admin -

J tem Bank (Create & Edit ltems) L

Dashboard (Authorize Students & View Resulis)

Assezsments (Create & Scheduls Azzessments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

1emrifom

Assessment Menu
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2. Change thefilters as needed.

Clear Fillers
System £
Bank 1D Assessment 1D
Assessment Mame Assessment Creator
Schedule Status Reserve ltems
Imported Show Empty Banks
Subject Course

Assessments Screen

Hidden filters no longer display in the search results.

An alert is available to indicate that filters are in use when you click
=& Apply Filters. This alert also indicates how many Active Filters are
in use.
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o Sortby ID — Select to sort the assessments by the Assessment ID number in ascending

or descending order.

« Sortby Name — Select to sort the assessments by Name alphabetically in ascending or

descending order.

When sorting by ascending, assessments with numerical
numbers or spaces prior to the name of the assessment

display first.
Assessments % s ERAEL ) [TdRle
mm My Assessments Test History ## Settings Folder Style-  Compact Row - Wiew All m
System & B Without a Bank CFI)

Bank D B Inspect ltemBank CEE)
Sanik il 2-

Aszessment D

B Item Bank for Admin User £X)
BaneDo3
B Edupoint Item Bank
Assessment Name Bane D6

Assessment Creator

Schedule Status

Reserve ltems
Imparted

Show Empty Banks
Subject

Course.

Assessments Screen

4. Change what and how information displays on the Assessments or Test History tabs.

a. Selectto arrange Assessments by Folder Style, Banks Only, or Assessments Only.

« Folder Style — Displays the organization of assessments in banks
« Banks Only —Displays available assessment banks
« Assessments Only — Displays all available assessments
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b. Selectto display Assessments as Compact Row, Full Row, or Tile.

« Compact Row — Displays the most amount of information with space-saving
details. You can hover over the row to view additional details.

My Assessments Test History £ Settings Assessmenis Only - Compact Row ~

Sort by Wame 1 | Sort bw 1D

* Algebra I CCSS Summative Assessment 2015-
2016

g AssessmentID: 1011 - ull n 2015-2016
Owner: District

* Description: 2015-2016

Points: 23.00

Subject: Math

# Grade: Grade K 2015-2016
*

*

nge 2015-2016

No Date Limit
No Time Limit
Options -

Algebra II CCSS Interim Formative Assessment Green 2015-2016
1LY, L

Assessments Screen

o Full Row — Displays all the information in a larger area

My Assessments Test History 2 Settings | Folder Style -~ Full Row — | View All
Sort by Name 1 | Sort by ID
[ Edupoint Item Bank Owner: User, Admin
Bank ID: 6 Description: ltems designed by Edupoint users for demao
purposes.
B Inspect ItemBank €D Owner: Imported
Bank ID: 2 Version: 12/8/2017
P
|
-
B [tem Bank for Admin User Owner: User, Admin
Bank ID: 3
B Without a Bank ££IT)

Assessments Screen

o Tile—Displays all the information in a smaller space

All Assessments Test History ¢ Settings Folder Style~  Tile ~
Sort by ID | Sort by Name T
ft Adams Elementary €5 D 3D A pistrict D CED
A Edupoint School District ) €5 1 Hope High School €8 CD €D
# Jefferson Elementary C) €1 A Kennedy High School €5) €19 €D
Assessments Screen

5. Use Options to select Actions and Views for the Assessment, Bank, or Group.
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1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or

navigate to Synergy SIS > Assessment > Assessments.

Asseszment ~ RTI -~ Admin -

Item Bank (Create & Edit ltems)
Dashboard (Authorize Students & View Resulis)

Assezsments (Create & Scheduls Azzessments)

o

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Assessment Menu

2. Select an assessment bank.
3. Select Bank Details in Options.
4. Setthe Sharing options.

Enter the search criteria
b. Make a selection.

c. Click ‘ﬁ' to set options available to the users who have access to the shared

assessment.
You may also grant each shared group or person editing and adding privileges to the bank. These groups will be able to add items to, edit
items within, and archive items within this bank. You may change this access at any time.
Sharing Search Shared With
Search @ HS English 10 %¢ o
Search for Schools, Grades, Courses, Subjects, User dent Groups, and User HS English 09 3¢ 3
HS English 11 3¢ o
HS English 12 %¢ o
HS English 12
Shared
[ Allow Editing @
) Allow Adding
Shared With:
Departments'HS English 10, HS English
09, HS English 11, HS
English 12
Bank Details Screen
5. Click Save.
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Creating Assessments

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or

navigate to Synergy SIS > Assessment > Assessments.

Azzezement -~ RTlI -~ Admin -

J tem Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Results)

Assezsments (Create & Scheduls Asssssments)

Bank Management {Creats & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

-~ ik

|

Assessment Menu

2. Click NEW to select an assessment type.

Assessments  TestHistory — BFSeftings | Lst V| Assessment ¥

¥ Algebra | CCSS Summative Assessment al Assesgment [Dx 1011
2015-2018

Alocken | Lo oo T 3 al 5 ST anan

Full Assessment
& Quick Assessment
ol Bank

Assessment Grid Screen

Creating Full Assessments

1. Select Full Assessment from New.
2. Enter the assessment Name for the student under Assessment Info.

p
E The Assessment Creation screen has two display modes.
\

7

to teacher created assessments.

Diagrams are not drawn to scale.

\

« Define a naming convention for assessments to use across
the district to identify district created assessments in contrast

? « Enter instructions for the assessment. For example:
Read each question carefully. Each question has 4 answer
choices. You may need to scroll to see all 4 answer choices.

3. Select a Status.

« Live—Available for use in assessments (Default setting)
o Draft—Not available for use in assessments

« Archive — Not available for use because they were intentionally disabled
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4. Click Upload a file for students to add resource materials to an assessment. These
materials are available for students to download and use during the assessment. This is done
at the Assessment level and all Scheduled Instances use it. Resource Types can include
PDF, Word, audio, and video formatted files.

7

The resource materials display on the Introduction page:

and on the menu bar during the assessment:

Grade 3 Science Diagnostic

Additional Resources

Access Information

Notices
P Start
A Return To StudentVUE

Assessment Introduction Page

Grade 3 Science Diagnostic - ‘ 4 7 @ @ Last Name, First Name

1

Where is most water found on Earth?

o in glaciers e in lakes o in rivers. o in oceans

aq

Save and Close

Assessment
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5. Click T to define and format the Description and Instructions.

Assessment Info

Name the assessment and describe its content.

Name

Grade 3 Science Diagnostic

Status

Live ~ In live status, this assessment wil be available for scheduling.
Bank

Mo Bank w

File Resources &

Upload a file for students

Description +

Instructions

Assessment Creation Screen
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a. Click ¥ to open the Sharing Search.

Sharing

To share this assessment, use the Search box below and select the User or Group that you wish to share with, these features can be
filiered to allow sharing with groups within a school.

Share this Assessment 4=

Assessment Creation Screen

Sharing options in Item Banks, allow users to share by
« School
o User Group
« UserRole
« Grade Level
« Individual Users

When assessments are shared:

« Assessment owners can schedule their own
assessments.

« Those who have assessments shared with them, can
schedule assessment for their students.

« District users can schedule assessments for all
students.

105
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b. Selectthe settings:

Sharing

To share this assessment, use the Search box below and select the User or Group that you wish to share with, these features can be [Tt g
sharing with groups within a school

be allowed, these include
changes o the Assessment

I
: . i
Sharing Search Shared With Options, and the ability to add or i

remove ilems.
Search @ Mathematics 00 (MTHOD) % e
mathe Mathematics 00
(MTHOD)
Courses Departments Shared
Allow Changing
Mathematics (DMTH) Mathematics

Mathematics 01 (MTHD1)
Mathematics 02 (MTHD2)
Mathematics 03 (MTH03)
Mathematics 04 (MTHO4)
Mathematics 05 (MTHOS)

Shared With:
Courses: Mathematics 00 (MTHOO)

Assessment Creation Screen

« Enter Search criteria. The list is filtered.
« Make a selection.

« Click & to set options that are available to user who have access to the shared
Item Bank:

« Allow Changing — Users can edit the assessment.
4

~
If shared users are allowed to change the assessment,

the changes affect ALL current instances of the

A assessment. Edupoint recommends not changing
assessments. Use the Copy function to make changes
to assessments without affecting the original
assessment.

7. Select the assessment Settings.
« The settings display grouped by:
o Assessment Level Settings
o Student Settings
« Staff Settings

o Click “* tolock the setting for all scheduled instances of this assessment. The icon
changesto i.

« ¥ indicates the setting is enabled.

« % indicates the setting is disabled.
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Text-to Speech Defaults are browser specific. A selection should
be made for Chrome, Firefox, and Edge.

Text-to-Speech is not supported in Internet Explorer.

Settings

Assessment Level Settings

Determine how this assessment is used for all scheduled instances. These options may only be
changed on this screen, and will not be available during scheduling.

+ Allow Copy @ Use Alternating Choice Letters [: ]
+ Allow Printing @

% Use Date Availability @ ® Use Time Availability @

Student Settings

Determine how the assessment is presented to students. Use the lock feature to secure the
setting for all scheduled instances of the assessment.

% Item Navigation @ ® secure Browser @

¥ Randomize Item Order € * Media Upload ©

% Randomize Answer Order & ' Text-to-Speech Choice &
% Rubric Access © Text-to-Speech Defaults - @

Feedback Options =

Staff Settings

Determine which options are available to additional staff tied to a scheduled assessment. Use the
lock feature to secure the setting for all scheduled instances of the assessment.

+/ View Student Results € ' Access Now ©

Item Detail Options ~ ® Unlock Student Submit @

+ Constructed Response Scoring @ % Manual Response Input @
+' Grant Retakes €@ ¥ Override Student Scores €
+ Allow GradeCam @ " Modify Student Accommodations @

Assessment Creation Screen

» Assessment Level Settings:

« Allow Copy — If enabled, allows others to make copies of the assessment
except for item details and responses that are hidden.

« Allow Printing — If enabled, allows others can print the assessment. The printed
version follows the View Student Results settings.

« Use Date Availability — If enabled, uses selected dates as the default dates for
the assessment and cannot be changed.
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« Use Alternating Choice Letters — Enter letters to use for Multiple Choice and
Multiple Select items for online and GradeCam scored assessments. Each row
alternates the letters for the choices. For example ABCDEF and JKLMNO.

4 )

The correct answer displays in the original form (A-F) on

the printable answer key, Live Dashboard, and

Dashboard Analysis screens.

The alternate choice letters appear when:

a « Viewing the assessment as a student (preview)
« Taking an online assessment in StudentVUE
« On printed GradeCam bubble sheets

50000
@000

\. J/

« Use Time Availability — If enabled, uses selected times as the default time for
the assessment and cannot be changed.

¢ Student Settings:

« Item Navigation:

« Ifenabled, allows the students to scroll back and forth through the
assessment and change their answers before submitting it. Also allows
the student to highlight in yellow, strikeout in red, and to mark items for
review.

« Ifdisabled, the studentis not allow to revisit items. They are allowed to
mark incorrect answer red to help them decide on the correct answer.

« For INSPECT Inline Choice items, allows the student to click Next
Question without viewing or changing the drop-down answers. It
selects the first item listed as the correct response if the student
clicks Next Question.

o Fornon-INSPECT Inline Choice items, does NOT allow the student
to click Next Question without selecting an answer from the drop-
down list of choices. A message displays that says No Skipping if
the student click Next Question.

« Randomize Item Order — If enabled, shuffles the order of the items for each
student taking the same assessment.

« Randomize Answer Order — If enabled, shuffles the order of possible answers
to each item for every student taking the assessment.

« Formative Feedback — If enabled, a button displays with the option to Review
Incorrect Answers when the student has completed the assessment.
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Rubric Access — If enabled, students can view the rubric for Constructed
Response items when a rubric is available.

Secure Browser — If enabled, students are prompted to use a secure browser
which does not allow access to other computer functions while taking the
assessment.

Media Upload — If enabled, students can upload documents with Constructed
Response items.

Feedback Options — Select how the students see results:

« Full Feedback — If enabled, students have a button to view all details of
their assessment results after submitting for grading. This option includes
each item, the correctness, what response was correct, and rationale for
any answer choices. This must be enabled for the passage details to be
available.

« Incorrect Items (Formative Feedback) — If enabled, students have a
button to view only items they missed during the assessment. This option
shows the stem and incorrect options, but not the student's response or
correct responses.

« Item Summary - If enabled, students have a button to view a brief item
summary. This option includes, the item number, item type, and
correctness. It does not show the item stem or other identifying
information.

« Show Results — If enabled, students see their results at the end of an
assessment.
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« Return Later —If enabled, students can view their results in
StudentVUE in the Online Assessment History after completing the
assessment.

( )
The Feedback Options selected for the
assessment determine the information that
students see. For example, if you only selected
Item Summary, they can see the item number,
item type, and points scored.

Feedback Opticns =
X Full Feedback &

K| Incomect ltems &

X Item Summary €

L" P

I .

v Show Results &

¥ Return Later @

Assessment Creation Screen
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« Staff Settings:

« View Student Results — If enabled, allows others to view Dashboard Analysis
and Live Dashboard.

« Item Detail Options — Select how others see the item details.

« Show item details and responses — If enabled, others have full access
to the items on the assessment and any of their student's responses.

« Show item details and responses after scheduled start — If enabled,
others only see item and response details after the official start of a
scheduled instance of the assessment

« Do not show item details and responses — If enabled, others do not
see any of the items on the assessment or any student response
information.

tem Detail Options -

¥ Show item details and responses @
¥ Show item details and responses after scheduled start @

X| Do not show item details and responses £

nmaratinne
Assessment Creation Screen

« Constructed Response Scoring — If enabled, allows others to score
constructed response items.

« Grant Retakes — If enabled, allows others to allow a student to retake the
assessment.

o Access Now — If enabled, allows others to allow student's immediate access to
the assessment.

o Unlock Student Submit — If enabled, allows others to reopen an assessment
after a student has submitted for grading.

« Manual Response Input — If enabled, allows others to manually update or
enter a student's response for True/False, Multiple Choice, Multiple Select, and
Constructed Response items.

o Override Student Scores —If enabled, allows others to override the student's
score on the Student Analysis screen.

Copyright 2015-2019 Edupoint Educational Systems, LLC



Assessment User Guide
Chapter 4: Create Assessments

112

8. Select the accommodations a student can use during the assessment.

Accommodations

Set the tools available by default for all students taking this assessment.

Q Searc

| Mark for Review

e Attributes
— Y Strikeout ; — - - -
Dioitel Mot ation for assessment classification that do not impact how an assessment is delivered to students.
gita! Notepad
Calculator Grade Level Subject Course
Text-To-Speech

Text-To-Speech Passages

Color Tools.

Assessment Creation Screen

Students have access to the Mark for Review and Highlighter
accommodations if enabled when Iltem Navigation is disabled.

9. Select whether the assessment is grade level (typically used by elementary schools) or
course based (typically used by secondary schools) under Attributes.

« Selectthe Grade Levels and Subject for this assessment if grade level classification.

Attributes

Attributes are general information for assessment classification that do not impact how an assessment is delivered to
students.

Grade Level  Course

Grade Level Subject

Mone

MNone v

Mastery Analysis Band Default Analysis Band

Monge v Mone v

Assessment Creation Screen
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« Selectthe Course Subject and Course for this assessment if course level
classification.

Attributes

Attributes are general information for assessment classification that do not impact how an assessment
is delivered to students.

Grade Level  Course

Selected Course Course Search
Mone Specified

Enter your search here

<< Select == v

Mastery Analysis Band Default Analysis Band

None v None v

Assessment Creation Screen

o Selectthe Default Analysis Band to set the analysis band used when viewing results
of the assessment. Other users scheduling the assessment can change the default
selection.

[\
Mastery Analysis Band is not functional.
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10. Define the Assessment ltems:

When items from an assessment, the Assessment Item window
? displays in Simple display mode. When you are finished entering the
item, click Add/New.

Assessment ltems o

Add, Change, and Remove Assessment ltems

0 item(z) selected for this assessment. 4l1

Measured Standards

This list includes all standards that are part of the selected azsessment items. You can click to toggle these standards on or off. Only selected
standards wil be included in assignments and dashboard analysis.

Mo items with standards have been added yet.

Total Points: 0

Add Existing ltems. Create a New I[tem Add By Standards

L 2 3

Items Overview [ Expandie view |

MNo items added yet. To begin, click the Add/Remove Iltems button above.

Assessment Creation Screen

Displays details of the assessment including the number of items.

Add, Change, and Remove Assessment Items

E Assessment ltems

23 item(s) selected for this assessment.l.ll

Assessment Creation Screen
\. Y,

« Tocreate asingle section assessment:

a. Selectitems by one of the following methods:

« Add Existing Iltems (1)

« Create aNew ltem @

« Add by Standards ©
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« Tocreate a multiple section assessment, for each section:

a. Click Create Sections. @

b. Enter a Section Name, Description, and Instructions.

c. Enter Options, if needed:

« Enter letters with no commas or spaces (for example, LMNOP) in desired

order to Use Alternating Choice Letters.

7

\.

You can use different Alternate Choice Letters for
each section.

2 OOO00 20000 0000
110,00 20ME@OE 200.00O0Q®
Printed Bubble Sheet

J/

« Reserve All ltems — If enabled, teachers cannot use the items during the

reserved time. (District Users Only)

« Enter the Start Date and End Date for the reserved period.

+" Reserve All ltems £

Reserve Dates (Optional) @

Start Date

£/6,/2017 Gl
End Date

6/6/2017 o

Assessment Creation Screen

d. Selectitems by one of the following methods:

« Add Existing

ltems @

« Create aNew ltem @

« Add by Standards ©

115
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e. Rearrange sections, if needed:

« Drag the section name to a new location on the navigation menu to
reorder the sections.

« Click * to delete a section. Click again to confirm.

1. Part One: Language ArtsE

Grade 3 ELA concepts and standards Assessment ID: 1185
Total Points: 1000

<X emip: 7 SR
Inspect !

Q-
0.
)

200 [ il

Points: | 1 " Points: 1 Paints: | 1 Points: | 1 Points: "1

Assessment Creation Screen

Creating Quick Assessments

Quick Assessments are restricted to Multiple Choice and Multiple Select items. Teachers can quickly
schedule these assessments to their available sections. If applicable, users can generate
GradeCam bubble sheets.

1. Select Quick Assessment from New.

2. Enter the Quick Assessment details.

Create a Quick Assessment

Measure your students quickly using the materials already available in class! Quick Assessments are intended for use with
Multiple Choice and Multiple Select items written on a board or provided in handouts. After you are done, the results are available
just like full assessments. You can even reuse these Quick Assessments by scheduling them like a regular assessment.

If you are using GradeCam, you can also print off bubble sheets right here for use in class.

Name Test Document € Which class to target? @ How many items? How many choices per item?

Quick Assessment 1/22/2020 Upload a file Select One or More - 5 1

Create A Quick Assessment Screen

« Name — Defaults to Quick Assessment and the current date.

« Test Document — Teachers can upload a PDF document that displays to students
while testing.

« Which class to target — Teachers can select their sections to allow for quick
scheduling.

« How many items — How many Multiple Choice or Multiple Select items will be
available.

« How many choices per item — The default number of responses generated for those
items.

3. Click * to create the assessment and make further changes.
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4. Customize the items available.

« Enter an optional stem in the text field. (1)
« Selectthe correct response to create a Multiple Choice item or multiple correct
responses to create a Multiple Select item. (2]

o Use to change the number of responses available. ©
« Select the drop-down to use a text field to search for available standards by code. (4]
« Change the number of Points for the item. e

o Select to create additional items for testing. (6]

Customize your items

1 2 3

o x x x

=1+ e =1+] =+)

(2]
(4]

Points: | 1 e Points: | 1 Points: 1

4 5
b 1 X
@
Points: | 1 Points: | 1

Customize Your ltems Screen

5. Save the assessment:

o Teachers click Save and Launch to schedule the assessment to the selected sections
that grants students with Access Now.

« The assessment saves to the Assessment screen where you can schedule it
again.

« Generate GradeCam bubble sheets for the scheduled sections if needed and
available.

« The scheduled assessment displays in the Assessment Dashboard with results
and the ability to use analysis.

« Admin and School level users click Save. The assessments display on the
Assessments screen where you can schedule the assessment as needed.
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Student Testing

This describes a student's interaction with a Quick Assessment with a Test Document uploaded.

1. Loginto StudentVUE > Assessment.

2. Select an assigned assessment. The assessment launches and diplays with the PDF file of
the assessment next to the bubble sheet used to select answers.

4 )
If using accommodations with the Quick Assessment:

« Mark for Review — Located by the Question number. Clicking it
turns it green and marks the question for review.

Question #1[&]

N DN R
A) B L) D)

Quick Assessment

« Highlight — Turn the highlighter on and off by selecting . Itturns
green whenitis on. Students need to turn it off to select their

answers.

To Kill @ Mockingbird was released and became popular during
A. 1970's
B. World Warlll
C. Civil Rights Movement
D. Great Depression

Quick Assessment

o Strike Out — Select and then click the answer to strike out.
Deselect the icon to turn it off.

Question #3 k
P NP
x (B) AR D)

Quick Assessment

Submit for Grading

When the student answers every question the button

displays.

Clicking kit St BT without clicking m clears all answers.

Edupoint Proprietary and Confidential



TKM Formative

Name,

To Kill a Mockingbird
Part One Quiz

MULTIPLE CHOICE — For each statement, write the best answer on the line provided.
1. To Kill a Mockingbird was set during
A 1970's
B. World War Il

C. Civil Rights Movement
D. Great Dey

2. To Kill o Mockingbird war
A 1970’
8. World War Il
C. Givil Rights Movement
D. Great Depression

leased and became popular during

3. To Kill o Mockingbir

C. Scottsboro, Arkansas
D. Finch’ ndi

4. A major goal the children share during su
A See as may is h
B. Make Boo
C. Collect the

Y
ret tree giffs
D. Win at strip poker

5. Scout gefs in trouble her first day of school because
A She reads and writes
he.

e teacher's social mistake
A Retum To StudentVUE

£ o

Assessment User Guide
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7
Abbott, Billy 1@0106

Question #1 &
®EeO0O

Question #2 &
®@EeO0O

Question #3 &
INYOTAYT
(IACIRCOIAC)

Question #4 &
INYAYAYS
@ ® © 0

Question #5 &
INYAYAYS
@@ © 0D

Question #6 &
NN
@w® © o

Question #7 &
NN
@w® © D
Question #8 & >

Quick Assessment

Piloting Items in an Assessment

You can pilot items to students. Piloted items do not count towards the overall score of the
assessment. The items are highlighted in blue for Assessment Details and Analysis screens to allow

users to identify and verify the validity of the item.

e You set Pilot Items when viewing

assessments.

Assessment Details or when creating

1. View Assessment Iltems in Tile View.

2. Click a’ to display more settings.
3. Select Pilot this item.

ltems Overview

1 2

Item ID: 15 SRR oD 14 SRR

The pool st the park is bout 96 feet The jar below has 21 beans in it

ang. If Randy swims scross the

langth of the pool 2 times, sbout how

many fest will ha swini?

Item ID: 12 %

,,,,,,,,,,,,,,,, S —— Look ot the sy % Pilot this item @
= e T Points: | 1
R =mee. T
- LT

1 unit

Based on the information from
the graph and from Ms

-

O e
e

\Wnat is the perimeter of this amay?

Create Assessment Screen

Copyright 2015-2019 Edupoint Educational Systems, LLC



120 Assessment User Guide
Chapter 4: Create Assessments

The tile displays with a blue highlight.

ltems Overview
1 2 3 4
El El El El
Item ID: 15 S RE temD: 14 SRR temip: 10 < %X temp: 13 Rl b
................... + Pilot this item @
The poal st the park is soout 06 fest The jar below has 21 beans in it o o ey Look at the array.
=,
ang. If Randy swims scross the o S m—— TTI Points: | 1
‘angth of the ool 2 tmas, 200t how i T ||
. S oo
L Tunit
o 100 feet Based on the information from What is the perimeter of this sray?
T Em" the graph and from Ms.

Create Assessment Screen

4. Click Expanded View. The blue highlight displays on the item.

4 Edit 1.00
Item ID: 13

Owner: Carroll, Natalie

Bank: District Look at the array.
Item Type: Multiple Choice
Subject: Math

Grade Levels: Grade 03
Status: Live

Standards: —
[ 03M.54.01.2] unt

What is the perimeter of this array?

b 20 Units
Q 24 Units

Create Assessment Screen

5. Click Save. The Total Points for the assessment update to reflect the point value change.

Measured Standards

This list includes all standards that are part of the selected assessment items. You can click to toggle these standards on or off. Only selected
standards will be included in assignments and dashboard analysis.

State Standards
03.M.81.C31 03.M.S2.C1.2 03.M.84.C1.2 03.M.S2.C11

Total Points: 5 (4)

eserve lems

Create Assessment Screen
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Piloted ltems also display a blue highlight on the following screens
accessible from Dashboard (Authorize Students and View Results):

« Manual Response Input screen

i,

« Live Dashboard screen
. Data Table tab on the Student Analysis screen

« Data Table and Detail tabs on the Question Analysis screen
\. J

Adding Items to an Assessment

Adding Items from an Iltem Bank

1. Click Add Existing Items.

Assessment ltems

Add. Change, and Remove Assessment ltems

0 item{s) selected for this assessment. Jh

Measured Standards

This listincludes all standards that are part of the selected assessment items. You can click to toggle these standards on or off. Only selected
standards wil be included in assignments and dashboard analysis.

Mo items with standards have been added yet.

Total Points: 0

Add Existing ltems Create a New ltem Add By Standards

Items Overview

No items added yet. To begin, click the Add/Remove Items button above.

Assessment Creation Screen
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2. Search for items by scrolling through the list or using filters.

Q_ Click Toggle Filter Display to hide the filters.

Assessment ltems

Add, Change, and Remove Assessment ltems
0 itemis) selected for this assessment. Wi

Measured Standards
Thiz list includes all standards that are part of the selected asseszment items. You can click to foggle these standards on or off. Only selected standards
will be included in assignments and dashboard analysis.

No measured standards are available yet.

Total Points: 0

* Reserve All Items €

Done Selecting ltems Toggle Filter Display

o
ltem Type
Text Entry
System
Passzage Title ® Promation Status % Bank ® Item Type X Item ID ¥ Import ID %
Text Entry
Status % Subject % Grads % Course % Depth Of Knowledge 3% Paper/eh 3
AudioNideo % Standard Code X% Standard Tres % Item Preview % Equation Tool %
Imported
Grade Level (Certica) Subject (Certica) % Difficulty (Certica) % Blooms Taxonomy Depth Of Knowledge Language (Certica) %
x . . e . (Certica) % (Certica) % _ _ .
External Id (Certica) %
Item ID: 116320 Solve the equation:
Owmer: User, Admin _
Bank: District Bank
Item Type: Taxt Entry 36 * 8 ? = 123

Status: Liva

This item is Onling Cnly

Assessment Item Creation Screen

3. Select the items to include in the assessment or click Select All to select all available items.

[
Select All works when there are 200 or less items.

4. Click Done Selecting Items.

Edupoint Proprietary and Confidential



Assessment User Guide
Chapter 4: Create Assessments

123

Adding Items from Standards

4 )
Assessments created when older standards were in use, retain those
standards and also have access to the standard branches for analysis.

E Assessments created after the older standards are discontinued do not
display (when hidden) or use those older standards, automatically reflect

L the newer updated standards. )

1. Click Add By Standards.

Assessment Iltems

Add. Change. and Remove Assessment ltems

D item(s) selected for this assessment. i

Measured Standards

This list includes all standards that are part of the selected assessment items. You can click to toggle these standards on or off. Only selected
standards will be included in assignments and dashboard analysis.

Mo items with standards have been added yet.

Total Points: 0

Add Existing ltems Create a New [tem Add By Standards

Items Overview [ Expanced view |

No items added yet. To begin, click the Add/Remove Items button above.

Create Assessment Screen

2. Select Show Codes from Option to view the standard codes and number of items
associated with the standard. The number indicates the number of items available for that
strand/concept.
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3. Select the standards to include by one of the following methods:

« Scroll through the standards.

« Selecta strand or concept under Class Standards list to view a filtered list of
concepts.

-

Use the toggle button to switch between All Standards or Class
Q Standards.

Click © to view the report card correlation information when using
standards for report card rows.

Assessment ltems

Create Sections 6

Add, Change, and Remove Assessment Iltems
0 item(s) selected for this sssessment. oy

Measured Standards

Thig ligt includes sll standards that are part of the selected aszezement items. “ou can click to toggle these standards on or off. Only selected standards
will be included in assignments and dashboard analysis.

No measured standards are available yet.

Total Points: 0

% Reserve All ltems @
oo

Select Your Standards

All Standards All ltems H|"'"|ﬂ factc’rs and e’go"n-?.“'[cs -
Human factors and ergonomics: Psychological factor.
Search 1.1b.f Guidance: Analyze data in relation to ligh...

9 Class Standards
9 03206.1B4585.1 '|J.f@

0 +all  standard

® Human factors and ergonomics

® Human factors and ergonomics: Psychological factors

and texture as qualitative or quantitative (crdinalinterval)

e * 1.1b.f: Guidance: Analyze data in relstion to light, smell, sound, taste, temperature

Assessment Item Creation Screen
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« Alist of standards display © based on selection All Standards or Class Standards. @

« Select Show Codes from Option to view the standard codes and number of items

associated with the standard. ® The number indicates the number of items available
for that strand/concept.

a.
b.

All Standards
All ltems

Options = 1 Selected = DONE

2.1 -
iubtract whole numbers to four digits

#| Show Codes

03.M.51.C3 2
Concept 3: Estimation

03.M. 31.03.@
Make estimat@S appropriate to a given situation or computation

with whole numbers.

N3 M <9 5

Assessment Item Creation Screen

Click * @l to select all listed standards. @
Selected standards display on the row. ©
The last four standards that were selected display by Recent. (6]

To use the Search function:

Click All Standards.

Enter your search criteria in the Search field. As you type, the standards that
meet the search criteria display.

Select the applicable standard. The standards list displays.

Available
All ltems / Strand 4: Geography | Concept 1: The World in Spatial Terms
All Standards 5 Describe characteristics of human and physical ...
g

- 5 Describe characteristics of human and physical features: a. physical ? (i.e., river, lake, mountain, range, coast, sea, desert, gulf, bay, sirait, plain,

1253 - 6 Locate physical and human features using maps, illustrations, images, or globes: a. physical (i.e. river, lake, mountain range, coast, ses, desert, g
1273 - 1 Describe the impact of gecgraphic features (e.g., rivers, mountains, resources, deserts, climate) on migration and the location of human activities
1960 - 02 Explain the compesition, properties, and structure of the Earth?s lakes and rivers.

2.2.P0 3 - Describe the importance of the following river valleys in the development of ancient civilizations:

2005 - 3 Describe the impertance of the following river valleys in the development of ancient civilizations: a. Tigris and Euphrates - Mesopotamia b. Nile - |
2062 - 4 |dentify how factors such as riverfcoastal civilizations and frade influenced the location, distribution, and interrelaticnships of economic activities o
207 - 4 Recognize characteristics of human and physical features: a. physical (i.e., ocean continent, river, lake, mountaing, islands) b. human (i.e., eguator

- o Dot — | Strand 4: Geography

Standard Selection Screen
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d. Select the applicable standards. Once selected, standards display on
the row.

Options - 1Selecied =

+ all Standard

1246
Strand 4: Geography

1247
Concept 1: The World in Spatial Terms

1252
5 Describe characteristics of human and physical features: a. physical ? (ie.,
river, lake, mountain, range, coast, sea, desert, gulf, bay, strait, plain, valley,
volcances, isthmus, canyon, plateau, mesa, casis, dunes); b. human 7 {i.e., equ

Standard Selection Screen

e. Repeat until all standards are selected.

4. Click Available By Standard @ to randomly select the items to include in the assessment.

a. Select the options to filter the available items by Depth of Knowledge, Language, or
Item Type. (1]

Make sure your filters are as intended because if you select
A only English, Synergy Assessment randomly selects from
only items identified as English.

b. Select the number of items @ that are Available by Standards.
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c. Click Add (3] The number of items selected for this assessment increases. (4]

Assessment ltems

Add, Change, and Remove Assessment ltems

0 item(s) selected for this assessment.

Reserve All ltems @

oFF

Done Selecting Items | Select Your Standards | Available by Standard

Depth Of Knowledge Language ltem Type
* 1. Recall # English ¥ Constructed Response
2. SkilllConcept None Specified EBSR
# 3. Strategic Thinking # Spanish ¥ Graphic Gap Match
None Specified ¥ Hot Text
o Inline Choice
¢ Multi-Part
¥ Multiple Choice
# Multiple Select

Available by Standard

3.RF.3.a: Identify and know the meaning of the most common prefixes and e 3 J84 m e
derivaticnal suffixes.

3.RF.3.c: Decode multisyllable words. 162 m
3.RF.3.d: Read grade-appropriate irregularly spelled words. 135 m
3.RF.4.a: Read grade-level text with purpose and understanding. /8 m

Assessment Creation Screen

There is no preview of the items that were selected. To view the included
= items, view the saved assessment from the Assessment Creation screen.
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5. Click Done Selecting Items when complete. The Measured Standards update with the
selected standards.

« Greentiles indicate the items related to that standard are analyzed.
« Redtiles indicate that the items related to that standard are not analyzed.

Assessment ltems

Add, Change, and Remove Assessment Items

Add [tems Create a New Item

Reserve All ltems @
o

Measured Standards

This list includes all standards that are part of the selected assessment items. You can click to toggle these standards on or off. Only
selected standards will be included in assignments and dashboard analysis.

[Asse2[asse 3o [ Axpm1| Acent | Acena ] arei4a | Arets] arer1o] Are11] s | irra] Firss | rora]
[Forie s [sioe ][ [vat [ies] s aree mmer s [ [ rors]

Selected ltems

1t0 100f 33

Assessment Creation Screen

? Click the tile to toggle it on or off for analysis.
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After editing items in an assessment, rescore assessment to update the
scores for all students who have ever taken the assessment.

|

You can change the way the Items display in the assessment:

« Tile View — Items display as tiles with editing options.

« Expanded View — Click Expanded View to view the items in a list. Scroll down to view and
edit the items.

[ E Click Tile View in Expanded View to view items as tiles.

J

ltems Overview
1 2 3
ltem 1D: 80709 &% jtem ID: 80710 &% jtem ID: 80712 %
Points: [ 1 Points: [ 1 Points: [ 1
5 6 7
Iltem ID: 80720 "% tem ID: 80724 <% tem ID: 80725 %
i
Points: [ 1 Points: [ 1 Points: [ 1

Item ID: 80714 &%

2g he pars of the Sper cutothe dagram

—

)

Points: [ 1

8

-
Item ID: 30726 o %

Points: [ 1

Assessment Creation Screen

Using Tile View

Edititems in the assessment using the following methods:

Change the order, by dragging 2 to a new location.

« Change the Points for the Item.

l’
Click * to view the full item detail.

Click * to remove the item from the assessment. Click again to confirm.

129
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Using Expanded View

« Point value and/or sequence

o ltem detail

Point Value or Sequence

The creator of the assessment may edit the item point value and the sequence of the itemin an

assessment. District staff with editing permission may edit point and sequence values of all district
created assessments.

1. Select the assessment to edit in the Assessments screen.

Assessment ltems T

Add, Change, and Remove Assessment ltems

Copy assessment
This assessment has results. While you cannot add new items, you can remove items. Use this feature with caution, as some gi:: : ﬁ::::t:: :’:z::: with
students do have results that may be affected. Removing items is not final until Submit and then Save is pressed. To Rescore after instructions
changing an item point value, Submit and Save first, then Rescore. .
Changing the Measured Standards wil not update any already-created assignments connected to this assessment, though it will
reflect on Dashboard results.

This assessment has
Measured Standards scores against it, which
This list includes all standards that are part of the selected assessment items. You can click to toggle these standards on or off. el i ies
Only selected standards wil be included in assignments and dashboard analysis. questions.

No items with standards have been added yet.
' & Display Mode: [

Selected Items
5 tems

Gedt|  itemn Details Itemn Preview Points Sequence

Item Type: Mutiiple Choice =2 100
Subject Math
Grade Levels: High School

Course: N/& Which table below
Depth of Knowledge: Mone represents an

Status: Live X .
Item 1D: 1 exponential function?

Assessment Creation Screen
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2. Click edit under Assessment ltems.

Selected Iltems

11010 0f 33 e & Apply Changes G CANCEL
e Chide Item Details e Préeview Points Sequence
Item Type: Multiple Choice E 200 i]
Subject Math

Grade Levels: High School

Course: MN/A Which table below
Depth of Knowledge: None represents an

el Stafus: Live ) _
Item ID: 1 exponential function?

Assessment Creation Screen

The fields you can change appear in boxes (1)
« The " jcon displays when a row was updated @

Click Apply Changes to save your edits ©

Click hide to hide fields that you can change (4]

E If you updated a field, it still displays until you click Save or Cancel.
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Editing the Item Detail

7

.

Item text may be updated at any time. For example, when a typing error is
identified after the students have begun to take the assessment.
“= However, do not significantly change the text of the item to favor students

beginning the assessment after the change.

Standards can be added to items at any time.

\

1. Select the assessment to edit in the Assessments screen.

Assessment ltems

Add, Change, and Remove Assessment ltems

This assessment has results. While you cannot add new items, you can remove items. Use this feature with caution, as some
students do have results that may be affected. Removing tems is not final until Submit and then Save is pressed. To Rescore after
changing an item point value, Submit and Save first, then Rescore.

Changing the Measured Standards wil not update any already-created assignments connected to this assessment, though it will
reflect on Dashboard results.

Measured Standards

This list includes all standands that are part of the selected assessment items. You can click to toggle these standards on or off.
Only selected standards wil be included in assignments and dashboard analysis.

Mo items with standards have been added yet.

Selected ltems

S tems

Cean Item Details ltem Preview Points Sequence

Item Type: Muliiple Choice [ £ | 1.00
Subject Math
Grade Levels: High School

Course: N/& Which table below
Depth of Knowledge: Mone represents an
Status: Live

Item ID: 1 exponential function?

===y

Rescore Retum

Copy assessment

Open a printable version
Open a printable version with
instructions

‘iew assessment as a student

Restore assessment

This assessment has
scores against it, which
prevents adding new
questions.

Display Mode: [IE

Assessments Creation Screen

2. Click Edit under Assessment ltems. The item opens for editing in simple display mode.

Assessment Iltem

Item Type

Important Settings W

Constructed Response

Important Settings W

- I

Assessment Item Screen
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3. Make the changes to the item.
4. Click Save to save the assessment.

Deleting Items from an Assessment

s

ltems can be removed from an assessment after an assessment has
started and has results.

— Removed items are not presented to students who start the assessment
after the change.

Removed items do not appear in the Assessment Dashboard.

J

\.

1. Click * nextto the row in the Create Assessment. The icon displays on the row.

Look at the puzzle. 1.00 3

Which piece completes the puzzle?

Assessment Creation Screen
2. Click Submit. The deleted item is removed from the assessment.

3. Click Save to save the assessment.

Copyright 2015-2019 Edupoint Educational Systems, LLC



134 Assessment User Guide
Chapter 4: Create Assessments

Using Scoring Bands

A Scoring section is available when creating and launching an assessment, with the current option
of Scoring Bands creation.

Scoring Bands are similar to Analysis Bands, except instead of grouping students to display in color
schemes, Scoring Bands can manipulate a student's overall score based on a defined score range.
This new scaled score is presented to students alongside their traditional Overall Score when they
complete an assessment. This Scaled score is available on Student Analysis and in all data
calculations, charts, reports, and is stored within the database.

1. Navigate to an Assessment.
2. Navigate to the Scoring Section.

3. Click T to Create Band.

a. EnteraBand Name and Description.

Admin users can create Private or Public Scoring Bands. All
other users can only create Private Scoring Bands.

Scoring Band

New Band « o

Basic Rules €

Band Name
New Band
Description

Enter a Description

Visibility

Private v

Scoring Band Screen

4. Selectthe Rules tabto add arule.
5. Enter the score values to apply the rule to in the Score Range.
6. Enter the rule or value to apply to the overall score in the Becomes field.
« Rules can take on plain values or formulas. For a plain value, set a range and a value.
» The default score is used for values without a rule.
« Formulas use the letter 'n' to indicate the student's score.
« Formulas support these basic groupings and operations: (),||, *,/, +, -, *.
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« In addition, these math functions are also available:

=log(a)
=log10(a)
=max(a,b)
=min(a,b)
=round(a,places)

Assessment User Guide
Chapter 4: Create Assessments

7. Testthe rules during creation by using the Test It! feature. This performs all calculations.

8. Click Save.

Basic

Rules @

Standard Not Met
Score Range | Becomes @

Pl

0 |-| 4199

Standard Nearly Met
Score Range | Becomes @

42 |- &7.99 || =max(n,55)

Standard Met

Score Range | Becomes @

55 |-| 7699 || nv2452+342)

Add a Rule

Test It!

Value: | 48 |Result: 55

Scoring Band Screen, Rules Tab

135
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Student Analysis shows the Overall Score and the Scoring Band Score. Hover over the Scoring
Band Score to see which rule was applied.

For Admin users, School Analysis and Teacher Analysis report the
Scoring Band Score.

Scoring
Overall Band 1(MC) 2(MC) 3(MC) 4 (MC)
Score Score - 2] 2] [} [}

7273% 63.64% 63.64%

1010 (100%) 100% A B A B
810 (80%) 100% A B A B
9/10 (90%) 90% A B A B
710 (70%) 65% A B A B
610 (60%) 65% A B A B
510 (50%) 42% A B A B

Student Analysis, Scoring Band Score

Overall results that display to the student when they complete the assessment show the Scoring
Band Score as the overall percentage. The calculated value also displays.

Overall Score

419

0/10(0%)
LA 5.2.1.h Prootread and edit writing recursively for format and conventions of standard 0 (y
English (e.g.. spelling, capitalization, grammar, punctuation, syntax, semantics). 0
0/10

90

60

30

0 @

Overall Results, Scoring Band Score

E If selected to create a Grade Book assignment, the Scoring Band Score is
pushed into the Grade Book.
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Previewing Assessments

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Aszseszment » RTlI - Admin -

Item Bank (Create & Edit ltems)
Dashboard (Authorize Students & “iew Resulis)
Assezsments (Creste & Scheduls Azssssments)

Bank Management (Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Cooencibemn

Assessment Menu

2. Select the assessment.

@_ Use filters to search for specific assessments.

3. Click Open a printable version to open a new tab with the assessment preview.

Ea =D

. Return

Dy agsessment
| Open a printable version
TEW S SES T B 3 STdent

Rescore assessment

Assessment Screen
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Print Opticns - m

Third Grade Summative Assessment: Part One: Language
Arts

Description

This section tests student mastery of Grade 3 ELA concepts and standards.

Question #1

Instructions
TEACHER READS:

Read the guestion to yourself and select the best answer.

Which word BEST completes the sentence below?

|Sh3u|d tell cur parents that the movie was a'mul”1

0 e
e him
Q her

Assessment Print Preview

4. Selectthe Print Options.

Print Options = |m

+" Show assessment description
+' Show assessment instructions

+" Show answers

v
]
3

[(e]

t ¥ show item instructions

| ¥ Use two columns for multiple choice
+" Only print passages the first time
¥ Randomize items

¥ % Randomize multiple choices

Assessment Print Preview

« Show assessment description — Select to print the Description (if defined) of the

assessment.

« Show assessment instructions — Select to print the Instructions (if defined) of the

assessment.
« Show answers:
« Selectto print an answer key for teachers/users.
« Do not select to create a printed version to give to students.

« Show item instructions — Select to print Instructions (if defined) for individual items.
« Use two columns for multiple choice — Select to print Multiple Choice and Multiple

Selectitems in two columns as a paper saving option.
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« Only print passages the first time — Select to print a passage once when multiple
items correlate to the same passage. Use as a paper saving option.
« Randomize items — Select to print Items in a random order.

« Randomize multiple choices — Select to print Multiple Choice and Multiple Select
item responses in a random order.

5. Click Print.

Using View All or View Just Mine

A new option is available for administrators and principal users to View All or View Just Mine from
the Assessments screen. When selected to View All, the user sees all teacher-created banks or
assessments and can navigate to Assessment Details, Schedule Details, or Results Analysis. This

option does not provide edit rights to the assessments.

1. Login as an administrator or principal.

2. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Aszezement ~ RTlI - Admin -

J tem Bank (Creste & Edit llsms) L

Dashboard (Authorize Students & \iew Results)

Azzessments (Create & Scheduls Azssssments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

1otk

Assessment Menu
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3. Click View All to have access to assessments based on applied security settings.

« New School Name and Teacher Name filters are available.
« Ifviewing by Folder Style, details of each school are available.

. m —Indicates the number of teachers available at for the school or teacher
. E’ — Indicates the number of banks available for the school or teacher

. m — Indicates the number of assessments available for the school or

. Folder Style - Tile+ View Just Mine m
e All Assessments  TestHistory & Setiings Styl
Sort by Name t | Sort by ID
System &

P po— A Adams Elementary €5 €5 €0 A District €0 €D

As: it N: Schoal N;
/SESWEH e | c uﬂu ame | # Edupoint School District € CF) # Hope High School €8 €D €D

Teacher Name Assessment Creator

Schedule Status Reserve ltems
Imported Shared
Show Emply Banks  Subject

Grade Course

# Jefferson Elementary €9 €T A Kennedy High School €3 €T €Y

Assessments Screen

4. Click a school to see the available teachers.
5. Click ateacher to view their available banks.
6. Click the bank to view available assessments.

E Select the row header to navigate back to a previous view.
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7. Select Results Analysis from Options to open the Results Analysis screen for the

Assessment.
All Assessments Test History £ Settings Folder Style ~ Tile =
A Hope High School © 0 10 (0
2 Lewis, Jeff 10 0

B Without a Bank © 7

Sort by ID 4 | Sort by Name

% Basic Constructions
Assessment 1D: 2220

Owner: Lewis, Jeff

Description:

(Mon-compass based) ex.

midpoint, perpendicular,

angle bisector.

Points: .00
Subject: Algebra
Grade: Grade 10
No Date Limit
No Time Limit

Options =

¥ Basics of Geometry
Assessment ID: 2219
Owner: Lewis, Jeff
Description:
Refresher on the building
blocks of geometry including
points, lines, planas,
segments, rays, and angles.

Points: 7.00
Subject: Algebra
Grade: Grade 10
No Date Limit
No Time Limit

Options =

Assessments Screen

8. Select the name of the assessment to view the assessment details.

9. Locate the Scheduled Instances.

10. Select aninstance to view the scheduled details.

Scheduled Instances

View existing or schedule new instances.

0L/1818

Assessment Schedule Screen
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11.

Select the name of the assessment to view the Student assessment Results.

Basics of Geometry 4 schedued instance

Schedule ID
Level

Scheduled By

Instance Of Assessment
Assessment ID
Assessment Created By

Settings

Grade Book Settings

Date and Time Settings

1014
Teacher Level

Lewis, Jeff

Basics of Geometry
2218
Lewis, Jeff

# Item Navigation €
Randomize Item Order @
Randomize Answer Order €
Rubric Access @

Media Upload €

Full Feedback €
Formative Feedback €
Item Summary €

¥ Show Results @

¥ Return Later @

® Secure Browser @

¥ View Student Results €
Item Detail Options

' Show item details and responses €
% Show item details and responses after scheduled start

% Do not show item details and responses €

# Constructed Response Scoring @

¥ Grant Retakes @

¥ Access Now @

2 Unlock Student Submit €
. Manual Response Input @
% Override Student Scores @

¥ Grade Book Pull @
% Connect Grade Book €

Start Date. 122772018
End Date. 1182019

\iew assessment details

Details

Schedule Name: Basics of
Geometry

Assessment ID: 2219
Schedule ID: 1014

Total Points: 7.00
Scheduled By: Lewis, Jeff
Created By: Lewis, Jeff
Scheduled To: Scheduled To

Schedule Details Screen
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Promoting Assessments for District Use

If the district allows teachers to promote assessments for district use, the Nominate to District field

displays on the screen.

[\
The assessment must be saved before the Nominate to District is a link.

Submitting Assessments for Promotion

To nominate an assessment, teachers:

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Assessment ~ RTI -~ Admin -

Item Bank (Create & Edit ltems)
Dashboard (Authorize Students & 'iew Resulis)

Aszessments (Create & Schedule Assessments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Paszsages (Create & Edit Passages)

2. Select Assessments.

Assessment Menu

Assessments

Sort by ID | Sort by

Ideals of Government

Tie v| Assessment v m

Name

Assessments Screen

3. Select Assessment Details from Options for the assessment.

4. Click Nominate to District.

Assessment Info

Name

Descriptio

Styles

Name the assessment and describe its content

Battles of World War Il Test

Promotion

Nominate to District | @

BIUSHK XX I [=:2 £ =g == 8nEE e OM=0fxx

n

Normal - Font - s - A-@

Assessment Screen

A Nomination for Promotion tab and a success message displays.
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~
To cancel a nomination, select the assessment from the Nomination

for Promotion tab and click Cancel Nomination to remove the item
from district consideration.

Assessment Info
o Name the assessment and describe its content

Name

Battles of World War Il Test

Promotion

Cancel Nomination | @

Assessment Screen

Approving Assessments for Promotion (District Users Only)

When assessments are nominated for district use, the Nomination for Promotion tab displays on
the Assessment screen.

Your Assessments I Nomination for Promotion I

1 items

Assessment Details Creator Promotion Status

Tom Smith Requested
Battles of World War |l Test

A comprehensive test covering the battles of the Pacific.

Subject History
Grade: Grade 09

Assessments Screen

Select and review the assessment.

« To approve the assessment for district use, select Approve (1 39N copy of the assessment is
created for district use.

( )
Promoted items display a message.
Assessment Info
Name the assessment and describe its content.
s Name
= Battles of World War |l Test
Promotion
* Successfully promoted from Tom Smith View cument teacher version
Description
Assessments Screen
\. J
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« Todeny the assessment:
a. Provide an explanation for the denial (2}

b. SelectDeny (3}

Assessment Info

Name the assessment and describe its content.

Name

Battles of World War |l Test

Promotion

This assessment has been nominated for promotion to the district-evel. If you choose to approve, press the
Approve button. If the assessment needs comections before you can approve, or you cannot approve for other
reasons, provide feedback to the user using the text field below.

(1 ] somos

Reason for Denial
e “

Assessment Screen

Resubmitting Assessments for Promotion

If an assessment is denied, the teacher can modify the assessment and resubmit for approval.

Your ments Nomination for Promotion
1 items
Assessment Details Creator Promotion Status
Tom Smith ¥ Denied
Battles of World War Il Test | X Deried]

A comprehensive test covering the battles of the Pacific

Subject: History
Grade: Grade 09

Assessments, Nomination For Promotion Tab

1. Select the assessment on the Nomination for Promotion tab.

Promotion
Re-submit to Distict @ e

You have received feedback for your nomination. If desired, you may make
changes and re-submit for approval.

District says:
This assessment does not have enough questions with assodoted standords

Assessment Screen

2. Review the reason for denial. 0
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3. Make the requested changes.

4. Click Re-submit to District. @
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Scheduling an Assessment

The tabs that display on the screens depend on security settings. You
may not see all tabs and options discussed in this topic.

Schedule an assessment from the Assessments screen. When you schedule an assessment, you
are setting the time period that the student can take the assessment.

Working with Transferred Students

Teachers can view transferred students in the Schedule Details screen of their old class. The
teacher can grant access to the new class or leave the student as-is in the old class.

« Ifthe teacher assigns the student to their new class, the student's scores transfer if the
student completed the assessment. The teacher can grant access to any assessment in the
new class.

« Ifthe teacher leaves the student as-is, the teacher can allow the student to complete the
assessment in the old class.

« The teacher can manually move any Grade Book scores to the new class.

Schedule Details indicates when there is a new student available to take that assessment when new
students are transferred to a teacher's section or class and there is an assessment already
scheduled that includes the target the student belongs to. A message displays indicating, "New
students found and can now take test." Locate the new student in the list of targeted students and
update their access to that Assessment.

Grade Book Mass Sync must be performed for the Update message to
display on the Schedule Details of a previously scheduled assessment.

Scheduling Assessments with Archived or Omitted Items

The ability to schedule assessments with archived or omitted items is restricted.
' )
Archived items used in assessments:

g « Display a message on the assessment preview and on the
assessment.

« Are highlighted in red on tests and on the Assessment screen.
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The schedule button does not display on the assessment preview. You
can override the setting and schedule the assessment.

Before using an assessment that uses archived or omitted items, modify
the assessment by one of these methods:

» Change the point value of the archived or omitted items to 0.
- « Remove the items:
1. Make a copy of the assessment.
2. Remove the archived or omitted items.

3. Usereplacement items if needed for future testing.
\. J

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Assessment ~ RTlI » Admin -

ltem Bank (Create & Edit liems)

Dashboard (Authorize Students & View Results)

Azzezsmenis (Create & Schedule Azssssments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Assessment Menu

2. Select Assessments.

Assessments Tie | Assessment v m

Sort by ID | Sort by Name

Ideals of Government
al

Assessments Screen
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3. Select Schedule from Options for the assessment.

Assessments Test History £ Settings Assessment ¥
rt by ID | Sort by Name
Quick Assessment 7/17/2018
Gradecam #,
Assessment ID: 8 =
Banlk: Mone Assessment ID: &
Total Points: 200 Banike None
Created By: District Total Points: 5.00
Created By: District
Mo Date Limits o
Mo Time Limits Mo Date Limits
Mo Time Limits
Options
. Cptions +
Actions
Schedule
| Archive CR ) )
Views Certica - with CR
Assessment Detalls Assessment ID: 11
| At Anaie Bank: Maone
| Fesuls Analyss Total Points: 20.00
TN FOINTS: 27,00 Created By: District
Created By: District
- Mo Date Limits
No Date Limits No Time Limits
Mo Time Limits
Options =
Options =
Assessments Screen

? Use filters to search for assessment to schedule.
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Instance Settings

e “

Click View assessment details to view the Assessment Creation screen.

0 Return
= View assessment details

WView results analysis

Schedule Assessment Screen

Instance Settings

Various settings and properties for this scheduled instance.

Schedule Name o

Quick Assessment 121202017

Status

Active This schedule is available for students based on their access settings.

Schedule Level o
District

Student Settings

Determine how the assessment is presented to students.

% Item Mavigation & % Secure Browser @
® Randomize Item Order € ® Media Upload €
® Randomize Answer Order @ Feedback Cptions -

% Rubric Access &

Staff Settings
Determine which options are available to school level users and teachers tied to a scheduled assessment.
" View Student Results € " Access Now @
tam Detsil Cptions % Unlock Student Submit €
" Constructed Response Scoring @ % Manual Response Input €
" Grant Retakes @ *® Override Student Scores @

Schedule Assessment Screen
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1. Enter a Schedule Name.

Use unique names to schedule more than one instance of the same
=  assessment.

2. Selecta Status.
« Active — Makes the assessment available to students based on their access settings.

« Paused - Prohibits students from accessing the assessment online regardless of the
access status of the test.

When paused, GradeCam options and manual entry of scores are
available to teachers and admin users.

3. Select a Schedule Level — District level users select District or School.
4. Setthe Student and Staff Settings:

¢ Student Settings:

« Item Navigation:

« Ifenabled, allows the students to scroll back and forth through the
assessment and change their answers before submitting it. Also allows
the student to highlight in yellow, strikeout in red, and to mark items for
review.

. Ifdisabled, the student is not allow to revisit items. They are allowed to
mark incorrect answer red to help them decide on the correct answer.

o ForINSPECT Inline Choice items, allows the student to click Next
Question without viewing or changing the drop-down answers. It
selects the first item listed as the correct response if the student
clicks Next Question.

o Fornon-INSPECT Inline Choice items, does NOT allow the student
to click Next Question without selecting an answer from the drop-
down list of choices. A message displays that says No Skipping if
the student click Next Question.

« Randomize Item Order — If enabled, shuffles the order of the items for each
student taking the same assessment.

 Randomize Answer Order — If enabled, shuffles the order of possible answers
to each item for every student taking the assessment.

« Formative Feedback — If enabled, a button displays with the option to Review
Incorrect Answers when the student has completed the assessment.

« Rubric Access — If enabled, students can view the rubric for Constructed
Response items when a rubric is available.

« Secure Browser — If enabled, students are prompted to use a secure browser
which does not allow access to other computer functions while taking the
assessment.
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« Media Upload - If enabled, students can upload documents with Constructed
Response items.

« Feedback Options — Select how the students see results:

Full Feedback — If enabled, students have a button to view all details of
their assessment results after submitting for grading. This option includes
each item, the correctness, what response was correct, and rationale for
any answer choices. This must be enabled for the passage details to be
available.

Incorrect Items (Formative Feedback) — If enabled, students have a
button to view only items they missed during the assessment. This option
shows the stem and incorrect options, but not the student's response or
correct responses.

Item Summary — If enabled, students have a button to view a brief item
summary. This option includes, the item number, item type, and
correctness. It does not show the item stem or other identifying
information.

Show Results — If enabled, students see their results at the end of an
assessment.

Return Later — If enabled, students can view their results in
StudentVUE in the Online Assessment History after completing the
assessment.

( )
The Feedback Options selected for the
assessment determine the information that
students see. For example, if you only selected
Item Summary, they can see the item number,
item type, and points scored.

¥ Full Feedback &
X Incorrect ltems 6

X Item Summary €

L™ P

A .-

v Show Results &

X Return Later @

Assessment Creation Screen
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» Staff Settings:

« View Student Results — If enabled, allows others to view Dashboard Analysis
and Live Dashboard.

« Item Detail Options — Select how others see the item details.

« Show item details and responses — If enabled, others have full access
to the items on the assessment and any of their student's responses.

« Show item details and responses after scheduled start — If enabled,
others only see item and response details after the official start of a
scheduled instance of the assessment

« Do not show item details and responses — If enabled, others do not
see any of the items on the assessment or any student response
information.

tem Detail Options -

+ Show item details and responses €
¥ Show item details and responses after scheduled start €@

X Do not show item details and responses @

nmndatinne
Assessment Creation Screen

« Constructed Response Scoring — If enabled, allows others to score
constructed response items.

« Grant Retakes — If enabled, allows others to allow a student to retake the
assessment.

o Access Now - If enabled, allows others to allow student's immediate access to
the assessment.

o Unlock Student Submit — If enabled, allows others to reopen an assessment
after a student has submitted for grading.

« Manual Response Input — If enabled, allows others to manually update or
enter a student's response for True/False, Multiple Choice, Multiple Select, and
Constructed Response items.

o Override Student Scores — If enabled, allows others to override the student's
score on the Student Analysis screen.
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Accommodations

Select the accommodations any student can use during the assessment.

Accommodations
Set the tools available by default for all students taking this assessment.

v Mark for Review

o e Attributes
— ¥ Strikeout . - N
S ation for assessment classification that do not impact how an assessment is delivered to students
gital Notepad
Calevlator Grade Level Subject Course
Text-To-Spesch

Text-To-Speech Passages

Schedule Assessment Screen

You can select the accommodations for a specific student in Student
==l Access.

Attributes

Select the Default Analysis Band to set the analysis band used when viewing results of the
assessment. Other users scheduling the assessment can change the default selection.

Attributes

Attributes are general information for classification that do not impact how an assessment is delivered to students.

Mastery Analysis Band Default Analysis Band

Mong v Mone r

Schedule Assessment Screen

[\,
Mastery Analysis Band is not functional.
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Grade Book Settings

District Users

Grade Book

Student results can be automatically pushed to teachers Grade Books, orteachers can
have the option to pull in these results.

" Grade Book Pull €
¥ Grade Book Push @

Schedule Assessment Screen For District Users

« Grade Book Pull — Default setting. Select to have the results pull from the Student Analysis
screen into the teacher's Grade Book. (District Users Only)

« Grade Book Push —If selected, the assignment is created in Grade Book for the assessment
and can be targeted to a course, section, and period. See Pushing Scores to Grade Book for
information on completing the options that display. (District Users Only)

Teachers

« Connect Grade Book — Select to automatically update scores in Grade Book when students
complete the assessment. (Teachers Only)

« Auto-Create a new Grade Book assignment — Creates a new assignment as
students complete the assessment.

« Connect to an existing Grade Book assignment — Displays a list of assignments
available in the targeted sections for the assessment.

You can view the Grade Book Assignment list as a Compact
E Row, Full Row, or Tile.

This option is dependent on the students assigned and
displays an alert until the target groups are added.
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Grade Book

Select default Grade Book assignment options if you wish to connect this assessment instance to your Grade Book.

+" Connect Grade Book

Auto-Create a new Grade Book assignment @

® Connect to an existing Grade Book assignment €

Grade Book Assignment

Folder Style ~ Compact Row ~

Sort by ID | Sort by Name 4

(52) Jackson, K Am Govt(4) SEC:1469[CD)|

Section ID: 1469

]
(52) Jackson, K Am Govt(2) SEC:1269 ()

Section ID: 1269

]
(51) Jackson, K Am Govt(4) SEC:0469

(51) Jackson, K Am Govt(3) SEC:0369

Section ID: 0369

Schedule Assessment Screen For Teachers

All Users

« Assignment Type indicates if the type of assessment as defined by the district. For example,
homework, quiz, assignment, social behavior, or work study habits.

« Assignment Category indicates how the assessment is graded. It can be graded as a
normal item, as extra credit, or not for grading.

« Score Type indicates the assignment score type.

« Assignment Date indicates the date of the assessment. Defaults to today's date. Change if
needed.

E Places the assignment in the appropriate grading period.

« Points indicates the points that impact the student’s score.
« Show in Parent Portal displays in ParentVUE if enabled.
» Grading Period indicates the grading period the assessment belongs in. (Teachers Only)

N
? Use the Ctrl key to select multiple Grading Periods.
J
)
When Grade Book is enabled, a Grade Book column displays in the
Student Assessment Results screen. )
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Availability and Targeting Settings

Availability and Targeting

Date and Time

This assessment can follow the default settings provided from the District Calendar and
School Bell schedule. By default, this assessment is cumently scheduled for today.

»" Align with the Disfrict Calendar £
»" Align with the School Schedule &
Use this feature to select date ranges for this instance on a calendar. €

Use this feature to select the time ranges for this instance. @

Targeting

Select students to assign by searching for School, Grade, Course, Subject, Teacher,
Section, Student Group or Student Name. These targeted groups can then be further
defined and given a different Date and Time

Schedule Assessment Screen

1. Selectthe Date and Time options:
« Align with the District Calendar — Select to exclude weekends and holidays.

« Align with the School Schedule — Select to have the times follow the defined
bell schedule.

« Dates — Select the date ranges for this assessment.
» Hold the Shift Key to select a range.
« Dates highlighted in blue are included in the schedule.

« Target weekend dates by selecting Su or Sa in the Calendar to remove
the red highlight.

Dates 2 days selected between 12/6/2016 and 1/3/2017

N 12 13 14 15 16 B
18 19 20 21 22 23 24
25 26 27 28 29 30 N

Schedule Assessment Screen
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« Times — Select the time range of the assessment.

« SelectUse a time range for your dates to select time range other

than the bell schedule.

® Times 12:00 am to 11:5% pm

»Use a time range for your dates

2. Select the Targeting options:

12 «|:| oD =~

am v

ling
pm v Jeis

Schedule Assessment Screen

a. Click Add a Target Group.
b. Selectthe targeting type.

« District or School Level user can target the assessment by School,
Grade, Course, Subject, Teacher, Section, or Student.

A Grade Book Push can only occur if the Assessment is
targeted to a Course, Section, or Period, and displays

ﬁin the Target Group.

« Teachers can target to Section or Period.

Targeting

Date and Time

Student Acce

A comprehensive list

Select students to assign by searching for School, Grade, Course, Subject, Teacher, Section, Student
Group or Student Name. These targeted groups can then be further defined and given a different

+ Add a Tamget Group

Select and Search

Based on enroliment for 1/4/2017

Course v

| a

) grant access.

1. 15T SPED LANGUAGE ARTS (1-5P-LANG ART) 1
2. 2MD SPED LANGUAGE ARTS (2-SP-LANG ART) | 4
3. 3RD BILINGUAL LANGUAGE ARTS (3-BIL-LANG ART)

4. 3RD GEMERAL LAMNGUAGE ARTS (3-GEN-LAMG ART) 12

5. 3RD SPED LANGUAGE ARTS (3-SPLANG ART) &
6. 4TH SPED LANGUAGE ARTS (4-SP-LANG ART)| 11
7. 5TH SPED LANGUAGE ARTS (5-SP-LANG ART)| ®

+H+HHHHE++

Schedule Assessment Screen

c. Search by keywords. Courses can be searched by name or ID.

159
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d. Select the targeted audience:

. Click ¥ toadda group.

o Click to select all of the groups.

« Click ' to view the students in the group.

You can select multiple Target Groups for a single
scheduled instance

The selection displays.

Targeting

Select students to assign by searching for School, Grade, Course, Subject, Teacher, Section, Student Group or Student Name. These
targeted groups can then be further defined and given a different Date and Time

# Add a Taget Group
CGZD 1ST SPED LANGUAGE ARTS (1-SP-LANG GZD 2ND SPED LANGUAGE ARTS (2-SP-LANG
ART) D F] Bx ART) B fx] [+ B
Scheduling Assessment

. B The count of students targeted. This number updates based on
further targeting. Click to view the list of students.

. A To view Grade Book options. Select Override default options to

change the settings.

— Click to display the days and time selected.
u — Click to add a subgroup to target a specific group.

* _Click to remove a target group.

@D 15T SPED LANGUAGE ARTS (1-SP-LANG q
ART) B

Student Access

CE]+ K A
#" Include In Grade Book €
» ODverride default options

X Show in Parent Portal @

A comprehensive listing of all st Assignment Category:  torma v 1t

After saving you cal g

| P LI, MIEL T

Assignment Points: | 25
Assignment Type:
Assessment
[

X Score Type:| Raw Scors -

TULE IO SamlTe

Scheduling Assessments Screen

3. Click Save. You must save an assessment before granting students access.
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Student Access

District Users

Student Access
A comprehensive listing of all students asswgne(ﬂs mstar@d the ability to grant access. o
Name 4 District 1D ak Accommodations stalus & Grouping Criteria &7 Grade Book ¢? Next Access & Access
x x Selectto Change v
&
2 Ackley, Brian 913948 B -Bgswgnen =2 Jackson, Kathy No access granted No Access v
3 Aguirre, Jason 952357 - Assigned @D Jackson, Kathy No access granted No Access v
4 Anguish, Clarence 901945 - Assigned @ZZ=P Jackson, Kathy No access granted No Access v
5 Arhin, Dennis 169094 - Assigned @ZEZP Jackson, Kathy No access granted No Access v

Scheduling Assessment Screen

1. Select the student access:

Select the header name to sort the student list.

Click b to view the information for the column.

Click * to view duplicate students for district or school-level assessments.

Student Access
A comprehensive listing of all students assigned to this instance and the ability to grant access.
Name 1 District ID % | Accommedations | Status¢? Grouping Criteria &7 Grade Book &7 Next Access &7 Access &7
x x x x
Status Status
Assigned Assigned
Grouping Criteria Grouping Criteria
@559 Jackson, Kathy @275 Jackson, Kathy
Grade Book Grade Book
Next Access Next Access
No access granted Now until 11:59pm
Access Access
No Access
Row Count: 3
Row Count: 175

Scheduling Assessments Screen

« Accommodations allows you to select specific accommodations for a student . (1)

( N\
These options are the same as Accommodations.

The B icon allows the accommodation to be saved for a single
E user. This option is available for teacher users.

The E] icon allows the accommodation to be saved at the global
level to be available as default when this studentis added to an

L assessment by any assessment user. )

Status identifies assessment status and the number of students who have completed
the assessment. @
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« Completed displays when the student completed the assessment.
o Unlock— Select to allow the student to take an assessment marked Complete.
« Grouping Criteria is dependent on the selections made during the targeting process.
» Grade Book displays if the assignment was completed and scored for a student.
« Next Access displays when the student has access to the assessment.
[ E Select a heading in the green area to view details. ]
« Access ©
« No Access — Students do not have access when the targeted dates or times
occur.
» Scheduled Access — Students have access when the targeted dates or times
occur.
« Access Now — Students have access regardless of the targeted dates or times.
2. Click Save. The scheduled assessment displays under either the You Scheduled or
Scheduled for Your Classes tabs on the Dashboard.
Teachers

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Azzezement -~ RTlI -~ Admin -

tem Bank (Create & Edit ltems) [

Daszshboard (Authorize Students & View Resultz)

Assezsments (Create & Scheduls Azssssments)
Bank Management {Creats & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

e i -

Assessment Menu
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2. Select Student Access from Options or click Students with access.

15 items
Aszzessment Details Start Date End Date Student Access Completion
Options - | GradeCam Test 07THBAT D4/30/18 22 of 117 (19%)
—_— Taarhar 1 nnﬂl
Navigation ne: GradeCam Test Students with access
Resulis Analysis |D: 3258
Schedule Details 047
B.00

Jackson, Kathy
I Student Access E ksen, Kathy
Tanual Rezponse Inpu T | Scheduled To =

2017-2018 ¥ || View Dashboard Archive Toggle Live Dashboard

You Scheduled Scheduled For Your Claszes Completed Analysis Favorites

Assesement Details

Live Details

R essment 1210417 0s/25/18 40 of 222 (18%)
Actions 1
Complete ne: Demo Assessment Students with access
Pause Assessment |D: 2249
1037

Total Points: 13.00

Assessments Screen

3. Select the row to toggle through the student access.

Schedule Student Access for GradeCam Test 0 Search Lock SignOut Support Help

2 (52) Jackson, K Am Govi(4) SEC:1480 / Progress Period 3 +

3. Cunry, Arthur (677344} Compleie ¥ - I . MNext Access: Now

4. Gordon, Barbara (121580)
5. Grayson, Dick (867200)

6. Grey, Jean (871686)

7. Hayden, Jenny (579867)

Return to Dashboard

Click on a section row to change access for an entire section, or expand the section to change access for individual students.
Mo Access. Students will not see this scheduled instance, even if it is within the scheduled dates and fimes.

Scheduled Access. Students will see this scheduled instance during their scheduled dates and times automatically.

. Access Now. Students will see this scheduled instance, even if it has reached completion

Use Schadule

Next Access: No access granted

Compleie T Uss Schedule

Compiete ¥ I Next Access: Now until 11-58pm (Mo Bell Sthedule)

Student Access Screen

« Therow color defines the access for the student or section.

» Access Now — Students see the scheduled instance even when the assessment
End Date was reached. @

« No Access — Students does not see the scheduled instance even within the Start
Date and End Date for the assessment. @

« Scheduled Access — Students see the scheduled instance during the Start Date
and End Date for the assessment. ©

« Select the section header to set the access for all students in the section. 0

« Selectarow to change access for a specific student.

163
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« Change the status of the assessment for a student. (4]

o Complete — The student completed the assessment.

o Unlock— Select to unlock a completed assessment for a student.

4 )
Once unlocked, the student must return to the
assessment and complete the assessment.

{ N\
If you unlock the assessment for the wrong student,
access the assessment from StudentVUE and resubmit

the assessment for grading.

J

» Started —The student is currently working on the assessment.

« Select the accommodation. ©

o Use Schedule —Same as Accommodations

« Other options — Select specific accommodation for a student.

Pushing Scores to Grade Book

When changing the setting to Include in Grade Book after the start of a scheduled assessment, an
option displays that allows the creation of new Grade Book assignments for those teachers and
students who have results but not Grade Book results.

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Assessment ~ RTlI ~» Admin -

J tem Bank (Creste & Edit ltems) [

Dashboard (Authorize Students & View Resulis)

Azzesasments (Creste & Schedules Assessments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Creats & Edit Passages)

semrtbomm

Assessment Menu

2. Select Assessments.

Assessments Tle v| Assessment v m

Ideals of Government
al

Assessments Screen

3. Select Schedule from Options.
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4. Select a Grade Book option to display additional options:
» Select Grade Book Push. (District Users Only)
« Select Connect Grade Book and one of the following: (Teachers Only)

o Select Auto-Create a new Grade Book assignment to create a new
assignment as students complete the assignment.

« Select Connecto to an existing Grade Book assignment to display a list of
assignments available in the targeted sections for the assessment.

Grade Book

Student results can be automatically pushed to teachers Grade Books, or teachers can have the option to pull in
these results.

" Grade Book Pull @
' Grade Book Push @

Default Options

Assignment Type: classroom v Assignment Category:  MNormal v

Score Type:| RawScore ¥ Assignment Date: 1092017

Points: 33 ¥ Show in Parent Portal @

Auto and Manual Pushing

Student results can automatically be pushed into Grade Book when students complete the assessment. Or,
student results can be manually pushed into Grade Book after the results have been validated.

Pushing results to Grade Book can only occur when the Assessment is targeted to a Course, Section, or
Class Period. Once targeted properly, you will have the option to further customize the grade book options
for each target, including the selection of a grading period based on the target school.

® Automatically push results into Grade Book @

Push to Grade Book Now

n students in n classes will be affected by a push.

Manually push results into Grade Book @

Assessment scores currently in Grade Book: 0 @
Assessment scores not yet in Grade Book: 0 [:]

Total number of Assessment scores in Grade Book: 0@

Schedule Assessment Screen, Grade Book District Users
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Grade Book

Select default Grade Book assignment options if you wish to connect this assessment instance to your Grade Book.

| Connect Grade Book

@ Auto-Create a new Grade Book assignment @

(O Connect to an existing Grade Book assignment &

New Assignment Options @

Assignment Type Assignment Category:

Homework ~ Normal

Score Type Assignment Date [ ]| 3112019

Rew Score ~

%] show in Parent Portal @

Points

Grading Period:

Schedule Assessment Screen, Teachers

Grade Book

Select default Grade Book assignment options if you wish to connect this assassment instance to your Grade Book.
¥ Connect Grade Book

Auto-Create 2 new Grade Book assignment @

* Connect ta an existing Grade Book assignment @
Grade Book Assignment

Folder Style = Compact Rew =

[
(52) Jackson, K Am Govt(4) SEC:1468 (CE)

(52) Jackson, K Am Gowvt(2) SEC:1269 ()

¥
(51) Jackson. K Am Govt(4) SEC:0469
aD

w
(51) Jackson, K Am Govt(3) SEC:0369

Schedule Assessment Screen, Teachers

5. Make additional selections, as needed.

» Select the Default Options (District Only) or the New Assignment Options (Teachers

Only), if you selected the Auto-Create option.

Assignment Type indicates if the type of assessment as defined by the district.
For example, homework, quiz, assignment, social behavior, or work study habits.

Assignment Category indicates how the assessment is graded. It can be
graded as a normal item, as extra credit, or not for grading.

Score Type indicates the assignment score type.

Assignment Date indicates the date of the assessment. Defaults to today's
date. Change if needed.

Places the assignment in the appropriate grading

period.

Points indicates the points that impact the student’s score.
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« Show in Parent Portal displays in ParentVUE if enabled.

« Grading Period indicates the grading period the assessment belongs in.
(Teachers Only)

{ @ Use the Ctrl key to select multiple Grading Periods. ]

* Click W to display a list of assignments in that section, if you selected the Connect to
an existing Grade Book assignment.

7

— Indicates the number of assignments in that section

E hi_ Indicates an assignment

¢ _Indicates an assignment already linked with an
Assessment

\.

i. Select the assignment you want to connect to.
ii. Hover over an assignment and select Sync Grade Book or Edit Assignment from
Options.

s

N
Sync Grade Book is enabled only when students have a
score for that assignment.

E An alert displays to confirm that the Assessment scores
will override the existing Assignment Scores if the
selected assignment has class scores recorded.

\.

iii. Click Save.

6. Select the Auto and Manual Pushing option (District Users Only):

« Automatically push results into Grade Book — Select to have the score
automatically post in Grade Book when the student completes the assessment.

« Manually push results into Grade Book — Select to have the ability to validate the
scores displayed in the Student Analysis screen before pushing them to Grade Book.

o Click Push to Grade Book Now to update Grade Book.

You may have to use Grade Book Pull and Manual Push
to Grade Book more than once, as students complete the
assessment.
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Taking Assessments

A message displays to students if the number of skipped items in the
database is not the same as the navigation count. A message displays
asking the student to contact the assessment administrator.

Launching Assessments in Chromebooks

Before a student can open an assessment in a secure browser from StudentVUE, they must log in to
the app from their Chromebook.

1. Students select Synergy Assessment Kiosk from the Apps menu.

{5 Edupoint 1.0.0.9 QA
b Synergy Assessment Kiosk

() shutdown B Apps

Student Chromebook

2. Studentslogin to the app to launch the Assessments tab in StudentVUE.

3. Students click an assessment under Available Now. The assessment opens in a secure
environment.
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Accessing Assessments

1. Studentslog in to StudentVUE and staff members access through StudentVUE for a student
(either from the Seating Chart in TeacherVUE or StudentVUE screen in Synergy SIS).

2. Selectthe Assessment tab.
3. Click an assessment under Available Now.

R v cecort . cuons
=== Available Now
I

Aesessment ] Quick Assessment 12/11/2017 Quick Assessment 5/12/2017#3
[Fiemcenes | 'F(:J”ﬂave access until completed. _oirq\;e access until completed.

Class Schedule

Class Websites Quick Assessment 5/12/2017 #2 _RE!SEE_WE Items 1.1

Course History 'F(:J”ﬂave access until completed. ;;i:s;l::ccst on 12/22/2017

Fee

Grade Book

Hestth Online Assessment History

Report Card

S — 2016 2015

Student Info

Documents

Student Assessment Screen
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4. Click * tolistento any verbal instructions.
5. Click Start.

Item Type Test Hunting, Will

Iltem Type Test

Here is & test with ewvery item type available in the system. These questions are all user created
and not an additional cost.

Access Information
You have been granted access right now.

Instructions

P Start

A Retum To StudentVUE

Staff members viewing the assessment as a student see this
message.

Notices

= When providing answers for 3 student, please ensure accuracy of student
responses.

Student Assessment Screen

When launching an assessment from a secure browser, click Launch
Secure Browser.

a Math Week 8

ARSI

Dates and Times

This aiieriament B open beteedn Frdiy, Mach 28 and Sstumsy, March 26

MNotices

This SEseSAmanl fequies e ule of & secure bicwser To continue Cek o ihe
ik Eafbin

Launch Secuns Brorwser

L i i el vedsriorse] @ Do) Sl B OraSe T

Student Assessment Screen
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When a student returns to a test:

« Theyreceive a notice about their progress in the assessment.

Notices

» You have completed 7 out of 16 questions.

Student Assessment Screen

« They can jump to the next question in the test or select a question for review.

1 2 3 4 35
6 7 (89 10
1 12 13 14 15
16

Student Assessment Screen

6. Change settings if needed.

o Click an available accommodation

. ClickIul to change the screen brightness and colors to make the screen easier to
read.

. CIickI-I to select a translator

. Clickm to set the question for review so you can return later

Item Type Test wae- b S OB “« - 0 Hunting, Wil

aQ

Eye of the Tiger

Part A
The author both did his time AND took his chances.

0w

PartB
Which organ system does the Eye of the Tiger belong to?

@ vigestive @ Circulatory @) immune

< Previous Question m Next Question > Save and Retum

Student Assessment Screen
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7. Selectan answer and click:
» Save —Click to save the assessment and submit to grading.

« Next Question — Click to save your answer to the question and move to the next
question. You are not always allowed to return and review your questions.

« Previous Question — Click to save your answer to the question and move to the
previous question. You are not always allowed to navigate back and forth.

« Save and Return — Click to save the assessment and return to answer additional
questions. This option is not always available.

« End of Text — Click after you answer the last question and review your answers.
Reviewing your answers is not always available.

« Submit for Grading — Click after you reviewed all of the questions. You can only
review the test using the feedback options in Viewing Online History once you submit
for grading.

8. Click Review Item Feedback if available. See Viewing Assessment Results and History.

Item Types

Multiple Choice

Student selects the correct answer from several choices.

.
ltlem Type Test Hunting, Wil

This is just an example video of how amazing my dog is P oo/e —

0 Wow, impressive

e | want your dog

@ coolest dog ever

Q You have the dog version of Greg Louganis! This is the correct answer. ]

E Next Question » Save and Retum

Student Assessment Screen, Multiple Choice
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Multi Part or EBSR

Student selects the correct answer to different parts of a question.

liem Type Test wae- kSO - - 0 Hunting, Will

Eye of the Tiger Part A

The author both did his time AND took his chances

@

Part B
Which organ system does the Eye of the Tiger belong to?

e Digestive e Circulatowo Immune

Survivor

Rising up, back on the strest
Did my time, took my chances

Went the distance, now I'm back on my fest
Just & man and his will to survive

So many times it happens too fast
You trade your passion for glory

Con'tlose your grip on the dreams of the past
‘You must fight just to keep them alive

I's the eye of the tiger
It's the thrill of the fight

Rising up to the challenge of our rival
And the Iast known survivor

Stalks his prey in the night -
[ [ e | vevcems |
Student Assessment Screen, Multi-Part
True/False

Student selects the correct answer.

Hunting, Will

Qe

When Aladdin and his monkey, Abu, are firstintroduced in the movie, they are caught stealing a loaf of bread.

6 True

e False

< Previous Question ﬂ Next Question » Save and Return

Student Assessment Screen, True/False
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Hot Spot
Student selects a section on an image.

ltem Type Test Hunting, Will

Click on Lake Superior in this n":p..
Then click Submit. P

< Previous Question m Next Question ¥ Save and Return

Student Assessment Screen, Hot Spot

Inline Choice

Student selects answers from drop-downs.

ftem Type Test EZ7QF - Hunting, Will
-

Qe

Match the following cities with the correct state:
San Francisco: camomz v
Tucson: amsra v

Los Angeles: sssctons v

‘Seled One
Albany: ssect| Anzon
Califamia
New York
Oregon

4 Previous Question E Next Question ¥ Save and Retum

Student Assessment Screen, Inline Choice
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Text Entry with Equation Tool

Student answers the question using an equation editing tool.

Hunting, Will

What is the formula for the Pythagorean Theorem?

]

Equation Tool .
AREEE n
2800 | BRRAGEE | R
4195 [6 B sin cos tan :
1,203 | PR (S
0 -l ¢

4 Previous Question E Next Question ¥ Save and Retum

Student Assessment Screen, Text Entry

1. Click E to open the equation tool.
2. Use the tool to build the equation.
« When using equation builders insert your cursor into the appropriate space and enter

the value.
2} il
3+ (==
E - .
quation Tool
- Te[a e EEEEE
7)8 9= =llf 8| |m "
4/5)6 L~ sin cos tan
1 2 3 * arssin | arcooc | arofan
0 e -

Student Assessment Screen
« You can edit the equation until you save. Once you save, you must delete the equation
and start over.
« You can move the Equation Tool to a different location on the screen.
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Graphic Drag and Drop

Student drags the answers into hot spots.

Hunting, Will

Parietal Lobe

Brainstem Cerebellum! Fronial Lobe; Occipital Lobe! Parietal Lobe Temporal Lobe |

< Previous Question @ Next Question » Save and Retum

Student Assessment Screen, Graphic Drag And Drop

Hot Text

The student selects the text.

Hunting, Wil

Qe

Select the sentence that would be the climax of the story.

[A young farm boy, who dreams of adventure, lives in a galaxy torn by rebellion and war][He is pushed
into the conflict after his aunt and uncle are killed by the Empire for the droids he possesses][After joining
a smuggler for cheap transportation, the boy and his mentor are captured by the Empire on their way to

rescue a pnncess and, in The ensutng strugﬂle the mentor sacrifices h|m%lf%
£ e princess a k they have escaped, only to learn the Empire has fo el
iy 1l anet]Aided by his companions and the last lesson of his fallen mentor,
the boy must exploit the hidden weakness of the Empire’s destructive weapon to preserve the Rebelllon]

<€ Previous Question m Next Question $

Student Assessment Screen
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Matching

The student selects the item in the right column that matches the item in the left column.

nots- i S DB Hunting, Wil

Select the correct quadrant for the given points.

Quadrant || || W IV None of the above
35 ¥ 0 B O @

26 gle B 1 .

1-1 %

03 88 B I ¥

4.-2 D@8 O I i

€ Previous Question E Next Question ¥

Student Assessment Screen

Number Line

Line Plot

Student selects points on a line.

Hunting, Will
Plot the average wait times at the doctor's office based on the following integers.
156,10, 20, 15, 30, 35, 30, 30, 65, 40, 20, 30, 25
=0

X
X
X X

X X X X X X X X

0 5 10 15 20 25 30 35 40 45 50 55 60
Average Wait Time (minutes) -
< Previous Question m Next Question ¥ Save and Retum

Student Assessment Screen

« Hover a plot and click * toremove a plot.
« Click Clear All to remove all plots and start over.
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Points on a Line

Student selects points on aline.

Hunting, Will

Select ALL the factors of 32.

0 2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 32

Factor Line

< Previous Question m Next Question »

Student Assessment Screen

« Hover a plot and click X to remove a plot.
o Click Clear All to remove all plots and start over.

Text Entry

Student enters answer into a text box.

wuatc- | S OB Hunting, Wil
Doug bought three loaves of bread at $2.17 each. What is the total Doug should expect to pay when he
check out?
| 5651 |

< Previous Question E Next Question ¥

Student Assessment Screen
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Select Point
Points on a Graph

Student select points on a graph.

moe- B S OQB Hunting, Wil

Plot the following points on the graph. [5,-2] [7,3) (-2,-1 ]

L
10 k] 6 ] 2 | 2 4 6 g 10
. ) @
HEN
-_6.
-2

< Previous Queslion E Next Question ¥

Student Assessment Screen

« Hover a plot and click x to remove a plot.
« Click Clear All to remove all plots and start over.
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Points on an Image

Student selects a point on an image.

Hunting, Will

Where's Waldo?

< o | o ] owars > JRR soeaam

Student Assessment Screen

« 9 displays on the student's select selection.

« Hover over and click ® to remove a selection.
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Lines on a Graph

Student uses the tools to draw on the graph.

o | SO E - - Hunting, Wil
o

Graph the line that has a slope of 3 and includes the point (1,5).

& o= |0

£ Previous Question E Next Question ¥

Student Assessment Screen

« Hover a plot and click x to remove a plot.
« Click Clear All to remove all plots and start over.
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Student selects multiple answers.

Hunting, Will

Q Clark ] ) Lekewood Q Sheffield ] ©® Eeayy
G Cornelia ‘a Addison I @ lowa 0 Grace
= )

Student Assessment Screen, Multiple Select

Constructed Response with Media Upload

Student answers a question and uploads documents to support the answer.

« Click Attach a file if the assessment allows Media Uploads to attach afile.

Hunting, Will

Webinar Assessment

Brandy (You're a Fine Girl) Why couldn’t Brandy and the man she loved stay

Looking Glass together in this story?

-— T o (| = = =2 5|

|Sty1es -||Furmat -||Fom -HSme 'HA' .-‘

There's a port on 8 western bay
And it serves 100 ships a day
Lonely sailors pass the time away
And talk about their lives

And there's a girl in this harbor town
And she works laying whiskey down
They say Brandy, fetch another round
And she serves them whiskey and wine

They say, "Brandy, you're a fine girl

What a good wife you would be

You could steal a sailor

From the sea -

TED Talk Questicnnaire.docx %
€ Previous Question m Next Question ¥ Save and Retum

Student Assessment Screen, Constructed Response
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Viewing Assessment Results and History

Students view their assessment feedback from the Results Summary based on the assessment
settings.

"la  Sethow students receive feedback when creating assessments and
==t/ scheduling assessments.

1. Open the Results Summary:

« Immediately after taking an assessment

« Click Review Item Feedback.

o Online Assessment History
1. Click ayear on the Assessment tab in StudentVUE.
2. Selectan assessment.
3. Click Review Item Feedback.

Results Summary
Item Type Test

Overall Score

73%

14119
Results Summary
03.M.53.€1.2 Recognize, describe, extend, create, and find missing terms in a numerical 0 0/
sequence. 0
01
05.G.1 Graph points on the coordinate plane to solve real-world and mathematical 0 0/
problems: Use a pair of perpendicular number lines, called axes, to define a coordinate system, 0

with the intersection of the lines (the origin) arranged to coincide with the D on each line and a 01
given point in the plane located by using an ordered pair of numbers, called its coordinates.

Understand that the first number indicates how far to travel from the origin in the direction of

one axis, and the second number indicates how far to travel in the direction of the second axis,

with the convention that the names of the two axes and the coordinates correspond (e.q., x-

axis and x-ceordinate, y-axis and y-coordinate).

05.G.2 Graph points on the coordinate plane to solve real-world and mathematical 0 0/

problems: Represent real werld and mathematical problems by graphing points in the first 0

quadrant of the coordinate plane, and interpret coordinate values of points in the context of the 01

situation

05.MD.2 Represent and interpret data: Make 2 line plot to display a data set of 1 0 0 0/

measurements in fractions of 3 unit (1/2. 1/4. 1/8). Use operatiens on fractions for this arade to 0 h

Review Item Feedback A& Return To StudentVUE

StudentVUE Assessment Online History
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2. Select the Item Feedback.

You select how to provide feedback to students when creating
assessments, scheduling assessments, or printing student results
from the Student Assessment Results screen.

ltem Feedback

ERER | 1 il itk

Student Feedback Screen

If feedback is not allowed, the Results Summary displays and the
Review Item Feedback button does not display.

If the item contains Constructed Response items only, a message

a displays:

Your assessment has been submitted successfully for grading.

Student Feedback Screen

If Full Feedback is allowed. The screen opens with Full Feedback.

« Incorrect Feedback displays incorrect items without the student's selection.

Item Feedback

Item #6

What is the formula for the Pythagorean Thecrem? x
Item #7

’ X

Incorrect Feedback Screen
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« Summary Feedback displays a list of the items with the ltem Type and Points
received. Correct answers are green and incorrect are red.

ltem Feedback
#1 Multiple Choice 171
#2 Multi-Part 171
#3 True/False 171
#4 Hot Spaot 171
#3 Inline Choice 414
#5 Short Answer 01
#7 Graphic Drag and Drop 071
#3 Hot Text 1/1
#2 Matching 171
#10 Number Line 171
#11 Number Line 171
#12 Text Entry 171
#13 Select Point - Points on a Graph 071
#14 Multiple Select 171
#15 Select Point - Lines on a Graph 071
#16 Select Point 01

Summary Feedback Screen

« Full Feedback shows all items with correct and incorrect answers and the student's
selection.

« Correctresponses selected by the student are highlighted in blue and have E.4b

ltem Feedback

Incomect Feedback Full Feedback

ltem #1

This is just an example video of how amazing my dog is.

o Wow, impressive.

e | want your dog.

e Caoolest dog ever.
v

9 You have the dog version of Greg Louganis! This is the correct answer.

Student Full Feedback Screen
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« Incorrect responses selected by the student are highlighted in red and have X

« Correctresponses not selected by the student are highlighted in gray and have

v,

ltem #6

What is the formula for the Pythagorean Theorem?
Student Responses
, &x
a-+bc

Accepted Responses
v

a+b=c

Student Full Feedback Screen

« Graphic Drag and Drop items have an additional Answer Key with the full

responses displayed.

o Text Entryitems have a red skipped field when the student did not provide a

response.

3. Click Return to StudentVUE to select another assessment.
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GradeCam

GradeCam s a plug-in that uses a camera to automatically grade the assessment using bubble
sheets.

E GradeCam is embedded in Synergy Assessment but must be purchased
through Edupoint to enable the full features.

GradeCam works with assessments using the following item types:

« Multiple Choice
o Multiple Select
o True/False
« Constructed Response has the following options:
« Creates aform thatignores constructed response items that you grade later.
« Creates a form with numeric fields you can use to enter point values. You grade the
constructed responses on the form and scan the scores in directly.
Teachers use a camera on their computer to score the assessment and give immediate feedback to
the students.

« Blank forms are identified and presented as an error.

« Confusing forms ask you for feedback, allowing you to modify a student's responses to match
the form.

Using GradeCam

1. Select the assessment with the appropriate item types in either the You Scheduled or the
Scheduled for Your Classes tabs.

2. Click GradeCam.
3. Click Bubble Sheets.
4. Selectthe type of bubble sheet to create:

« Pre-Marked — Creates a PDF with a bubble sheet for each student for this
assessment. Each student’s name is printed on the sheet.

a. Click Pre-Marked.

b. Constructed Response — Selected by default. O Ifthe assessment contains
Constructed Response items the scores are entered using the Bubble Sheet.
This option allows you to load the scores using bubble sheets instead of manually
entering the scores for the items.
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c. Selectthe students:
« Select a class to include all students from the class. @
« Expand the class to select individual students. ©

d. Click Generate. A PDF of the bubble sheet is created with a sheet for each
student selected.

e. Click Open PDF. The PDF opens.
Print the PDF to distribute to the students.

Classes Available to Assign
Expand to Select Individual Students

A (YR) Lopez, C English 11(1) SEC:1150-0009

¥ (YR) Lopez, C English 11(2) SEC:1150-0010

Sierra Auerbach
Timothy Brock e
Kayla Cloyd

Emilv Denson

Back

GradeCam Screen
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« Generic — Creates a generic PDF that can be used for multiple assessments

a. Entera Custom Header, if needed. (1]

b. Enter the Question Count, Answer Count, and the Student ID Length. (2]

c. Click Generate. A PDF of the bubble sheet is created that contains a generic
bubble sheet.

d. Click Open PDF.
e. Printthe PDF.

Generic bubble sheets allow you to use bubble sheets for many
assessments, as long as each question has a bubble to fill in. As an
example, if you have a 20 question assessment, the bubble sheet must
have 20 or more available bubble selections. To scan these sheets, you
must be viewing the proper analysis results screen so it knows which
assessment to apply the results to

Custom Header Question Count
BIUSH®Xx T, 25

N Answer Count
Student Name

o Student ID Length

7

Back |

GradeCam Screen

5. If a paper version of the assessment is required:

o Click Print Assessment. The assessment displays in the browser.

« Use your browser to print the PDF.

6. CIick. to select a camera from the available devices to grade the sheets using a camera.
When students complete their assessment, they hold their bubble sheets to the camera and
receive an immediate score.

When teachers scan assessments with Constructed Responses,
n, theyreceive an alert if the scored value is larger than the allowed
= Max Value. A text box displays to update the score.

CIick- to turn off the camera.
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Bulk Scanning Bubble Sheets (District Users Only)

District Administrators have the ability to score multiple bubble sheets at one time.

« Blank forms are identified and allow you the option of scoring them as empty or skipping them.

« Confusing forms ask you for feedback, allowing you to modify a student's responses to match
the form.

« When a score already exists for the student, you have the option to update their result or
cancel the submission.

« The image of the scanned form displays on the screen and is included with any scanning
errors to identify the troubled scan.

« Ifa Gridded Response field for Constructed Response items scans a point value higher than
the item's total points, you have the option of updating that score.

Using Bulk Scanning

1. Scan the sheets in PDF, JPG, or TIFF format using gray scale or color.

2. Navigate to Assessment > GradeCam Bulk Processing.

Processing Report

GradeCam Bulk Processing Screen

3. Navigate to the folder in your file manager that contain the files.
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4. Drag and drop the files into the box.
5. Click Scan Now.

Processing Report

5 scans in 5 files processed. (Completed in 5.475
seconds)

The scan completed successfully.
Clear

GradeCam Bulk Processing Screen

6. View the Assessment Results.

Viewing Scheduled Assessments

Use the Dashboard to view scheduled assessments. You can also do the following from the
Dashboard:

« View live dashboard to watch live student responses on scheduled assessments

« Cancel assessments to cancel or end a currently scheduled assessment

« Archive assessments so it no longer displays in the Completed tab

o Pause or resume an assessment for students

Change access to define which students can access an assessment for students

Viewing Assessments

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Assessment ~ RTlI » Admin -

tem Bank (Create & Edit ltems) [

Dashboard (Authorize Students & View Resultz)

Aszzezsments (Create & Scheduls Azzsssments)
Bank Management {Creats & Edit Banks)
Ceonstructed Response Grading

Passages (Create & Edit Passages)

s cmrerb e

Assessment Menu
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« Scheduled For Your Classes — Assessments scheduled for your classes and can

include assessments that you scheduled

o Scheduled To Your School — Assessments scheduled to your school — Displays for
users with District Level and School Level scheduling. Assessments in this tab display

based on the user’s current Grade Book Focus.

o Completed — Completed assessments of all assessment levels

7

on the schedule level of the user.

in Preview Mode only.

The same assessment may show in multiple tabs, depending

Users without schedule rights of their own who have
Assessments assigned to them can view the Schedule Details

J

Filters &t

Text Search

Assessment Name

You Scheduled For Your Classes

Completed

1items
Assessment Details
uUc 2017

Teacher Level
Start Date
a Schedule Name: UC 2017

Schedule Name

Assessment ID: 6
aQ Schedule ID: 6
Total Points: 5.00

End Date

Scheduled By: Carroll, Natalie
Created By: Carroll, Natalie
Scheduled To: Scheduled To v

Select Search

Schedule Level

Scheduled By

Start Date End Date

10/26/17 1730117

2017-2018 v View Dashboard Archive

Analysis Favorites

Student Access Completion
10 29 (3%)

Students with access

Toggle Live Dashboard

Assessment Dashboard Screen

193
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The following information displays for the assessment:

o Level—District, School, and Teacher — Describes the level of the assessment
« Scheduled By — The name of the user who scheduled the assessment
« Created By — The name of the user who created the assessment

« Scheduled To — Lists the Schools, Grade Levels, Courses, or Sections the Assessment
was assigned to

Assessment Details Opens On Closes On
Algebra - Quadratic Equations 01/03/17 01/06M17
District Level 3 days ago 8 hours ago

Schedule Name: Algebra - Quadratic Equations
Assessment I1D: 2237

Schedule ID: 1018

Total Points: 5.00

Scheduled By: User. Admin

Created By: District

Scheduled To: | Scheduled To -

This assessn
Jackson, Kathy

Assessment Dashboard Screen

The Access Status displays for each assessment:

« Indicates that students currently have access to the assessment

Students with access

Assessment Dashboard Screen

« Indicates that students do not currently have access to the assessment

Students with atcess

Assessment Dashboard Screen

Edupoint Proprietary and Confidential



Assessment User Guide
Chapter 6: Using Assessments

195

2. Use thefilters to limit the assessments displayed.

Filters £*

Exact Match
Schedule ID

Assessment ID

Text Search

Assessment Name

Math

Schedule Name

Start Date

End Date

Fo RN e e e

Select Search

Schedule Level

Scheduled By

Subiject

Grade

Course

Clear
Active Filters

Assessment Name: Math

Assessment Dashboard Screen

O Click Clear to remove a filter under a category or Clear in the blue

= box to remove all filters.

» Select Assessment Details from Options to view an assessment. See Creating
Assessments .

o See Viewing Live Details to view live details of an assessment.

o See Canceling an Assessment to cancel an assessment.

« See Pausing or Resuming an Assessment to pause or resume an assessment.

« See Changing Access to an Assessment to change access to an assessment.

« Select Results Analysis from Options to analyze the assessment results. See Viewing
Assessment Results.
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Viewing Live Details of an Assessment

You can view the student responses while the students are taking an assessment.

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or

navigate to Synergy SIS > Assessments > Assessment Dashboard.

BTl -

Admin -

Assessment

-

Item Bank (Create & Edit liems)

Dashboard (Authorize Students & View Resultz)

Aszzezsments (Create & Scheduls Azzsssments)
Bank Management {Creats & Edit Banks)
Ceonstructed Response Grading

Passages (Create & Edit Passages)

Coaenebemn

Assessment Menu
2. Open the live view.
3. Click Toggle Live Dashboard. The Live Dashboard displays.

20152016 + [ view Dashbosra Arenwe
Filters 'u' Active Upcoming Completed
Text Search
2 items

Assessment Name

Q 717
Schedule Name Access Status By To Name Name start End  C

o

Dashboard Screen

4. Select View Details from the Assessment.

“iew Dashboard Archive

Toggle Live Dashboard

Live Dashboard e+ Fiterby Hone

ql

Sound and Light - 8th Grade Science

Assessment: Sound and Light - 5th

Start Date: 01/0217
End Date: 01/2117
Students Started: 1
Students Completed: 1

“iew Results Analysis
\iew Schedule Details

Sound and Light - 8th Grade Science

Assessment: Sound and Light - Bth Grade Science

Start Date: 01/0217
End Date: 01/2117
Students Started: 1
Students Completed: 1

Sound and Light - 8th Grade Science -
Assessment: Sound and Light - 8th Grade Science

Start Date: 01/0517
End Date: 0141217
Students Started: 1
Students Completed: 1

Live Dashboard Screen
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5. Select Live Details from Options to view the details of an ongoing assessment.

2016-2017 * | Mew Dashboard Archive Teggle Live Dashboard
You Scheduled Completed
1 items
Assessment Details Opens On Closes On Student Access Completion
Options ~ Algebra - Quadratic Equations 01/03/17 01/06/17 = 2 of 203 (1%)
Nictrict I aya| 3 days ago 8 hours ago )
Navigation Name: Algebra - Quadratic Equations Students with access
Results Analysis ent ID: 2237
Schedule Details ID: ;%1[}3
. nts: 9.
Assessment Details d By: User, Admin
Student Access by: District
Actions sessment is Online Only
Complete
Pause Assessment
Dashboard Screen

The details for the assessment display, including the Preferred Score Type as the students'
scores on the assessment.

iew Dashboard Archive | Togghe Live Dashbaard
Live Dashboard
"I x
Lopamaran
Filters
Fast Text Search n .
Ssudent Name
a
" 1 2 3 4 5 & T 8 9 10
Selet Search e Compledon PCT™ rr mc sa sA SA SA SA SA M5 CR
Class b [ ]
Completion Stus
| ° - (EEEEEE [
Band Ranges Lofbiad, M English 55) 2ei
Adare, Ryan -
Analysis Bands Nolasco. A English (1) .
Aguado, James -
Current Band 4 | sesms e B0% | ‘ | [l
Elomentary Standards_+ Reilly, J English 9(3) -
Agular, Irene = ‘_
5 | 92 80%
w1 .
75100 50-74 0-49 et L Sakth 22
an, Jasen
& | 1ioms g B0% [sa | | D
Boyd. S English 92)

Live Dashboard Screen, Assessment Details

« Students that have started the assessment display with their current time spent on the
assessment and their current overall percent.

« Student responses display for Multiple Choice, Multiple Select, True/False, Multi-Part,
and EBSR items.

7

For Multi-Part items, the individual parts display with an alpha
character appended to the item number. For example, 3.A, 3.B,
3.C.

For EBSR items, the individual parts display with an A and B
appended to the item number. For example, 4.A, 4.B.

For assessments with Sections, the sections are separated by a line
and the numbering changes. For example, 1.1,1.2,1.3and 2.1, 2.2,
2.3.

J
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« Short Answer items are highlighted as correct (green) or incorrect (red).

« Technology Enhanced and Constructed Response items are blue. These responses
are graded once the assessment is completed.

« Skipped items are orange.

Canceling an Assessment

The Options menu displays different choices depending on the status of
an assessment.

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Assessment ~ RTlI » Admin -

tem Bank (Create & Edit ltems) [

Dashboard (Authorize Students & View Resultz)

Aszzezsments (Create & Scheduls Azzsssments)
Bank Management {Creats & Edit Banks)
Ceonstructed Response Grading

Passages (Create & Edit Passages)

o 313

Assessment Menu

2. Select an action from Options in either the You Scheduled or the Scheduled for Your
Classes tabs.

« Unschedule — Displays for assessments prior to the scheduled start time or after the
scheduled start time as long as none of the students completed the assessment.

« Complete — Displays for assessments when at least one student has completed the

assessment.
2016-2017 v || View Dashboard Archive Toggle Live Dashboard
You Scheduled Completed
1 items
Assessment Details Opens On Closes On Student Access Completion
Options - Algebra - Quadratic Equations 01/03M17 01/06(17 E 2 of 203 (1%)
Dictrict Loyal 3 days ago 8 hours ago )
Navigation Name: Algebra - Quadratic Equations Students with access
Results Analysis ent ID: 2237
Schedule Details 1D: ;%1[}3
ts: 5.
Assessment Details 1d?;3y: ez AT
Student Access by: District
Live Details d To: | scheduled To -

ACTIion

sessment is Online Only

Pause Assessment

Assessment Dashboard, You Scheduled Tab
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3. Click Confirm to the confirmation message.

you wish to continue.

Confirm Completion

You have chosen to complete a scheduled assessment. Press the Confirm button if

Confirmation Message

Archiving an Assessment

Archiving a Scheduled Instance of an Assessment

Once you have reviewed an assessment, you can archive it so that it no longer displays in the
Completed tab. Moving assessments to the archive allows users a way to organize and display

their completed assessments.

Once an assessment is archived, it cannot be reinstated without
=  recreating the assessment. It can be reviewed from the Archive directory.

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Aszezement ~ RTlI - Admin -

tem Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Results)

Azzessments (Create & Scheduls Azssssments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Assessment Menu

2. Selectthe Completed tab in the Dashboard.
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3. Select Archive from the Options. A confirmation message displays.

Chapter 6: Using Assessments

‘You Scheduled Completed

1 to 20 of 458

Assessment Details

Algebra -

Diztrict | gyel

Navigation

Results Analysis
Schedule Details

Options =

zntID: 674
ID: 642

. its: 2.00
Assessment Details
Student Access

Live Details ly: District

ACTOMN

uadratic Equations

2016-2017 v

Opens On Closes On
01osT

Yesierday

010517
Y

estierday

MName: Algebra - Quadratic Equations

d By: Support, Student Information

o To: | Scheduled To =

sessment is Online Only

4. Click Confirm. The assessment moves to the Archive where it continues to display the same

student results.

Assessment Dashboard Screen, Completed Tab

4

To view archived assessments, click View Dashboard Archive in
the Assessment Dashboard. Click Return to Dashboard to return

to the active assessments.

You are viewing the archive.

Filters &

Text Search

Assessment Name.

Schedule Name

Scheduled Start

Scheduled End

20152016

Archive
11 items.
Assessment Name Schedule Name

Kinder Form 1 Kinder Form 1
Grade 10 ELA CCSS Summative

Assessment Form 1 Schools)

Assessment Dashboard Screen, Archived Assessments

Archiving an Assessment

1.

Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Aszessment

-~ RTl -~ Admin -

Item Bank (Create & Edit liems)

Dashboard (Authorize Students & View Resulis)

Assezsments (Create & Schedule Assessments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

=

Assessment Menu
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2. Select Archive from Options.

You Scheduled Completed Analysis Favorites

2 items
Assessment Details Start Date End Date Student Access Completion

Options = Webinar Assessment 092116 07/06/17 3 of 1451 (0%)

=y avel
Navigation Name: Webinar Assessment Students with access

Results Analysis ant ID: 2242

Schedule Details ID: 1023

Assessment Details |- 1000
d By: User, Admin

Student Access

ly: District
Live Details d To: Scheduled To
Actions )
\ a River Water Cycle 01/02/17 0412817 315 of 1133
o (28%)
District Level Students with access

Schedule Name: Cry Me a River Water
Cucla P

Assessment Dashboard Screen

3. Click Confirm. The assessment is archived.

( )

« This archived assessment displays all of the results and
retains the same functionality as any other assessment.

[\
o Toview archived assessments, select Archived in the
Schedule Status filter. Select Available to Schedule to
return to the active assessments.

Pausing or Resuming an Assessment

Users who have scheduled an assessment can temporarily prevent students from starting the
assessment from StudentVUE.

When pausing a scheduled assessment, students that are currently within
==t/ the scheduled assessment are not interrupted. They may continue testing.

To prevent students with access from starting the assessment:

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Aszezement -~ RTI - Admin -

Item Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Results)

Assezsments (Create & Scheduls Azzessments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Assessment Menu
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2. Select Pause Assessment from Options.

s

Pause Assessment only displays for the user that scheduled the

— assessment. Itis not available to other users that have access to the
test, but did not schedule the assessment.

2016-2017

You Scheduled Completed
1items
Assessment Details Opens On
Options + Algebra - Quadratic Equations 01/03/17
Nictrict I ayal| 3 days ago
Navigation Name: Algebra - Quadratic Equations
Results Analysis ent ID: 2237
Schedule Details ID: ;%1[}3
. nts: 9.
Assessment Details d By: User, Admin
Student Access by: District
Live Details d To: | scheduled To~
Actions sessment is Online Only
Complete

* | Mew Dashboard Archive Teggle Live Dashboard

Closes On Student Access Completion
01/06/17 2 of 203 (1%)
8 hours ago

Students with access

Assessment Dashboard Screen

E A pause button displays after selecting Pause Assessment.

You can also pause assessments when Scheduling Assessments.

Restore Access and Return Status

« Select Resume Assessment from Options.

escsSmen D By: Suppert, Student Information

Student Access
: District
To: | Scheduled To =

Live Details
Actions

2016-2017
You Scheduled Completed
3 items
Assessment Details Opens On
Options ~ Algebra - Quadratic Equations 0140317
Niwtrirt | ayg| 3 daysago
Navigation lame: Algebra - Quadratic Equations
Results Analysis iID: 1141
Schedule Details p: 626
B: 7.00

v ‘“iew Dashboard Archive Toggle Live Dashboard
Closes On Student Access Completion
03T 1 of 31 (3%)
24 days

Paused

0Ny 1 of 31 (3%)

24 days o
Paused

Assessment Dashboard Screen

%

the test, but did not schedule it.

Resume Assessment only displays for the user that scheduled the
—} assessment. The option is not available to other users that have access to
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« District Level and School Level users can change access to assessments for students.

» Teachers can change access to active assessments for their students.

To change access:

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or

navigate to Synergy SIS > Assessments > Assessment Dashboard.

Admin -

Aszezement -~ RTI -

tem Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Results)

Assezsments (Create & Scheduls Azzessments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Assessment Menu

2. Select Student Access @ or click the Students with Access icon. @

Results Analysis =nt ID: 674

Schedule Details

. 1ts:
s e D = Support, Student Information
Live Details istrict

Actions o To: | Scheduled To =
Archive yessment is Online Only

12

2016-2017 v “iew Diashboard Archive Toggle Live Dashboard
You Scheduled Completed
11020 of 458
Assessment Details Opens On Closes On Student Access Completion
Gtions ~ Algebra - Quadratic Equations 01 0140517 0 of 385 (0%)
Tietrint | pye| e A———
Navigation Name: Algebra - Quadratic Equations Students with access

Assessment Dashboard Screen
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3. Make a selection:

« Change the access for all listed students. (1)

« Change the access for individual students. (2]

Student Access
A cornprenensive Iisling of all students assigned to this instance and the amlity to grant aCcess.

Name T DistrictID B4 Status |} Grouping Criteria [ Grade Book | Mext Access [ Access
® ® ® x lect to Change
[l
»
LANG 4RT) U auLTos AT Se—h -
(&= 2ND SPED LANGUAGE ARTS (2-5P- ,
No Access v
2 Abbott, Bilty 169789456 Acsigned LG ART) Mo access granted A
3 Bates, Mary 123456789 Assigned (&= 2ND SPED LANGUAGE ARTS (2-5P- Mow until 11:58pm (No Bell Scheduled Access v
) LANG ART} Schedule)}
4 Dane, Mark 456123789 Assigned (emre ZDERED LB ER T (BT Mo access granted Mo Access
LANG ART}
=D 15T SPED LANGUAGE ARTS (1-5P- .
3 . \coess Now
Edwards, Lamy 789456123 Assigned LANG ART) Mow A ]

-

1-5 of 5 reconds

Student Access Screen

4. Click Save.

Working with Responses

Rescoring Assessment

Click Rescore assessment after editing items to update the scores for all students who have ever
taken the assessment.

(]

Retum

Copy assessment

Dpen a printable version
View assessment as a
student

Rescomre assessment

Assessment Creation Screen
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Scoring Constructed Responses

Accessing the Responses

Using Constructive Response Grading Screen

1. Select Constructive Response Grading from the Assessment menu or navigate to
Synergy SIS > Assessment > Assessment Item Grading.

Aszseszment » RTlI - Admin -

Item Bank (Create & Edit ltems)
Dashboard (Authorize Students & View Resuliz)
Assezsments (Creste & Scheduls Azssssments)

Bank Management (Create & Edit Banks)

Constructed Response Grading

Passages (Create & Edit Passages)

Cooencibemn

2. Select how to view the items requiring scoring.

« By Student — Lists the students that supplied answers and how many items require

review.
Enable Constructed Response Scoring to determine who can
==l score these items.

Filters By Student

Student =3 7 items

=T v Student Assessment Class Needs Review

= v Abbot, Billy Checkpoint Grade 2 Reading Inf: Integration Knowledge and ldeas Wagner, A SOC STUDIES 6 51(3) 2
Baron, Richard Checkpoint Grade 3 Reading Inf: Integration Knowledge and Ideas ‘Wagner, A SOC STUDIES 6 51(3) 1
Smith, Mary CR test Wagner, A SOC STUDIES 8 S1(3) 2

Assessment Item Grading Screen

« By Question —Lists the items and how many student answers need review.

Filters By Question
Date v 4items
Assessment v Needs
5 Date Assessment  Quesfion Review
Question Q
9/24/2015 CRtest V2 2
12:00:00 is considered an irrational number. What makes this number irrational? Explain your reasoning.
AM
??::,:2;5 CR test Shelly is painting signs for her school’s pep rally. She has AL; gallons of paint. Twelve signs use 1_{ galions of 3

Assessment Item Grading Screen

3. Selectaresponse to grade by either Student or Question.
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Using the Assessment Dashboard

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Assessment ~ RTI -

Item Bank (Create & Edit liems)

Dashboard {Authorize Students & View Resultz)

Assezsments (Create & Scheduls Azzsssments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

[——
Assessment Menu
L] L]
Grade Allow Overall 1(SA) 2(TF) 3(MC) 4(CR) 5(MC) 6(MP) &A(MC) 6B (CR)
Student District 1D Book Status Status Date  Section '~ School ¥ Teacher™  Retake Score ) ] ] ] o o o Q
T2.5% 65%
‘Abbott, Billy necarsa
01/04/2018 Jackson, K Am Govi{0) x 6.2510.00 1.00/ Unscored 025/ . Unecored
Retake on 1/4/2018 905483 Complete [ Hope High Schdl tackson, Kathy] T c A 0
P ﬂ 09:40 AM Jackson, K /Tofit F (83%) 1.00 rd 1.00 e
Alexander, George 97141 Compers /200G carmemzyEn 2 0w
Amow, Wayne [ [P
Reloke on 142018 873840 Complets  J1/04201 Lt 10 schf aokcon i AL B e tmpela 0K e )
I's
Arvanitas, Christina p - x R | nscored recorza
Relake on 142013 6276 compiee (IR commmEmEEEmETemmEm X 00 1R F T TUmeea 0B o )
Bailly, George —
Relake on 1142018 874872 Complete /042018 CcrmmemyEn ¥ Smow (fod ;o Umeed, 00 o @
I's
I 0 X Unscore: Unecored
Barbour July 2 967418 compers DN cowTREYD CETEReTYEm X w000 p -l DS 5
% 000/ x x .
P 03/07/2018 x 2251000 100/ 025/ c teeam
Barrett, Linca 985447 Complets  gzooy L Hope High send Jactson Katiy] (29%) 1 T A L o ’

Student Assessment Results Screen
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5. Print constructed responses, if needed.
a. Select students.
b. Click # .
c. Click Confirm to the Export Student Responses message.
d. Select the Print Options.

Print Options = m

% Use Page Breaks

¥ Show Rubric and Item Body on same
page

+ Show student name

*® show item ID

~" Show rubric

+' Show item stem

Force Line Spacing

* None
Single
Double
Triple

Print Web Page

e. Click Print.
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Scoring the Response

1. Review the Student's Response. (1)

2. Openthe Student's Documents if available. (2]

E Available if Media Upload selected in Assessment settings.

3. Enter and format the Feedback to Student. ©

tem Stem 3

1=ms & CR
The Outeasts of Poker Flat

Show Fassage

Teacher Instructions
TEACHER READS

e Read and complete the task that follows.

Iltem Body,

Rub:
Suggested Item Scere: 2.00 /2.00

Score: 200 |12.00

From this excerpt, determine how author Bret Harte uses events in the story to develop John Oakhurst's personality?
Support your conclusions with details from the text.

Feedback to Studznt

y, Apri 3, 2018 11:51 AM

Constructed Response Scoring Screen

4. Enter the score for the item @ or use the rubric © to select Ratings for each Criteria. The
Suggested ltem Score displays based on the rubric Points and Total Points of the item.

E If the value of the rubric does not match the Points of the item, a
suggested Score displays. You can change this value.

0

Critana

Rubric Points: 272
Suggested Iltem Seore: 2.00 7 2.00

Score:| 200 12.00

Assessment Grading Screen
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5. Click Save Score and Feedback. The nextitem to score opens.

6. Click Close.

Changing the Score of Constructed Response Iltems

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Assessment ~ RTI -~ Admin -

tem Bank (Creste & Edit ltems) I_

Dashboard (Authorize Students & YWiew Results)

Aszessments (Create & Schedule Assessments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Paszsages (Create & Edit Passages)

3o i

Assessment Menu

Select an Results Analysis from Options.
Select the Data Table tab.

Click # nexttoa previously scored Constructed Response Item.

Edit the score. The student score is automatically updated in Grade Book if the Include in
Grade Book setting was selected.

o > 0D

Manual Entry of Assessment Responses

A feature allows you to manually input student responses in to the assessment. This feature works
with the following item types: Multiple Choice, Multiple Select, True/False, and Constructed

Response.

« Fordistrict and school-level assessments, the option is available when enabled when
scheduling an assessment.

Staff Settings
Determine which options are available to school level users and teachers tied to a scheduled assessment. Use the lock
feature to secure the setting for all scheduled instances of the assessment.

" View Student Resulis € +" Access Now &

Item Detail Options » % Unlock Student Submit @

+" Constructed Response Scoring @ « Manual Response Input €

+" Grant Retakes & % Override Student Scores &

Scheduling Assessment Screen

« Forteacher level assessments, the option is available if the assessment uses the appropriate
Item Types.
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Access the Manual Entry Screen

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Aszesement -~ RTI - Admin -

tem Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Resuliz)

Azsessments (Creste & Scheduls Asssssments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Creats & Edit Passages)

o ik

Assessment Menu

2. Select Manual Response Input from Options.

Zeiens - | Art History - Impressionism
Mlimdmind Lol
Navigation \e: )
Results Analysis D: 1142
Schedule Details p28

100

& Support, Student Information Systems
Student Access Enct

Live Details
Actions
Complete

Assessment Details

Pause Assessment

Assessment Dashboard

« This screen acts like a spreadsheet.

« Use the arrows on the keyboard to navigate.

« Ifan Item has an unavailable response, Synergy highlights the square inred and a
notification displays: - Response is not an available choice

« Ifthe assessment uses Constructed Response Items, enter the point value. The total
points display in the Column Header.
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« Synergy automatically saves student scores.

Manual Response Input for GEOSCIENCE DCA: Meteorology and Oceanography

Marwal entry of stores is available for TIF, MC, MS, and CR ltem Types. Use the sproadshoat-style grid below to enter answers for your shudenis, or make changes to alrady eesting answers. Student scones will automatically sav upen entry

Narme District ID Scheduled Group Ll # L5 84 #5 #6 L 8 Ll #0 m "z 3 4
, .0 0O 0O o Lic 0 0O 0 0 o L)
1 | mbcuasli Mohammed 200757 g;“"‘*‘gﬁ;\f; B x ' ¢ A
Manual Response Screen

The Assessment User must enter all responses to mark the
student complete for the assessment.

Partial completion does not display on the Student Analysis
screen.
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Using the Student Activity Log

Synergy Assessment now records activity as a student navigates through an assessment when the
Student Action Log is enabled by an administrator. This record is available to teachers and others
who have access to student results on the Data Table tab on the Student Assessment Results
screen. It captures a student's answers on an assessment when a student has a loss of connection
so the student’s progress through the assessment is not lost.

Entering Responses in a Student Assessment

When someone accesses the student's assessment from StudentVUE, the window highlights with a
red box and the IP address and browser information is recorded in the Student Activity Log.

KS Quick

KS Quick

Access Information

You have heen granted ac

Notices

When providing answers for a student, please ensure accuracy of student responses
The end date for this assessment has passed. As a teacher, you have access to this
outside regular times.

P Start

A Return To StudentVUE

Student Assessment Screen
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Accessing the Student Activity Log

The Student Activity Log is located in the Student Feedback.

1.

o~ w D

Select Assessment Dashboard (Authorize Students & View Results) from the Assessment

menu.

Select Results Analysis from Options.

Select the Data Table tab.

Select a student to view the Student Feedback.

Click Show Activity Log.

#1
#2
#3

Shiow Activity Log

ltem Feedback

Summary Feedback

Constructed Response i

Graphic Drag and Drop 01
Hot Spot 141

Hot Text 11

Results For Student Window
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Viewing the Student Activity Log

Responses in the Student Activity Log are highlighted with a red box when someone other than the
student enters responses in the assessment.

The Student Activity Log is not available for responses entered using
—| GradeCam or Manual Input or for assessments taken prior to enabling the
feature.

0 - User who accessed the assessment from StudentVUE and took this assessment for the student
® - Browser used for that item

©— |P address of the computer where the response was entered

O - Blue numbers on the left indicate the question number on the assessment

O©-Item ID, Interaction, and the response the user or student selected or typed in

@ through ®- Click-by-click information with date and time stamp for this item

oc
IP:12 123 123 1 e
Suppart, Student Information Systems

Clicked to save
12/7/2018 13:50:16.0 ‘.

I/\\) IP: 121231231

Support, Student Infarmation Systems

Start button pressed
12/7/2018 13:50:01.0

Support, Student Informatio

A response has been saved Item ID: 70035

12/7/2018 12:50:16.0 ‘. Interaction ID: RESPONSE1
Value
IP:12.123.123.1

This is my answer for guestion 1

Support, Student Infarmation Systems

Clicked nest item

o

IP: 121231231

Suppart, S

Dropped into a hot spot

12/7/2018 620.0

Support, Si

Suppart, Si

Support, Student Infarmation Systems

®

IP:12.123.123.1

®

1P 12

2312341

®

IP:12.123.1231

toid: 37473
Cheice: Choiced3
Het Spot: HotspotO1

togiel: 37473
Cheice: Chaoice04
Hot Spot Hotspot02

Student Feedback Window
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Viewing the Assessment Results

Responses made by someone other than the student are highlighted with red on the Data Table tab
on the Student Assessment Results screen. Hovering over the item displays additional information
about the user who submitted the response.

3 (H5) 4 (HT) 5 (IC) 6 (MA) 7 (MC) 8 (M3)

Answered by Support, Student Information Systerms

0/1% |11 o1 %

b di 4y

141 1/1 1/1 01 % /1% 0/1%

Student Assessment Results, Data Table Tab

The Data Table also displays icons to indicate how the responses were entered into the
assessment.

.« B _student's results scanned using GradeCam
« B _Student's results entered with Manual Response input

1 , .
e ° —Student's response was overridden

1(CRYA 2(MC) 3(MS) 4(TP

1/1% 141+ 0/1% 111+
[ o] (o]

iz 111+ 171+ 1/
a8 (o]

22V 1/1+ 171+ 1/1+
=] (o]

0/2 % 17114 (17114 D/ 1%

229 0/1% 11 11
@ = =

Student Assessment Results, Data Table Tab
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Losing Connection

Improvements to the assessment system allow students to continue working even when their
connection to the web server fails.

Student responses now save periodically while a student is taking their assessment. Constructed
Response is the best example of this. It saves to their browser even if the student never clicks Save.
Even if the computer suddenly reboots, that saved information is available when the student logs
back in.

Connection Health information is now always available and color-coded.

Last Name, First Name

Connection Health

Assess §al= Average Ping: 143ms

Latest Ping: 13ms
Connected

Student Assessment Screen

Last Name, First Name

Connection Health

ASSESS' Average Ping: 17ms

Latest Ping: 20ms

Mot Connected

Student Assessment Screen

Students are notified if there is a connection loss and there are multiple ways for students to
immediately log back in when disconnected.

Login to Continue

Login

User Name
Password

Login

Student Assessment Connection Loss - Login

Edupoint Proprietary and Confidential



Assessment User Guide

Chapter 6: Using Assessments 217

The Start button becomes a No Connection button with a Login form when the student is not
logged in and there is no connection.

Notices

» You have completed § out of 8 questions.

l No Connection

Login

User Name

Password

A Return To StudentVUE

Student Assessment Connection Loss - Login

Messaging notifies the student to tell the teacher and that they can continue to test.

_ O Connection Lost I

( w You can continue to test, but let your

Average Ping teacher know.
Latest Ping: soms

Not Connected

Login

User Name

Password

Student Assessment Connection Loss - Login

Students are informed when they regain their session and responses they gave during the session
loss are saved in Assessment at this time.

When a student is not logged in, reaching the End of Test requires a login to continue. This login
officially saves the answers stored in the browser during the session loss and requires the student to
submit the assessment.

4 N\
The student must use the same computer and browser because the
student's responses are saved to the browser.

If the browser cache is cleared, the student’s locally saved responses are

A also lost.

Due to the nature of the secure browser and the Sunergy Edupoint Kiosk
App, this locally saved data is cleared if the user logs out. The same is true

. for the browser when using Incognito modes. )

Copyright 2015-2019 Edupoint Educational Systems, LLC



Chapter 7:
View Assessment Results

Analysis BasiCs .. .. ... 219
Viewing Assessment Results .. ... ... ... 221
Test History Analysis



Assessment User Guide 219
Chapter 7: View Assessment Results

Analysis Basics

You can view any assessment that displays in the Dashboard.

This section focuses on data used to analyze the results of completed
==l assessments. Analysis is also available for active assessments.

Why analyze the results?

Analyzing the assessment results allows you to learn whether or not the student learning outcomes
are met. The data gathered from the analysis can be compared to previous assessments and
existing standards. For example:

« Are students/teachers/schools meeting the standards?
« How do students/teachers/schools compare to their peers?
« Are students/teachers/schools improving?

« Isthe teacher curriculumimproving?

Once the data is gathered on the assessment, it can be reviewed to determine where the successes
and weaknesses are and what actions are needed to share successes and improve weaknesses.

Who can view assessments?

You can view and analyze assessment results based on your security settings.

District users can only view district created assessments. They cannot
==l view teacher created assessments.

Analysis Security

View assessment data based on

Type Setting

Teachers
Student Principals Student, standard or item, and analysis bands

District

users

Item and answer in:

Teachers o Grid view that shows the item number, answer, with the number of
ltem Principals students that picked that answer, and the percentage of correct answers

District « Expanded view that shows the item and answer with the student name

users that selected the answer, the number of students that selected the

answer, and the percentage of students

District The overall score the students received on an assessment for the teacher, the
Teacher .

users school, and the district

District The overall score the students received on an assessment for the school and
School L

users the district
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-
The Student Assessment Results display when you select an assessment
to analyze. Once open, all other analysis types are accessible from the
Navigation menu.

Mavigation Wiew Options -
Student Analysis
School Analysis
Teacher Analysis
ltem Analysis
Schedule Details
Assessment Details
Dashboard
Student Assessment Results Screen
0 Analysis Bands are set up in Grade Book but you can modify them and/or
= create new ones in Synergy Assessment. District users can modify district-
created bands but teachers can only modify bands they created. When
gaps are present in the selected Analysis Band and the results are not
accounted for, they highlight in gray.
Analysis Bands Perf. Band 1 Details
Gean Bands @ You can setup your color bands without picking colors and a nice palette will be r you. Hf you want to setup custom colors you
F 9.49 '3
Analysis Bands Screen
\.
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navigate to Synergy SIS > Assessments > Assessment Dashboard.

Aszessment -

RTlI -

Admin

Item Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Resuliz)

Constructed Response Grading

Passages (Create & Edit Passages)

Assezzments (Creste & Scheduls Azssssments)

Bank Management (Create & Edit Banks)

P
Assessment Menu
2. Usefilters to narrow the results.
Dashboard (Authorize Students & View Results) QB s Lock Sign Out Support Help
A (52) Jacksen, K Psychology 11(1) SEC:1165 f Progress Period 3 +
2017-2018 v | View Dashboard Archive Toggle Live Dashboard
Filters ‘Q You Scheduled Scheduled For Your Classes Completed Analysis Favorites
Exact Match 18 eme
Assessment ID
Exact Maich Assessment Details Start Date End Date Student Access Completion
Q Options + GradeCam Test 0711817 04/30118 220f 117
Teacher Level 19%)
Text Search Schedule Name: GradeCam Test Students with access
Assessment Name. Assessment ID: 3253
Q Schedule I1D: 2047
Total Points: 9.00
Name a Scheduled By: Jackson, Kathy
Created By: Jackson, Kathy
Start Date a Scheduled To: scheduled To -
End Date Opticns ~ Demo Assessment 12/04117 05/25/18 40 of 222
Q Teacher Level (18%)

Select Search

Schedule Level Name

Scheduled By

Schedule Name: Demo
Assessment

Assessment 1D: 2249
Schedule 1D: 1037

Total Points: 13.00
Scheduled By: Jacksen, Kathy
Created By: Jackson, Kathy
Scheduled To: scheduled To -

This assessment is Online
Only

Students with access

Assessment Dashboard Screen

221
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3. Select Results Analysis from the Options menu for an assessment. The Student Assessment
Results screen displays the Charts tab.

Student Assessment Results LA sapg & Seoro Loc SignOut Support Help
A (YR) Garoll, N 24 Grade(1) SEC:0102 / 15t @ + ==
Sider sy Fr E— [
CR Assessment o 9
CR Assessment ioh
0712672019 75.00 - 100.00
Completions 0
25 Medium
Overall Average 50.00-74.00
o [

Low
Options~  Moreinfov  0.00-49.00

00

e Charts  DalaTable  Grade BookOpfions  Reports

Your Results

@ Ethnicity Results

Student Assessment Results Screen

4 N
You can access the results for an assessment from the Schedule
Assessment screen.

\ 4 o
View assessment details
| View results analysis
Schedule Assessment Screen
\ /

Edupoint Proprietary and Confidential



Assessment User Guide

Chapter 7: View Assessment Results 223

« Selectthe Navigation. (1)
o Student Analysis— All users
o School Analysis — District users
o Teacher Analysis — District users or Principals
« Question Analysis— All users

o Schedule Details — Select to view the Assessment Schedule screen for the
assessment.

o Assessment Details — Select to view the Assessment Creation screen for the
assessment.

o Dashboard— Select to return to the Assessment Dashboard.

o Selectthe View Options. (2]

MNavigstion~ || View Optians =

Data Views o Analysis Band o
GradeCam Test High

04/30/2013 75.00 - 100.00 Assessment ltems ¥ oy band 1 ¥ | | Edit Bands

Completions
24 Medium

Overall Average 50.00 - 74.00
2555 7 Data Filters @
Low I v
Options = || More Info w 0.00 - 43.00 =elec s P

13

Without filters you are seeing all assigned students
SiestEies

Assessment Results Screen
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« Data View — Select to view details by Assessment ltems, Standards, Historical
Summary, Historical Standards, SBAC Claims, or SBAC Targets if available to

the specific assessment. (3)

« Ifyou select Standards, select specific Standards to narrow the results.

Wawvigation = || iew Options =

Data Wiews Standards

Standards v All v |

All a
41
41PO1

Analysis
41P02a
41P03a
41PC4
41P0C4
41P0O5a
Data Filte] 4.2p0 1
43P0
Favorites: | Selectafaver| 44 po 4
4MDE.4
4RLA
4RL3
2.FAZ
‘Without filters you are sesing| 3.F.B
hl 3.FB4

B3
ELACC4RLA 7

Azian 1

Assessment Results Screen

my band 1 T

Select 3 Filer b

« Ifyou select SBAC Claims, select specific Claims to narrow the results.

Mavigation + “iew Options +

Data Views Claim
SBAC Claims v | Al v
All
Analysis Band

6th ELA Form 2 ¥ | Edit Bands

Data Filters @

Select a Filter v

Without filters you are seeing all assigned students

Assessment Results Screen
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« Ifyou select SBAC Targets, select specific Targets to narrow the results.

Mavigation + “iew Options «

Data Views Target

SBAC Targets v | Al v

1 Ela - Reading - 09
. 1 Ela - Reading - 10
Analysis | 1 Ela- Reading - 12

6th ELA Form 2 ¥ || Edit Bands

Data Filters €@

Select a Filter v

Without filters you are seeing all assigned students.

Assessment Results Screen

« Analysis Band — Select to apply desired analysis bands to the available charts
and data available. @

E Click Edit Bands if needed.

« Data Filters — Select an option from Select a Filter to change the data
displayed. O sce Filtering Data From View Options.
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« Use the Options menu to move view assessment information: (6]

Assessment with SBAC Advanced (Level 4)
01/30/2018 50.00 - 100.00
1]
Completions
1 Proficient (Level 3)
Overall Average 70.00 - 83.99
33.33% 0
Nearing Proficient (Level 2)
Options « More Info - 50.00 - 69.99
n
Navigation

Schedule Details
Assessment Details

Student Analysis

Staff Settings

® View Student Results @
¥ Constructed Response Scoring @
v Grade Book Pull @

Celn

Results Analysis Screen

» The Navigation options are available to all users:

» Schedule Details — Select to view the scheduling information for the
assessment.

o Assessment Details — Select to view the information for the assessment
on the Assessment Creation screen.

« Student Analysis — Select to view the Student Analysis Assessment
Results screen.
« The Staff Settings options are not available for Teachers:
« View Student Results — Select to allow others to view student results.

« Constructed Response Scoring — Select to allow others to score the
Constructed Responses.

« Grade Book Pull— Select to allow teachers to pull the information into
Grade Book.
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« Use the More Info menu to view assessment completion information for the

assessment. 0

Assessment with SBAC

01/30/2018

Completions

1

Overall Average
33.33%

COptions =

More Info -

Assessment ID 1219

Schedule ID 807 :(Level1)
School Count 1 10-49.99
Teacher Count 1 1

Not Started 39

Started

0
Completed 1
Active Now 0

Advanced (Level 4)
90.00 - 100.00

Proficient (Level 3)
70.00 - 89.99
0

MNearing Proficient (Level 2)
50.00 - 69.99
0

Assessment Results Screen

o Select Add More Results to compare information between assessments. O For
example, compare the results of a test given before you present the subject to a class

and after.

« Selectatab: ©

e Charts —All users

« Data Tables — All users

« Reports — All users on Student Analysis, district users on Teacher Analysis

o Details — All users

« Exportresults: (10)

« Export Student Results — All users can export student results

o Export To Excel —All users

o Export to PDF —All users

« Connect/Update Grade Book — Teachers can update scores in Grade Book

« Create Breakout — Teachers can create breakout classes

227
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« Drill down into the details on the chart.

« Click a chart section to display the student information for the data
« Click “ onthe bottom right corner to resize the pop-up window.

« Click =+ to expand the pop-up window to full size.

Dander Results - Femake - Lo E

Assessment Results Screen

Filtering Results

From View Options

Use the following steps on the Student Analysis, Teacher Analysis, and School Analysis screens to
change the data that displays.

1. Select an option from Select a Filter to change the data displayed.

o Completion— Select to Include or Exclude students base on their current status of the
assessment, this defaults to display only completed students when the assessment is
complete. Select an option:

« All-Displays all students scheduled to the assessment.

« Assigned — Displays students currently assigned to the assessment and have not
accessed the assessment. This filter automatically applies for Active
assessments.

« Started — Displays students who have accessed the assessment.

o Completed —Displays students who have submitted the assessment for grading.
This filter automatically applies to Completed assessments.

« Student Group — Select to Include or Exclude students based on the Synergy-created
student groups.

o Overall Score Percent — Select to Include or Exclude data based based on score
ranges using operators (=, <, <=, >, >=)
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o CSV File—Select to Include or Exclude data based on an imported spreadsheet.

Mawigation = \fizwr Cptions =
Data Views Analysis Band
Assessment ftems ¥ fith ELA Form 2 ¥ || Edit Bands
Data Filters @

leal | Completion v | Include ¥ || Szlzct one of mors

Select 3 Filter

Completion
Student Group
Owerall Score Percent

CEVFile
7V

ou are seeing all assignad students.

e

Assessment Results Screen

2. Click Add Filter.
3. Add additional filters if needed.

a Click Clear Filters to clear all filters or * to remove a single filter.

4. Click Apply Filters. Active Data Filters display to indicate you filtered the data on the screen.

Data Filters @

Select a Filter v

b R WTPSTLEY Shudent Group - Baseball Varsity (016)
t 3 MUY Siucdent Group - Football Varsity (060) |
b W TLEY Overall Score Percent < 50

*

oo

Assessment Results Screen

In the example, the data includes only students in the Baseball and
Football Varsity student groups whose Overall Score is less than

50.
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Teachers with School Level Access

Select which results to display (for teachers with school level access):

« Click Switch to all results to view all results.
« Click Switch to just your results to view just your classes.

‘You are currently viewing your entire school | Switch to just your results

The ability to switch results displays depending on your scheduling
level.

In Data Tables and Grids

Enter a value to filter data for analysis in the column.

Use last names only for Teacher.
= Enter percentages without %. For example 100 for 100%.

Some Overall Scores require you to calculate the value. For example,
7.00/8.00 is 87.5 instead of 88.

« Gender and Ethnicity headers are available.
« Search and Filter options are available on appropriate column headers.

. Select & to display the Column Chooser and make decisions on which information is
displayed or hidden.

Charts Grid

SelectAll | SelectNone Shaw Anaysls Sarde Export Student Results || Export To Excel || Exportta POF
oFF

Pagelof23(tit6items) < [[)] 2 3 4 562 . A 2 B[

| Column Groupings
| Drag a column header here to group by that column

1
Grade Allow Overall (Mc) 2(Mc) 3(MC) 4(MC) 5(MC) 6(MC) 7(MC) 8(MC)
Q ] (*) -] () ] () ]

Student School District ID Book Section Teacher Retake Score

Overall Summary Avg:64.13% 60.65% 55.39% 62.41% G4.16% 66.42% 69.17% 65.66% 69.17%

Aaron, lan CEEEE 120442 n = T B ox A c ] c ] o
(B8%)
Abernathy, Diana [ Lincoin Elementciz<:hrg [Licnes, sormit=
Hpeyta, Tina G 146772 R L grne 8 o A c D c D D
(100%)
Acosta, Joseph [ Lincoin ElemeoRiEE [ ngham, 1 00 Graceqs] aingram, weon
- o 8.00/3.00
Acuna, Annie { Adams Element1iH] - W eurgharst, ¢ 34 Gradel] Burghardt, Chey (100%) B D A c D c D D
Acuna, Mary [ effersan ElemfocneS A J Waliams, K h Gracett)] Wliore=, Kevir L Rreei] IS A A% A% AR AxX AR

Student Assessment Results Screen

o Click a Student Name or their Overall Score to see the Results Summary screen and the
Item Feedback.

Edupoint Proprietary and Confidential



Assessment User Guide
Chapter 7: View Assessment Results

231

« Click an Item Response to see how the student responded to that individual item.

« Theresponse has ared border if a user other than the student provided the response.

. B displays displays if the student’s response was entered using GradeCam Hand
Scan or Bulk Scan.

« B displays if the student’s response was entered using Manual Entry.

Sorting Results

Click the header to sort the column in ascending or descending order. Click again to change the
direction of the sort.

Charts  DataTable  Repors

SelectAll || Select None %) Show Analysis Bands

Page: 1 of 5 (219 items] [zzash>

| Cohnn Grougings
| Drag 2 column header hers to group by that cokamn

Grade Allow Overall 1(MC) 2(HS) 3(HS) 4(IC) 4ago 4BQO) 4000
Student District ID  Book Status Status Date  Section ™! School =/ Score Q ] ] Q Q Q ]

T15% 1875% 19.33%  19.38%|

Abbot, Bill (117 7 J L ck=on. K Am Govift)

iy - X  7o0m300
Retake on 127182017 %0383 S HEH . K o Favorgah 2= Eish Scid Jackon Kat (54%) B

Student Assessment Results Screen

« Inthe Assessment Items Data View, sort by any column heading including answers to the

Grade Allow Overall 1(MC) |2(HS) 3(HS) 4QC) eano asBuo)  4cao
Student District ID  Book Status Status Date  Section ™ School | Teacher™  Retake Score Q Qo Q (-] Q L] L]
Averages 69.9% T25%  80%  65% 775% 1B75% 19.38%  19.36%)
Abbott, Billy o 010772018 Jackson, K Am Govi{0) = x 7.0013.00 100/ 100/ 000/
Retake on 12182017 905483 GrEE 0116 PM Jackson, K Mofft Favorify 2P 1gh Schd Jackson, Katin] (54%) 8 100 ) 400 e
o ®
Mexander,George G541 ] compete DOV CIDCDCEEEIGETEED ¢ o ” [0 TR R i

Student Assessment Results Screen

« Inthe Standards Data View, sort by any column heading including standards.

Grade Allow Overall
Student District ID  Book Status Status Date  Section ¥/ School ¥/

Teacher™  Retake Score 41 41P01 41P01 a
Averages. 69.9% 68.75% 5% 68.75%

Abbott, Billy 01072018 Jackson. K Am Govi{0) = x 7.00/13.00 o
Retaks on 127182017 903483 n Complete  py-16 M Lackson, K Tl Favorifyl 2P ool $e lackon. Katin] (54%) i (o%) 014 (0%) o1 @%) ¢

Student Assessment Results Screen
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Hover over the pie chart to view the distribution.

615%

4.1 4.1.P01

/1 (0%) /4 (0%)

Student Assessment Results Screen

Grouping Results

Drag a column header into the box to group the results.

4.1

Grade Allow Overall
Student District ID  Book Status Status Date  Section ¥/ School ¥ Teacher™  Retake Score 4.1.PO1 4.1PO1 4.1.P0 2.2

2 L] 7 2 L]

Student Assessment Results Screen

N\
J

Make sure the arrows show when dragging the column header.

Select Al Select None

Page 1 of 5 (219 items) a2 3 4 5>

1p by that column

4.1

Student Assessment Results Screen

o Dragging the heading back to the column headings ungroups the results.
= The arrow indicates where it will be inserted. Ungroup results before
switching to the ltem results view.

| Retake 4.1 < 1.P0O1 41.P01

Student Assessment Results Screen
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Comparing Student Results

1. Select an assessment from Add More Results. Results from all of the selected assessment

display.

Student Analysis For Assessment
American Government Test

Charts Data Table

Reports
American Government Pre-Test  _ American Government Post Test  _
01/12/2018 = 01/26/2018 =

American Govemment Pre-Test

Overall Average

Navigation = || Vizw Options

011272018 0172612018

Completions
4

Overall Average

Completions
26

Assessment Results Screen

2. Selectthe Data Table tab. A graph displays showing the difference between the

assessments.

Charts Data Table

Reports

Create Breskout || Export To Excel || Exportio POF

| Gohumn Grougings

{ Drag a column hesder here tm group by that cxkumn

lan, Janice

Samuels, Aaren

186257

912815

Assessment Results Screen, Data Table Tab

Copyright 2015-2019 Edupoint Educational Systems, LLC



234 Assessment User Guide
Chapter 7: View Assessment Results

3. Select = toprinta PDF orimage of the graph.

Print

BNG il
Lindley, Jen ari702 =

PDF file

60

40 20

- JPEG file
20

WG file

Assessment Results Screen, Data Table Tab

Creating Favorites

You can create favorites from your Active Filters and when you compare results.

Data Filter Favorites

1. Selectyour Data Filters.

2. Click * to add this group of Active Filters to your favorites.
3. Enter a name for your filter.
4. Click Add Favorite Filter.
Data Filters €
Favorites: | Select a favorite v

Select a Filter v

b L WINTLEY Student Group - Baskethall (BSK)
E 3 N MY Student Group - Football (FOOT)
b &M= GG Dverall Score Percent < 50

x
= '
=

Assessment Results Screen
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A new menu displays to select Favorites.

Select 2 Fil

Data Filters €

=~

Favorites: | Select a favorits v

Select a Bavorite
Athletic Groups Score < 50

v

Without filters you are seeing all assigned students.

Assessment Results Screen

a * indicates you used a filter from your favorites.

Data Filters @

Favorites: | Athletic Groups Score <50 ¥ |

Select 3 Fiter v

e, Sient Group - Footal (FOOT)
XN Sient Group Basketoal 55K
% 3. Exchuie EEEIETRED

*
o

Assessment Results Screen

235
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Analysis Favorites

1. Select the assessments to compare.

A w0 D

Click to create an analysis favorite.
Enter a name for the analysis favorite.
Click Add Favorite Analysis.

Student Analysis For Assessment

American Government Test

Analysis 01082018

Add Favorite Analysis

Assessment Results Screen, Data Table Tab

« The Analysis Favorites tab displays on the Assessment
Dashboard screen. Select a favorite to compare the results.

2017-2018 ¥ || View Dashboard Archive Toggle Live Dashboard

“You Scheduled Scheduled For Your Classes Completed Analysis Favorites

Analysis 01/08/2018
Includes

American Government Post
Test

American Government Pre-
Test

W K

Analysis Dashboard Screen

indicates you used a filter from your favorites.
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Viewing Assessment Items

« Click < to see the item.

Answers

Teacher Instructions

TEACHER READS:

Caleb picked apples off of his Grandma's apple tree. Did Caleb pick an odd or an even number of apples?
Click on the correct answer below.

ltem Body
Caleb picked apples off of his Grandma's apple tree. Did Caleb pick an odd or an even number of apples?

Click on the correct answer below.

L=

Student Assessment Results Screen

For Multi-Part items, the individual parts display with an alpha
character appended to the item number. For example, 3.A, 3.B,
3.C.

E For EBSR items, the individual parts display with an A and B
appended to the item number. For example, 4.A, 4.B.

For assessments with Sections, the sections are separated by a line
and the numbering changes. For example, 1.1,1.2,1.3and 2.1, 2.2,
2.3.

\. J
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« Hover over the answer to see the student and correct response.

7o; ) A A A
rted Overrider

Student Response:
red A
rted Correct Responses:

A

rted
rted

Student Assessment Results Screen

Overriding Scores

Select an Override for the score.

[=]
I=
1=
I=

;u:l

b Cwarrides

(= £

Studs Mark Correct
Ed A

Mark Incorrect

® No Override
Corrg

!

Student Assessment Results Screen

Overriding a student score does not update the Grade Book assignment
or impact any item analysis statistics.

Teachers push scores to Grade Book from the Student Assessment Results screen.
1. Selectthe Data Table tab.

2. Select the students that have score adjustments. The selected students highlight in green.

All previous data for the selected students will be overwritten when
you push the scores from the assessment. Make sure you only
select the students you want to change scores for.
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3. Click Connect/Update Grade Book.

Charts Data Table Reports

Select Al || Select None

% Show Analysis Bands

Page 1 of 7 (301 items)

Connect/Update Grade Book

Create Breakout

Export to PDF

| Cohmn Groupines
| Drag 2 column headr here t group by that cskumn

4

Grade
District ID ~ Book Status

Allow Overall 1(CR) 2(CR) 3(CR) 4(MC) 5(DI
Student Status Date  Section School Teacher Retake Score -] Qo o -] ]
Averages 0% 100% 0% G667%  100% 10
300/ 100/ 200/
[TiTe:sTe TP A Jackson, K Am Govi(0) ® £00/10.00
Abbott, Bily 205483 Complete : [ Hope High Schq Jackson. Kathy} 30 20 30 ¢ Corrs:
n 07:43 PM Jackson, K Am Govi(D) (80%) ’ =) ’

= ] )

Student Assessments Results Screen, Data Table Tab

239

Copyright 2015-2019 Edupoint Educational Systems, LLC



240

Assessment User Guide
Chapter 7: View Assessment Results

Viewing Student Assessment Results

( )
Student responses to technology enhanced items display in the Student
. Assessment Results screen. Items rendered and scored outside of
Synergy display images of the student responses. Images are not
exportable and items rendered outside of Synergy are not included in
L Assessment Advanced Statistics. )

Student Analysis For Assessment Navigation ~ || View Options v

Demo Assessment
057252018 75.00 - 100.00
. 2
Completions
40 Medium
Overall Average sn-w1- ;a.nn

67.12%

Low
0.00-25.00

Options = || More Info =

Add Mora Results ~

Charts Data Table Reporis

e Overall Results

o Ethnicity Results

Student Analysis Screen

Hover over a section of the chart to view details.

Low
1154 student(s)
69.98 %

el 92 (G%)

403 [ 24%)

Student Assessment Results Screen
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The results displayed on the Chart tab include:

« Alist of the Analysis Bands, the associated settings and how many students are in each band.

« Overall Results indicate the number and percentage of students in the Analysis Band for all
students. @

« Ethnicity Results indicate the number and percentage of students in the Analysis Band by
ethnicity. (3)

« Gender Results indicate the number and percentage of students in the Analysis Band lists by
gender.

Gender Results

10 6 2

Student Analysis Screen
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« Standard Results indicate the number and percentage of students in the Analysis Band lists

by standard.
Demo Assessment _
Standard Results -
42p01 40
:_'_:; 1 40
40
41 31 5
41P01 3l 43
31 5
29 51
B
26 14
e 17
23 1
32 B

Student Analysis Screen

« SBAC Claim Results indicate the number and percentage of students in the Analysis Band
lists by SBAC Claim.

Assessment with SBAC
SBAC Claim Results

Student Analysis Screen
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« SBAC Target Results indicate the number and percentage of students in the Analysis Band
lists by SBAC Target.

Assessment with SBAC
SBAC Target Results

Student Analysis Screen

i,

Standard, SBAC Claim, and SBAC Target Results do not display if
not defined in the assessment.

SBAC Claims and SBAC Targets only display for items in the
INSPECT item bank that have SBAC data associated.

Select a Standard, Claim, or Target from View Options to view a
definition and to view the results. @

N\
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The results displayed on the Data Table tab depend on the Data View selection in View Options.
The Data Table displays the raw score followed by the preferred score (in parentheses).

o Assessment Items Data View

* Student Analysis For Assessment Navigation ~ || View Options ~
Demo Assessment
Dema Asssssment High
05252018 750010000
2
Completions
Medium
Overall Average S
67.12% =
Low
Options + More info + 00 -sse
7
Add More Results ~
Charls | DataTable | Reports
Selectal | SelentNone % Show Analysis Bands kout || Expon Student Results
Export ToExcal || Exportto POF
Page 1 of § (219 items) mjzzash
| Cownn Grousings !
| Drag 2 column header here t group by that colkemn |
4 »
Grade Allow overall 1(MC) 2(HS) 3(HS) 4(IC) aaqe) 4By  4c(e) 4
Student District ID  Book Status Status Date  Section | School ¥/ Teacher™  Retake Score -] -] -] -] [ L] ]
Averages 69.9% 725%  B0%  65% 775% A75% 19.38% 19.33%
* * ° * *
Abboit, Billy 0170772018 Jackson, K Am Govi{0) = x 7.00M3.00 100/ 1.00/ 000/ B . .
Retake on 12182017 05483 B compete i0iou koo, K flolit Favory 10PE High Schdl Jackson. Kathy (54%) B 100 100 200 CoeD oD mmem oo
— e . 12082017 ® 7.0013.00 . ® 100/ 000 400 . .
seanaer Gerge w75t ] compee 13RO NI QI €I ol O L e I
041772018 ® 12001300 100/ 100/ 400/ 2 5 5
sl e D |2 B C Ul Jockson. K Am Gorts I Hope tigh sch Jackson. Kathy} (92%) B 10  [1oo [spo |22 |amvem faim o

Student Assessment Results Screen, Data Table Tab

« Select Show Analysis Bands to shade the results with the analysis band colors.

Charts Data Table Reports.
SelectAll || SelectNene +/| Show Analysis Bands Connectilpdate Grade Book || Create Breakout

Export Student Results || Export To Excel || Exportto PDF

Page 10f 5 (219items) </ [[1]] 2 3 4 5 [>

! Column Groupings
| Drag a column header here to group by that column

l

Grade Allow Overall 1(MC) 2(HS) 3(HS) 4(IC)
Student ~ -] (-] (-]

District ID Book Status Status Date  Section/™/ School ¥/ Teacher™  Retake Score

v A v v v

Abbott, Bill

ly 0100772018
Retake on 1211812017 905483

“Jackson, K Am Govi(o) ® 7.00/13.00 100/ 100/ 000/
Complete  pq.4pM Jackson, K Moflt [ tiope High Sch Jackson, Katty] (54%) B 100 100 400

041772018 ® 12.00/13.00 100/ 100/ 400/
Complete 0705 P  tiope High Schd Jackson, Kathy} (92%) B 100 100

4.00

/08 x
Aonder,Googe 975141 compes IR crmrETD eorEmemyem ¢ G800 *RHC 9% 46
Amow, Wayne 873840

Arvanitas, Christina 892796 Assigned L1 High scid sackaon, et SRS

. o 12/072017 »® 9.00/13.00 X 100/ 1.00/ 400/
Bailey Mchael 138214 Complete 12072017 ey (ETET €TINS ) D o i

Student Assessment Results Screen, Data Table Tab
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« Selecta student's name to display the overall score for the student. The Preferred
Score Type value displays as the student's overall score. This also displays for students
when they complete an assessment.

Charts Data Table

4.1 Understand the relationships between structures and functions of organisms.

Reporis

Back o Tl

Demo Assessment

Overall Score

92%

12/13

100%

lacomotion)

g0

4.1.PO 1 identify animal structures that serve different functions (e.g., sensory, defense

100%

Standards Data View

+* Student Analysis For Assessment Nevigation = || \hew Options =
Demo Assessment
Demo Assessment High
057252018 7500 -100.00
Completions =
@ Medium
Overall Average S000-7a00
B712% 3
Low
Options v More Info = 0.00 - 43.00
7
Add More Resuls ~
o e
SelectAll || Select None % Show Analysis Bands ConnectUpdzte Grade Book || Creste Breskout || Export Swdent Resuls
Export To Excel Export to FDF
Page 1o s (2omems) <[] 2 2 & 5
{ Colunn Grougings ;
§ Drag a column header here t group by that cokmn |
‘ »
Grade Allow overall
Student DistrictID  Book Status Status Date  Section ¥ School ¥ Teacher™  Retake Score 41 41P01 4.1.P01 4.1p
Averages 69.9% 68.75% 5% 68.75%
® v v ® v
Abbatt, Billy 01071018 mm x 7.0013.00
Relaks on 127182017 205483 B comee oM eommIETT = (E4%) 0 (0%) 014 (0%) o1t (O%) 101 (100
_ o _ 120082017 - x 7.0013.00
Alexander, George 975141 n Complete 1293 A [ ackson, K Am Govi(3) I Hope High Schd Jackson, Katiy] (64%) 0n %) 414 (100%) 011 {0%) 11100

Student Assessment Results Screen, Data Table Tab
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o SBAC Claims or SBAC Targets Data View

Student Analysis For Assessment

* Assessment with SBAC Navigation v | View Options +

Assessment with SBAC

Advanced (Level 4)
0173012016

90.00-100.00
Completions

1 Proficient (Level 3)
Overall Average 70.00- 8959
33.33%
Nearing Proficient (Level 2)
Options = || More Info - 50.00- 6999
0

Basic (Level 1)
000-48.99

Add More Results +

Charts [  Data Table

SelectAl | Select None | Show Analysis Bands

Export Stugent Results | Export ToBxcel || Export to PDF

 Column Groupings
§ Drag = column headsr hers to group by that column

Teacher™  Retake Score

Allow Overall 1Ela-Reading-  1Ela-Reading-  1Ela- Reading -
Student District ID  Status Status Date  Section™ School >/ 09 10 12

Averages 3333% 100% 0% 0%

Student Assessment Results Screen, Data Table Tab
The Reports tab displays reports based on selections. To view a report:

1. Selecta Report Type on the Reports tab.

Charts Data Table Reports

Report Type
Select a Report v

Select a Report

Overall Student Performance
Overall Teacher Performance, Single Standard
Individual Student Performance

Teacher Assessment Results Screen, Reports Tab

2. Make selections depending on the Report Type:

« Overall Student Performance — Select the Class, Order By, and Precision.

Charts Data Table Reports

Report Type Class Order By
Overall Student Performance v Jackson, K Psychology 1(1) (0169) v Alpha v
Precision
Whole A
Generate

Student Assessment Results Screen, Reports Tab
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« Overall Student Performance, Single Standard — Select the Class, Order By,

Standard, and Precision.

You must select a Standardsin Data Views and a

4

single standard from Standards in View Options for
this option to display.

Charts Daia Table

Report Type
Individual Student Performance, Single Standard v

Standard
41 v

Select All

Class

Precision
\Whole

v

Alpha

Order By

Generate

Student Assessment Results Screen, Reports Tab

« Overall Student Performance, Single Claim — Select the Class, Order By,
SBAC Claim, and Precision.

You must selecta SBAC Claimin Data Views for this

= option to display.
Charts Data Table Reports
Report Type Class Order By
Overall Teacher Performance, Single Clam ¥ Select All Alpha
SBAC Claim Precision
1Ela-Reading v Whale A
3enerate

Student Assessment Results Screen, Reports Tab
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« Overall Student Performance, Single Target— Select the Class, Order By,

SBAC Target, and Precision.

You must selecta SBAC Targetin Data Views for this

=  option to display.
Charts Data Table Reports
Report Type Class Order By
Cwverall Teacher Performance, Single Target ¥ Select All v Alpha v
SBAC Target Precision
1Ela-Reading-09 v Whole v
Generate

Student Assessment Results Screen, Reports Tab

« Individual Student Performance — Select the School, Teacher, and Precision.

Charts Data Table Reports
Report Type Class
Individual Student Performance v Jackson, K Psychology 1(1) (0169) v
Precision
Whole v
Generate

Student
Bailey, Michael v

Student Assessment Results Screen, Reports Tab

3. Click Generate to view the report.
4. Click Export To PDF to print the report, if needed.
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Export student results for assessments using standards. If your
assessment does not include standards, only the Overall Score displays.

1. Selectthe Data Table tab.
2. Select the students to export. The rows highlight in green.
3. Click Export Student Results. A confirmation dialog displays.

Charts Data Table Reports

SelectAll || Select None

Page 1 of 5 (219 items] M2228535>

% Show Analysis Bands CannzctUpdat

§ Cohumn Grouings.
} Drag  column header her= t group by that cokemn

4

Grade
District ID  Book  Status

Student
Averages
Abbot, Billy
Reake on 12182017 905483 R comper
AMlexander, George 875141 n Compiets
Amow, Wayne 873840 n Complstz

Arvanitas, Christina 892796 Assigned

Bailey, Michael 138214

I3 compet

Allow

Overall
School ¥ Teacher™  Retake Score.

1(MC) 2(HS) 3(HS) 4(IC) <apo) 4sge)  4cuo)
Status Date  Section -] -] 9 ] -] -] Q

69.9% 725% 0% 5% 71.5% 18.75% 19.38%  19.38%|

011072018 Jackson, K Am Govi{0) x 7.00/13.00 1.00/ 1.00/ 0.00f

el e Lriope g e o o] Moz (5t 40 000 emm famm amies
120082017 x 7.00/13.00 X 00/ 000/ 4007 . . .
EREYTH Jactson. X Am GovtG) [ Hope High Sct] Jacson, Kate| (E2%) D B ORE aE e miam i
04/17/2018 x 12.00/13.00 1.00/ 1.00/ 4007

oLl oo Am Gor Y iopein s sceson.Kary LW g D MO 40 s e s

x
acioon K m Gori Y Hope o s dcson Kt
120072017 ® 5.00/13.00 | X 100/ 1.00/ 4007
DaaA D B 2] 100 100 AD0 i e et

Student Assessment Results Screen, Data Table Tab
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4. Click Confirm. The results display.

Demo Assessment

Overall Score

53%

Ti13
Results Summary
4.1 Understand the relationships between structures and functions of D 0/
organisms 0
i1
50
50
El
0
4.1.PO 1 identify anims! structures that serve different functions (e.g. O 0/
sensory, defense, locomotion). 0
0i1
50
50
30
0
4.1.PO 1 Recognize different typss of maps (e.g., political, physical, D 0/
thematic) serve various purposes 0
0id
50
60
30 /
0
4.1.PO 2.a vertzbrates — msmmals, birds, fish, reptiles, smphibians 1 O 0 0/’0

111
50 @
60

Exported Student Assessment Results Screen

« Hover over a data point to see the assessment name where the standard was
evaluated.

Results Summary

4.1 Understand the relationships between structures and functions of O 0 /
organisms 0
0i1

Demo Assessment 12/18/2017 (1037)

Exported Student Assessment Results Screen
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Printing Student Results

s Alloptions under Overall Results and Show Item Summary are enabled
==t by default.

1. Display the results by selecting a student or exporting the results for multiple students.

2. Select Overall Results from the Print Options.

Print Options m

Overall Results

» Show Assessment Mame
W Show Result Measure Text
" Show Overall Test Score

(10

» Show Results Summary
» Show Overall Results
W Show Standards

" Show SBAC Claims

1 | Show SBAC Targets

» Show Result Charts

Feedback View
Hide Feedback I
et Show Incorrect Items Feedback
# Show ltem Summary Feedback (

Show Full tem Feedback

Export Student Assessment Results Screen

« Show Assessment Name — Clear to hide the assessment name.

Overall Score

53%

7113

Export Student Assessment Results Screen

« Show Result Measure Text — Clear to hide text that describes the standard.

4.1.PO1 1000/0

4/4

Export Student Assessment Results Screen
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o Show Overall Test Score — Clear to hide the Overall Score at the top of the results.

Demo Assessment

Results Summary

Export Student Assessment Results Screen

o Show Results Summary — Clear to hide the Results Summary.

Demo Assessment

Qverall Score

53%

7113

ltem Feedback

#1 Multiple Choice 0/1
#2 Het Spot 171
#3 Het Spot o/1
#4 Inline Choice 474
#5 Hot Spot 0r1
#6 Het Spot 171
#T Multiple Choice 0/1
#5 Multi-Part 0/
#5 Multiple Choice 171
#10  Hot Text 0/

Export Student Assessment Results Screen

o Show Overall Results — Clear to hide all information but the student name,
assessment name, and ltem Feedback.

Demo Assessment

ltem Feedback

#1 Multiple Choice 071
#2 Het Spaot 11
#3 Hot Spot 071
#4 Inline Choice 474
#5 Het Spat 0/1
#5 Hot Spot 171
#7 Multiple Choice 071
#3 Multi-Part 0r1
#9 Multiple Choice 171
#10  Hot Text 0/

Export Student Assessment Results Screen
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« Show Standards — Clear to hide results for standards.

CCSS.ELA-Literacy.RF.3.4a Read on-level text with

purpese and understanding

20 ©

100%

Export Student Assessment Results Screen

« Show SBAC Claims — Clear to hide results for SBAC Claims.

1 Ela - Reading

33%

Export Student Assessment Results Screen

« Show SBAC Targets — Clear to hide results for SBAC Targets.

1 Ela - Reading - 09

w
- &

100%

Export Student Assessment Results Screen

o Show Result Charts — Clear to hide all results charts.

4.1.PO 2.a vertebrates — mammals, birds, fish, reptiles, amphibians

100%

Export Student Assessment Results Screen

253
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3. Select Passages from the Print Options. Show Full Item Feedback must be selected for
the passage details to be available.

Print Options ~ m

Overall Results

®

Show Activity Log
Show Assessment Name
Show Result Measure Text
Show Overall Test Score
Show Results Summary
Show Overall Results
Show Standards

Show SBAC Claims

Show SBAC Targets

Show Result Charts

VNN NN N

L\

I Feedback View

O Hide Feedback

t O show Incorrect Items Feedback

¢ O show Item Summary Feedback

@® show Full Item Feedback

Passages
O No Passages
@ show All Passages
1 O show Each Passage Once

Export Student Assessment Results Screen

« No Passages — Passages do not display.
« Show All Passages — Passages display with each item that the passage is available.

« Show Each Passage Once — Passages display once for each student if used with
multiple items.

4. Click Print.

Edupoint Proprietary and Confidential



Assessment User Guide
Chapter 7: View Assessment Results

255

Exporting Student Responses on Constructed Response Iltems

Teacher, School Level, and District Administrators can print student responses to constructed
response items from the Student Assessment Results screen.

1. Selectthe Data Table tab.
2. Select the students to export. The rows highlight in green.
« Click Select All to highlight all students.

Use Column Groupings to sort the student names by teacher,
==t school, or course before using the Select All option.

« Click Select None to clear highlighted students.

3. Click ® to print the student responses. A confirmation dialog displays.

Charts Data Table Reports
SelectAl | Select None ¥/ Show Analysis Bands Connect/Update Grade Baok || Create Breakout | Export Student Results

Export To Excel || Export to PDF

Page 1 of 4 (181 items) nmz 3 s>

 Column Groupings
 Drag a column header here to group by that column

Grade a - ~ Allow overall 1(SA) 2(TF) 3 (MC) ) 5(MC)
Student District ID ~ Book Status Status Date  Section ¥/ School™  Teacher™  Retake Score [>] -] 2] -] 2]

5806% 64.1% 84.62% 58.97% 359% 8205

v v v b4 v
é‘é?/:fé?é”?mm woms Y compee Qo0 COTIID qruEm @mmopmn X SBOe 100 o unsoed
Alexander, George 975141 Compiete 720010 [tiope High scal Jackson, katny R (Uﬂ‘agm D
Qrenalﬁﬁe‘fna??izo«s - compieie 042018 epryTTTE) CrUITET €XEmEn ¥ Q000 (007 ¢ Tz

Student Assessment Results Screen, Data Table Tab
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4. Click Confirm. The Constructed Response Rubric, Question Stem, and Student Responses
for the ltem selected display.

Print Opticns - m

Rubric for ltemID 50076

Criteria

A response; Score: 2
o Gives sufficient evidence of the ability to understand an informational text and
supplies a relevant and appropriate thesis statement
o Includes a thesis statement that is on topic
A response; Score: 1
o Gives some evidence of the ability to understand an informational text and
supplies a somewhat relevant and vaguely appropriate thesis statement
o Thesis statement is not entirely on topic
A response gets no credit if it provides no evidence of the ability to understand and Score: 0
write an appropriate and accurate thesis statement for a topic.
Page Break

Item Stem for ItemID 50076

Read the paragraph below.

Diclphins are a lot like whales, but they are much smaller. You can find delphins all over the world.
Dielphins can reason and have many thought processes. Delphins can communic ate with each other with
certain sounds that they make. They can even recognize themselves in a mirror, as well as other dolphins
that they know. Delphins can work together to get food that they want to eat.

This paragraph is missing a thesis statement. Write the most appropriate thesis statement to begin
the paragraph.

& Page Break
Response for Abbott, Billy
Sea Mammals
Item 1D: 50076

Dolphins areinteresting mammals that live in the ocean.
Page Break

Response for Dunham, Stephen
Sea Mammals
Item 1D: 50076

Colphins are mammals

Student Response Output
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5. Selectthe Print Options.

Use Page Breaks — Select to print using the Page Breaks shown on the preview.

Show Rubric and Item Body on same page — Select to print the Scoring Rubric
with the Item Stem .

Show student name — Select to include the student names. Do not select to use for
blind scoring.

Use student key and hide name — (District Users Only) Select to display a 6-digit
number in place of the student's name. Do not select Show student name.

Show item ID — Select to include the Item ID.
Show rubric — Select to include the Scoring Rubric for the item.
Show item stem — Select to include the Item Stem.

Force Line Spacing — Select to force a specific line spacing when printing the
document.

Print Options = m

w Use Page Breaks

® show Rubric and ltem Body on same
page

+" Show student name

*®| Show item ID

| Show rubric

+ Show item stem

Force Line Spacing
® None
Single
Double
Triple

Student Assessment Results Screen, Teacher

Print Options = m

¥ Use Page Breaks

% Show Rubric and ltem Body on same
page

¥ Show student name

% Use student key and hide name

% Show item ID

¥ Show rubric

» Show item stem

Force Line Spacing
= None
Single
Double

Triple

Student Assessment Results Screen, District User
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6. Click Print.

E The student responses begin on page 3.

Pulling Scores into Grade Book

Teachers can pull the scores into their Grade Book.

1. Selectthe Data Table tab.

2. Select the students to update. The rows highlight in green.
« Click Select All to highlight all students.

Use Column Groupings to sort the student names by teacher,
school, or course before using the Select All option.

« Click Select None to clear highlighted students.

3. Click Connect/Update Grade Book.

Charts Data Table Reports.

Select All Select None

Page 1 of 5(219items) < [[A]] 2 3 4 5 [>

" Show Analysis Bands

Export Student Results

‘Connect/Update Grade Book

Export To Excel

Creste Breakout

Export to PDF

| Column Groupings
! Drag a column header here to group by that column

Grade

District ID Book Status

b b
Abboit, Billy 01/07/2018
Retake on 1211372017 905483 B3 comee 1NN
Alexander, George 975141 Complete }%‘ESQA?JT
Amow, Wayne 873840 ﬁ Complete g‘fé;’%‘ﬂ g
Arvanitas, Christina 892796 Assigned
Bailey, Michzel 138214 Complets 121972017

Status Date  Section/~!

School ¥

Teacher /™!

Al A v
Seckaon, KAm G Jope rugh scnd smcton Kt
 dactson i Am Govis | Hope ioh sca dackson Kt
[ sackson, K Am Govi(3) X Hope High Schd Jackson, Kathy]
P ecreen e ot Y ipe rege s sraer, g
[ Jackson, K Psychology { Hope High Schd Jackson, Kathy]

Allow
Retake

® 7.00/13.00
(54%)

® 7.00/13.00
(54%)

® 12.00/13.00
(92%)

®

® 9.00/13.00
(69%)

100/
= 100
X 100/

g 1.00
1001

e 100
X 100/

L 100

Student Assessment Results Screen, Data Table Tab
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Connecting Assessment Scores to Assignments

1. Select Dashboard (Authorize Students & View Results) from the Assessments menu.

2. Click an assessment name or select Results Analysis from Options.

3. Selectthe Grade Book Options tab. The targeted sections display the assignments the

assessment scores can connect to.

Folder Style +

Sort by ID | Sort by Name T

Section ID: 0369

Section ID: 0469

Section ID: 1077

Section ID: 1268

Section ID: 1468

Charts Data Table | Grade Book Options | Reports

Compact Row ~

W (51) Jackson, K Am Govt(3) SEC:0369 (E)
W (51) Jackson, K Am Govt(4) SEC:0469 (E)
W (52) Jackson, K Am Govt(0) SEC:1077 CED
W (52) Jackson, K Am Govt(2) SEC:1269 (B

W (52) Jackson, K Am Govt(4) SEC:1469 (D)

Student Assessment Results Screen, Grade Book Options Tab

Click a section or period to display the assignments.

5. Select the assignment to connect the assessment scores to.

6. Hover over an assignment and select Sync Grade Book or Edit Assignment from Options.

An alert displays to confirm that the assessment scores will override
the existing assignment scores if the selected assignment has

existing class scores.

7. Selectthe Data Table tab.

259

8. Select a student and click Connect/Update Grade Book to assign the Assessment scores to

that assignment.

This option displays for District Scheduled Assessments if Grade

Book Pull was enabled.

Book is updated.

A purple icon displays in the Grade Book column after the Grade

Reports

Charts | DataTablel Grade Book Options

District ID  Gender

Student

Ethnicity ¥ Grade Le...

Q Q Q Q Q Q

Grade Bo...

% Show Analysis Bands

ConnectlUpdate Grade Book | Create Breakout  Export Student Results

6 &
Status
Q

Status Da... Teacher School Section Retake  Overall Sc... 1 (MC)

v Seymore, Martha 879226 Female White Grade 12

Bailly, George 874872 Male White Grade 12

Alexander, George | 975141 Male White Grade 12

Not Started Jackson, Kathy Hope High School Jacksan, K Am Govi(d) (046.. Not Started

Not Started Jackson, Kathy  Hope High School  Jacksan, K Am GOVt(4) (146.. Not started

Not Started Jackson, Kathy Hope High School  Jacksan, K Am Govi(3) (036, Not Started

Student Assessment Results Screen, Data Table Tab
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Allowing Students to Retake an Assessment

Select individual students or allow all students to retake the assessment from the Grid tab on the

Student Assessment Results screen.

« Setthe Allow Take/Retake option to Yes for the students that are allowed to retake the

assessment.

The Allow Take/Retake option may be unavailable for district

assessments.

Avg: 40%  Avg: 75% Avgi62% Avgi25% Avgi 0% Avg: 38%

Abbott, Bilty

Retake on 3117201 EIm, M English 11(1) 3.00/6.00 (50%) T F X c cx c
Borman, Mary Elm,M English11(2) el 4.00/5.00 (57%) T T A X c X G
Case, Larry Elm, M English 11(1) 3.00/6.00 (50%) T T B % A X c
Dunnam, Elise Elm, M English 11(2) No

Charts Grid
Select All || Select None Snow Aniysis Sands Create Breskout
Page 1of 2 (66 tems) [« []] 2 [>
! Cohumn Grougings
| Drag a column header here to group by that column
Allow 1(TF)  2(F)  3(MC)  4(MC)  5(MC)
Student Class Take/Retake OverallScore @ [+] -] [+] 2]

Export To Excel || Expart to POF

6 (MC)
-]

Avg: 38%,

Assessment Dashboard Screen, Grid Tab
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Creating a Breakout Class Based on Assessment

Create a breakout class based on the assessment results from the Grid tab on the Student
Assessment Results screen.

1. Use filters to sort the students by their results. For example, sort on the Overall Score column
to group the students and select students performing below grade level, to provide them
additional instruction to reinforce the curriculum.

Select the students from the Students column.
Click Create Breakout. A confirmation message displays.
4. Click Confirm.

Charts Grid
=
Page 1 of 2 (66 items) oz @&
! Cobumn Grouings
+ Drag a column header here to group by that column
Allow 1(TF) 2(TF) 3(MC) 4(MC) 5 (MC) 6 (MC)
Student Class Take/Retake OverallScore @ o ] (-] [+] (*]

Overall Summary Avg 40% AvgT5% Avg62% Avg25%  Avg 0% Avg 38%  Avg: 38%
 Abbott, Billy ) - —

Retake on 3/11/2018 Elm,M English 11(1) 3.00v6.00 (50%) T Fx c c % c cx
«" Barman, Mary Elm,M English 11(2) bl 4.00/6.00 (67%) T T x (&

+ Case, Larry Elm, M English 11{1) e 3.00/6.00 (50%% E T B X & c cx
+ Dunnam, Elise Elm,M English 11(2) bl

+" Edwards, Charlie Elm, M English 11(1) bl

Assessment Dashboard Screen, Student Assessment Results
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Viewing Item Assessment Results

Select Question Analysis on any Assessment Results screen or navigate to Synergy SIS >
Assessments > Assessment Dashboard.

« The Data Table tab displays the consolidated responses to the item.
« Click Export to Excel or Export to PDF to download a file of the results.

Week 3 Math Quiz

ooco®O "

Question Analysis Screen

« The Details tab displays all the information available on the item and the responses, which
include the:

o Item

» Possible Answers

» Related standards

« Students who responded to each answer (teacher only)
« Student responses for Constructed Response items.

item Type Test

(=)

© Forramois Lus.

ide eating, sleeping, and chewing on

© e has a sxyoar ok sitrramea Mazay

© Hosbiesnclu cating seepig, and
b

P e i s i

ing this as the correct answr,

Question Analysis Screen, Details Tab
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Use Jump To Item to jump to the item instead of scrolling.

ﬂ Search Close  Support Help

Jump to tem -

Wiz ltem Analysis -

not shown.

Item Assessment Results Screen, Details Tab

Click the student's name to expand the content.

See the Statistical Terms tab for an explanation of the terms used
such as Point Biserial. Toggle Show Advanced Stats to ON if tab is

J

Exporting Results

1. Click Export to print the results.

2. Selectthe Print Options to limit what displays.

\
|
o
bi

Print Options + |m

# Show Item Details

# Show ltem Statistics

# Show ltem Stem

¥ Show Response Statistics

# Show Constructed Responses

Item Assessment Results Screen, Details Tab, Export

3. Printthe screen using the browser print function.

263
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The Statistical Terms tab defines the terms used on the Details tab.

Assessment [tem Analysis For

Cry Me a River

Vg ltem Analysis - Schedule Detsils

Two Halves Split Reliability:

Standard Deviation: 227 €@
N-Value: 400 @

Water Cycle Quiz g™

Odd/Even Spiit Reliability: 0.00 @

fifuel - ]

Kuder-Richardson 20 Reliability: 065 @

Grid Detailz Statistical Terms

Espart to POF

Assessment Terms

Odd/Even Split
Two Halves Split

Kuder-Richardson 20

Standard Deviation

N-Value

A measure of internal assessment reliability. The response data within the assessment is split by odd and even item numbers. The overall
calculation is the coefiicient comelation of overall student performance on odd items versus even items.

A measure of internal assessment relisbility. The response data within the assessment is split by first half and second half assessment items
The overall calculation is the cosfficient lation of overall student performance on first half versus second half.

& measure of internal assessment reliability. In brief, this calculation gathers dats from all assesement items, comparing the individual item
variances to the overall statistical variance. Traditionally, & value less than 0.50 would be a concemn. This measurs is used primarily with
assessments containing no partial correct responses.

K ZKp;q\
-

r=——-1
K-1 2
Ox
A statistical calculation for how far assessment scores vary. Used in a variety of other calculations.
| a——
1 .
se= =Y (x-x)

=1
The total number of students with results which are included in calculations. Does not include students who did not at least start the
aszessment.

Assessment ltem Terms

Return

Item Assessment Results Screen, Statistical Terms Tab

o Click Export to PDF to download a PDF of the terms.
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Viewing Teacher Assessment Results (District Users Only)

Principals and district users select Teacher Analysis from Navigation on any Assessment Results

screen.

The ability to switch results displays if you have School Level scheduling

ability.

« The Charts tab displays the results by Teacher and School for Assessment ltems,

Standards, SBAC Claims, and SBAC Targets:

Cry Me a River Water Cycle Quiz

x
Cry Me a River Water Cycle Quiz High
02/28/2018 75.00 - 100.00
199

Completions
Medium
Overall Average 50.00-74.00
64.03% 105

Low
Opticns = || More Info v 0.00- 43.00
96

Charts Data Table Reports

10 4 10

Teacher Analysis For Assessment Mavigation v || ‘iew Options »

Teacher Assessment Results

« Enter ateacher and/or school name to Filter by Teacher and School.

Hover over a section of the chart to view details.

A

Medium
14 student{s)
26%

—_—,

159

Assessment Results Screen
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« The Data Table tab displays the results depend on the Data View selection in View

Options. Admin users can view this using the Preferred Score Type.

o Assessment Items Data View

Teacher Analysis For Assessment Mavigation = || View Options v
Cry Me a River Water Cycle Quiz
x
Cry Me a River Water Cycle Quiz | fyigh
02/28/2018 75.00 - 100.00
Completions
Medium
Overall Average 50.00-74.00
64.03% 105
Options v More Info v 0.00 - 49.00
96
Add More Resulls ~
Charts Data Table Reports
e A"ﬂly 3
§ Column Groupings
} Drag a column header here to group by that column
Teacher
Teacher School Average® | 1(MC) 2(MC) 3(MC) 4(MC) 5(MC) 6(MC) 7(MC) 8(MC)
63.85% 60.47%
* L]

Berg, Justin Washington Elementary 58.87% 6774% 4516% 58.06% 5806% 7097% 6452% 5161% 5484%
Branch, Nancy Grant Elementary 69.64% 57.14% 6071% 7857% 5357T% 75% 82.14% 75% 5%
Brunner, Kelley Lincoln Elementary 96.67% 9667% 9667% 9667% 9667% 9667% 9667% 9667% 9667%
Burch, Kali Adams Elementary 55.21% 58.33% 50% 45.83% 5833% 50% 5833% 625% 58.33%
Burghardt, Chris Adams Elementary 63.39% 57.14% 6357% 60.71% 657.14% 6071% 57.14% T7857% B8214%
Carroll, Natalie Adams Elementary 79.31% 8621% 5517% B8966% 8276% 8276% 7241% 8276% B8276%
Dingle, Jason Washington Elementary 66.29% 39339% 5455% T7576% 69.7% 69.7% 7576% T7273% T7273%

Teacher Assessment Results Screen, Data Table Tab
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« Standards Data View

Teacher Analysis For Assessment Navigation = | \iew Options v

Cry Me a River Water Cycle Quiz

x
Cry Me a River Water Cycle Quiz High
021282018 150010000
Completions 2
Medium
Overall Average 50.00 -74.00
64.03% 105
Low
Options || More Info 0.00-49.00
96
Add More Results +
Charts Data Table Reports
' Show Analysis Bands Export To Excel || Export to PDF

+ Column Groupings
! Drag 2 column header here to group by that column

] 3

Teacher
Teacher School Average @ 07.G6.5 11.P02 1.2P02 1.2P03 4.1.PO5
63.85% 65.68%
v hod
Berg, Justin Washington Elementary 58.87% 5161% B3.76% 5161% 5161% 54.84% k
Branch, Nancy Grant Elementary 69.64% 75% B8429% 75% 75% 75% [
Brunner, Kelley Lincoln Elementary 96.67% 96.67% 96.67% 96.67% 96.67% 96.67% 1
Burch, Kali Adams Elementary 55.21% 625% 51.39% 62.5% 625% 58.33%
Burghardt, Chris Adams Elementary 63.39% 78.57% 57.14% 78.57% 78.5T% 82.14% k

Teacher Assessment Results Screen, Data Table Tab

« The Reports tab displays reports based on selections:

1. Select Report Type on the Reports tab.

Charts Grid Reports

Report Type
Select a Report v

Select a Report
QOverall Teacher Performance
Overall Teacher Performance, Single Standard

Individual Teacher Performance

Teacher Assessment Results Screen, Reports Tab
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2. Make selections depending on the Report Type:
o Overall Teacher Performance — Select the School, Order Teachers By,
and Precision.

Charts Grid Reports

Order Teachers By

Report Type School
Overall Teacher Performance v Early College Academy v Performance, Descending +
Precision
Whole v
Export to POF

Edupoint Public Schools Alexander High School 04/04/16
Overall Teacher Performance

Grade 9 ELA CCSS

Teacher Name District Average % School Average % Teacher Average % District Delta

Brown. Mary 43 55 55 [ 12]

Teacher Assessment Results Screen, Reports Tab
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« Overall Teacher Performance, Single Standard — Select the School,
Order Teachers By, Standard, and Precision.

You must select a Standardsin Data Views and a
? single standard from Standards in View Options

for this option to display.
Charts Grid Reports
Report Type School Order Teachers By
Overall Teacher Performance, Single Standard Early College Academy v Performance, Descending  +
Standard Precision
RL.9-10.2 v Whole r
Export to PDF
Edupoint Public Schools Alexander High School 04/04/16

Qverall Teacher Performance, Single Standard

Grade 9 ELA CCSS

RL.9-10.2: Determine a theme or central idea of a text and analyze in detail its development over the course of the text, including how it
emerges and is shaped and refined by specific details; provide an objective summary of the text

Teacher Name District Average % School Average % Teacher Average % District Delta

50 a

Brown, Mary 4 50

Teacher Assessment Results Screen, Reports Tab
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« Overall Teacher Performance, Single Claim — Select the School, Order
Teachers By, SBAC Claim, and Precision.

You must select a SBAC Claimsin Data Views
= for this option to display.

Charts Data Table Reports

Report Type School Order Teachers By
Qverall Teacher Performance, Single Claim ¥ Select All v Alpha v

SBAC Claim Precision

1Ela-Reading Whole v

Export to PDF

Albuguerque Public Schools 01/10/2018

Overall Teacher Performance. Single SBAC Claim
Assessment with SBAC

1 Ela - Reading:
Teacher Name School Name District Teacher Average % School Teacher Average % Teacher Average % District Delta
Jackson, Kathy Wilson Middle School 33 33 33 [o]

Teacher Assessment Results Screen, Reports Tab

o Overall Teacher Performance, Single Target— Select the School, Order
Teachers By, SBAC Target, and Precision.

You must selecta SBAC Targetin Data Views
= for this option to display.

Charts Data Table Reports

Report Type School Order Teachers By
Select a Report v Select All A Alpha v
SBAC Target Precision
1Ela-Reading-09 v Whole v

Export to POF

Albuquerque Public Schools 011072018

Qverall Teacher Performance. Single SBAC Target

Assessment with SBAC

1 Ela - Reading - 09

District Delta

Teacher Name School Name District Teacher Average % School Teacher Average % Teacher Average %

wackson, Kathy Wilson Middle School 100 100 100

Teacher Assessment Results Screen, Reports Tab
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« Individual Teacher Performance — Select the School, Teacher, and

Precision.

271

Charts Grd Reports

Report Type

Individual Teacher Performance v

School

Career Enrichment Center v

Precision

Whole v

Export to PDF

Career Enrichment Center

Mary Brown Individual Performance

Grade 9 ELA CCSS

High Medium Low
75.00 to 100.00 50.00 to 74.99 0.00 to 49.99

Title District Average % | School Average % | Teacher Average % | District Delta

Overall Performance 43 54 54 [11]
RL.9-10.2 4 67 67 { 2 |
RL.9-10.5 47 0 0
RL.9-10.10a 44 33 33 B
RL.9-10.10b 44 33 33 B

Teacher

All Teachers =

04/04/16

Analysis Band Performance

(8] (8] (8] (8]
w

Teacher Assessment Results Screen, Reports Tab

3. Click Generate to view the report.
4. Click Export to PDF to print the report, if needed.
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Viewing School Assessment Results (District Users Only)

Principals and district users select School Analysis from Navigation on any Assessment Results
screen.

The ability to switch results displays if you have District Level scheduling
==l ability.

o Assessment ltems Data View

School Analysis For Assessment Naugaton = || View Optons +
Cry Me a River Water Cycle Quiz
x
Gry Me.a River Watsr Cysls Quiz | Figh
0228018 750010000
199
Completions
0 Medium
Overall Average 50307460
se0% ]
Low
Ogions = | Wore Infa - oD
o
A M Resuls
Charts | Daia Table
a
School Results =
u »
“ 2 El
EJ L 1
El s 1
= 3 1
as
School Assessment Results Screen
« Standards Data View
Charts Data Table
4.3.D : Science Strand 6 Concept 2 Explain the water cycle and factors that affect climate.
Filter by Schoo a
School Results =
Adams Elementary 8
Grant Elementary 68 20 21
Jefferson Elementary 54
Lincoln Elementary 6 2
Washington Elementary 6
x 3 it 50% o 5 1

School Assessment Results Screen
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The results by school display on the Chart tab.

« Enter a school name to Filter by School.

Hover over a section of the chart to view details.

A

Medium
14 student(s)
26%

—, —

159

Assessment Results Screen

« Theresults displayed on the Data Table tab depend on the on the Data View selection in

View Options. Admin users can view this using the Preferred Score Type.

o Assessment ltems Data View

« Select Show Analysis Bands to shade the results with the analysis band

colors.
« Click an option to export the results to Excel or PDF.

School Analysis For Assessment

Cry Me a River Water Cycle Quiz

Navigation = || View Opfions =

64.28% 61.31%

x
Cry Me a River Water Cycle Quiz High
022802018 e Nraan)
Completions 199
Medium
Overall Average 5000 -74.00
64.03% 105
Options = || Mare Info = 0.00-29.00
96
Add More Results »
Charts Data Table
7 ShowAnalysis Bance
} Column Groupings
Drag a column header here to group by that column
School
school Average 1(MC) 2(MC) 3(MC) 4(MC) 5(MC) 6(MC) 7(MC) 8(MC)
64.28% 61.31%
Adams Elementary 66.67% 67.9% 53.09% 6667% 6667% 6543% 629% 7531% 7531%
Grant Elementary 56.42% 4679% 4679% 4404% 5138% 6147% 633% 6697% 7064%
Jefferson Elementary 62.27% 6481% 6111% 6296% 7037% 5926% 6667% 4815% 64381%
Lincoln Elementary 73.37% 73.91% 6848% T717% 7391% 73.91% B8261% 68.48% 65.48%
Washington Elementary 62.7% 53.12% 50% 67.19% 64.06% 70.31% 70.31% 625% 64.06%

Student Assessment Results, Data Table Tab
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o Standards Data View

Student Assessment Results Screen, Data Table Tab

Edupoint Proprietary and Confidential

School Analysis For Assessment View Options ~
Cry Me a River Water Cycle Quiz
x
Cry Me a River Water Cycle Quiz High
02/28/2018 o
Completions 199
Medium
Overall Average 50.00 - 74.00
64.03%
Options ~ More Info ~ 0.00 - 49.00

Charts
¥ Show Analysis Bands Export To Excel || Export to PDF
} Column Groupings
} Drag 2 column header here to group by that column
“ v

School
School Average 07.6.5 1.1.P0O2 1.2.P02 1.2.P03 4.1.P05 4.3.D 4.
61.59% 59.75%
Adams Elementary 66.67% 75.31% 62.14% 75.31% 75.31% 75.31% 59.88% 65.43%
Grant Elementary 56.42% 66.97% 47.4% 86.97% 86.97% 70.64% 45.41% 61.47%
Jefferson Elementary 62.27% 48.15% 64.81% 48.15% 48.15% 64.81% 62.04% 59.26%
Lincoln Elementary 73.37% 68.48% 73.19% 68.48% 68.48% 68.48% 72.83% 73.91%
Washington Elementary 62.7% 62.5% 60.42% 62.5% 62.5% 64.06% 58.59% 7031%
64.28% 64.28% 61.59% 59.75%
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o SBAC Claimsor SBAC Targets Data View

School Analysis For Assessment

Charts

- Navigation v || View Options +
Assessment with SBAC
x
Assessment with SBAC Advanced (Level 4)
01/30/2018 90.00 - 100.00
Completions. v
Proficient (Level 3)
Overall Average 70,00 - 89.39
33.33% 0

Data Table

Nearing Proficient (Level 2)
Options v || More Info 50.00 - 69.99

Basic (Level 1)
0.00 - 49.99
1

% Show Analysis Bands Export ToExcel | Esxport to PDF

| Column Groupings
! Drag @ column header here to greup by that column

School

Averages

Wilson Middle School

Averages

School 1 Ela - Reading - 1Ela - Reading - 1 Ela - Reading -
Average 09 10 12
33.33% 100% 0% 0%
hid
33.33% 100% 0% 0%
33.33% 100% 0% 0%

Student Assessment Results Screen, Data Table Tab
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Test History Analysis

Viewing Test History on the Assessment Grid

1. Select Assessments (Create & Schedule Assessments) from the Assessments menu.

2. Selectthe Test History tab.

is | Tost History

11020 of 118
Assasament Detalls

o

AP NONAUR SUB
Bank: None
Subject: No Subject

pseny - SAT Il MATH2
2

SAT I MATHZ
Bank: Hong
Subject: N Sutyect

Ocsers = AP ENG LANG CM

=)

Subject: No Subpect

Tant Histony 10 7731845210 Arotbaieci st T2

Tost History 1D: rsessccstarn-sissazsiconetztaie

Assessment Screen, Test History Tab

3. Selectan Option.

« Test History Details displays the details of the Parts as well as the Dates of

Administration.

« Click Return to Assessments to return to the list of assessments

« Click View test history analysis to open the Student Assessment Results screen.

MA3001 A test history item

Creator Test History

Test History ID 07d3e6255e40

Otherfreview

Item Count: 4

Adminisiration Instances

8/10/2007 7M0/2016

Student Count: 12 Student Count: 1

799b83d1-795d-43¢1-b370-

Create Date 250112018

Description
MA3D

Sections
Introduction Deductive Reasoning Relationships Btwn Lines
Item Count: 12 Item Count: 5 Item Count: &
Triangles/congruence Triangles/segments Transformations

Item Count: 7 Item Count: 4 Item Count: 3

10/10/20230

Student Count: 7

Test History Details
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« Test History Analysis displays the data with charts and a breakdown of student testing
data.

« The Charts tab displays the parts of the test based on the applied Analysis Band

« The Data Table tab displays both the Score and Scaled Score of each part of the test.
You can export the Data Table to Excel or PDF.

Charts Data Table

® Show Analysis Bands

! Column Groupings
! Drag a column header here to group by that column

4

Deductive Relationships
Combined i D i i i ip« Btwn Lines Triangles/co
Student District ID  Score overall % Admin Date Introduction (Scaled %) Reasoning (Scaled %) BtwnLines (Scaled %) Triangles/col (Scaled %)

Averages 26% 62% 517 46.97T% 3n T4.44% 29 58.89% 35 50%

Archer, Annie 915423 25 6324 1/10/2007 2 1818 4 80.0 3 60.0 3 42.86
Bagby, Kathy 901299 26 66.68 14102007 2 1818 3 60.0 3 60.0 2 2857
Beeson, Timothy 904528 25 625 1/10/2007 3 2727 4 80.0 i 60.0 2 28.57
Cleveland, Heather 974746 25 63.356 1/10/2007 3 2727 4 80.0 3 60.0 3 42.86

Test History Analysis Screen, Data Table Tab

Pushing Assessments to Test History (District Users Only)

1. Select Dashboard (Authorize Students & View Results) from the Assessments menu.
2. Select Schedule Details from Options.
3. Click Push to Test History to start the process of pushing data to Synergy Test History.

_ @ Starting Process I

In 4] Se .
PrOress & @ y This job has been added to the process ﬁ
queue, and will complete even if you
navigate away.

Return

‘iew assessment details

Push to Test History

Assessment Schedule Screen
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Connecting to Test History

1. Login as an administrator.

2. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Assessment ~ RTl ~ Admin -

tem Bank (Create & Edit ltems) [

Dashboard {Authorize Students & View Resultz)

Assezsments (Create & Scheduls Azzsssments)
Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

= ik

Assessment Menu

3. Select Schedule Details from Navigation.
4. Select Test History Connect.

Schedule Assessment f [ i coR, e

Instance Settings

Attributes

Various settings and properties for this scheduled instance
Grade Book

Schedule Name o
Grade 3 Science Diagnostic Details

Scoring

Schedule Assessment Screen

5. Click Create to create a new Test History Entry or use the search field to Use Existing Test
History.

« If connecting to an Existing Test History entry, the number of Test Parts must match the
number from Section Count. Use the Score Types selection to determine how the
assessment data connects to the score types used for the selected entry.

6. Click Preview Data to view which data will be pushed into Test History.

E Select the headers of the Data Table to sort the data as needed.

Select 5 to export into an Excel document.
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7. Click Connect to update the selected Test History entry with the Assessment Data.

E This job runs on the Process Server.

Student Score Count Section Count
Use Existing Test History @ Auto-Create New €@
Test Name Scan Sheet Number
Test Parts Score Types @ Raw  Srale
CHEM 0o @
Raw Score ®
Preview Data
B
District ID Student... T | StateID Location Grade Part Name
146772 Abeyts, Tina | 0011404774 | Grant Elem... Grade CHEM B
992705 Acuna, An... 0000738795  Adams Ele.. Grade CHEM 5
295082 Acuna, Mary | 0000758246 | Jefferson El.. Grade 04 | CHEM 14
876950 Adams, Ire... | 0001126378  Washingto.. Grade CHEM 12
876942 Adams, Ke.. 0001113240  Washingto.. Grade CHEM 10
151517 Aguirre, Be.. 0011673279 Grade CHEM 7
101786 Aguirre, Ka... 0000730051  Adams Ele... Grade CHEM 1n
977132 Ahill, Kelly | 0000748077 | Grant Elem... Grade CHEM 12

Test History Connect Screen
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Viewing Test Group Analysis

Staff without TeacherVUE access Test Group Analysis by navigating to Synergy SIS > Test
History > Setup > Test Group Analysis.

v Test Group Analysis

Menu - < Q » = + Save || * Undo X Delete

Test Group Analysis
Name Group Order Show In TVUE Show In PVUE'SVUE
Technology Enhanced Iten 5l =]

@  Test Analysis Group Parts +4dd | W Hide Detail |
Part Tests

Technology

1 Enhanced Narme High Score Type Order Show Performance Level in PVUE/SVUE
ems

ey Technology Enhanced Iten - =]

@ Part Tests + sdd

e
“- Technology Enhanced Items Assessment

Test Group Analysis

« Teachers access the data by selecting Test Group Analysis or Test Group Analysis 2 on the
Home menuin TeacherVUE.

TeacherVUE

AL Period 1 Prin Eng Il (S2) ~

Test Group Ana|ysis Print | Retum to Seating Chart

Technology Enhanced ltems Assessment
Student Name Date
Perf Lvl Assessment Raw Score Assessment Scale Score
Abbott, Billy C. 12/05/2017 4 40

Arambula, Pamela A

Test Group Analysis Screen

Technology Enhanced Items m
Assessment

Technology Enhanced ltems
Assessment

Most recent import: 2017

Student Breakdown

Test Group Analysis 2 Screen

See the Synergy SIS — TeacherVUE User Guide for more
information about the Test Group Analysis and Test Group Analysis
2 screens.
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Viewing Test History (District Users Only)

281

1. Select Assessments (Create & Schedule Assessments) from the Assessment menu or
navigate to Synergy SIS > Assessment > Assessments.

Asseszment ~ RTI -~ Admin -

tem Bank (Create & Edit ltems)

Dashboard (Authorize Students & View Resulis)
Assezsments (Create & Scheduls Azzessments)

Bank Management {Create & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

o jE

Assessment Menu

2. Selectthe Test History tab.

©_ Identifies assessments imported from Synergy Test History.

Aszessments Test History ¥ Settings Row ¥ | Assessment ¥ m

WRTA12

WRTA
Created By: District

Mo Date Limits
Mo Time Limits

Options =

Assessments Screen, Test History Tab
3. Click a sort option, if needed.

« Sort by ID — Select to sort the assessments by the Assessment ID number in
ascending or descending order.

« Sort by Name — Select to sort the assessments by Name alphabetically in ascending
or descending order.

When sorting by ascending, assessments with numerical numbers
or spaces prior to the name of the assessment display first.
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4. Select Test History Details from Options to view additional information about the test.

. . “iew test history analysis
1234 - CTE Test A test history item T
Creator Test History
Test History ID 6b6faSdf-7893-46da-b571-975111bdSdEa
Create Date &/3/2018
Description
CTE Test Test
Sections

CTE Test Part

Administration Instances

512018
Student Count: 1

Test History Details

5. Select Test History Analysis from Options or click View test history analysis on the Test
History Details screen to view the Student Analysis for the test.

Student Analysis For Navigation = || View Options =

1234 - CTE Test

1234 - OTE Test High
A test history item  75.00 - 100.00
Completions
1 Medium
Overall Average  5090-7200
100.00%

Low
0.00-45.00

Charts Data Table

CTE Test Part

Test History Analysis Screen
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Using the Analysis Dashboard

The Analysis Dashboard enables district administrators and principals to view Assessment results
by assessment and school. The Analysis Dashboard uses dynamic filters to define the analysis
parameters. The data can be viewed in bar or pie charts or be filtered by gender or ethnicity.

« Select Analysis Dashboard from the Admin menu or navigate to Synergy SIS >
Assessments > Assessment Dashboard.

¥ Change View ~ Mark Distribution Analysis RGELEETELS Reset £ Options +

Al Mark Analysis for Entire School - Qd + o o e || ‘ N

You can filter your view in the menu above.

Analysis Dashboard 3 l4 l 5 & s Lock Close Support Help

»

Analysis Dashboard Screen

The Analysis Dashboard screen displays the Mark Distribution Data
by default.

o Select Assessment Results from Change View. O The Assessment Results screen
displays the scores and the number of students that received those scores on assessments
created by the school or district.

Analysis Dashboard @ Se: Lock Close Support Help

£} Change View » Assessment Results Analysis PELEUETe ELE Reset £¥ Options

L L]

all Assessment Resulls ina |,_‘ '3

To begin, make your selections from the menu above

Analysis Dashboard Screen
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See the Synergy SIS — Grade Book Administrator Guide for
information on:

« Mark Distribution — Displays the overall grades and the

number of students that received that mark. Normally used
with section-based grading in secondary schools. Elementary

schools normally use Report Card Iltem Analysis.

285

\.

« Test History — Displays the scores and number of students
that received those scores on tests imported to Grade Book.

J

« Use the dynamicfilter to select the focus of the chart and limit the data displayed on the

dashboard. 9

[\,
Additional filters display as selections are made.

@ schools:

Al Assessment Results @
| Choose an Assessment
@) Assessments:

Narrow the chart scope and filter the assessment list:

ect School v

Select Assessment v

Analysis Dashboard Screen

Analysis Dashboard

@ Search Lock Close Support Help

£ Change View =

Test History Analysis Reset

£ Options =

al AMS2013 ~

15

You can filter your selection in the menu above.

bs

Ml &

Reading Writing Math

Qverall

Analysis Dashboard Screen

o Click Add New Chart to add additional charts to the bottom of the screen. Select different

filters to perform a comparison. ©
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« Click Reset to remove all filters and selections. @

« Click Options to: (5)

« Change the Chart Display
o Select the Panel Size
o Select Chart Colors

Add New Chart Reset ﬁ'@j}linns'.v

Chart Display Panel Size Chart Colors
h‘j Stacked Bar |:| Larger View #eeeedd
5 | Bar Smaller View -
W Fie

Analysis Dashboard Screen

« Selectthe type of chart. (6]

2l @ 2

Analysis Dashboard Screen

« Full Stacked Bar Chart #:«
« Bar Graph (ol

« Pie Chart &

» Gender Breakout

« Ethnicity Breakout .

« OpenaCopy —A copy of the chart opens below the copied chart
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« View Data Grid — A data grid opens below the chart. You can filter, group, and
export the information.

Gender Breakout

Export To Excel || Exportto PDF

| Drag 2 eslumn headr here to group by that eslumn

—— — p e —_ = = =
e manper e bt o0y W e .
N R per s W o o
e Renper s . it .
e R per 18 W e .
e Remper s . Wit .
Ne Foenper e . e 5
N Reéinper w7 r e B
e R per e v wivs v
N Reémper w7 r e c
v Remper e W wits B
C15]

Analysis Dashboard, Data Grid

You can select more than one of the icons to display additional information. For example,

select E] and to see a breakdown by All Marks, marks selected by Males, and marks
selected by Females.

P e———re ,:;. @ 3
You con fier yourview n the men abov.
A5 oc oo
o0
)
p
550
sw
)
A1vats e [
Gender Breakout

Analysis Dashboard
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Admin Reports

Further analysis can be done using SQL statements and Admin Reports. An unlimited number of
Admin Reports may be created.

See the Synergy SIS — Grade Book Administrator Guide for information
L] . :
on creating Admin Reports.

Some sample SQL statements for assessments are shown below.

Assessment Student/Standard Results

select stu.LASTNAME+', ' +stu.FIRSTNAME StudentName

, subj.SUBJECT

,st.CODE+' - '"+st.STANDARD Standard

, L. TESTNAME

,'"DOK ' 4+ CONVERT (VARCHAR, ib.DEPTHOFKNOWLEDGE) DOK

,convert (datetime, convert (varchar (11) ,min (r.RESPONSEDATE) ) )
TestDate

,convert (decimal (6,1), SUM(case when r.CORRECT=1 then 1.0
else 0.0 end) / COUNT (r.ID)*100.0,1) 'P-Value'

from EGB TEST ITEMBANK ib

join EGB TEST QUESTIONS g on q.ITEMBANKID = ib.id
join EGB TEST t on t.ID = g.TESTID
join EGB TEST SCHEDULED sch on sch.TESTID = t.id

join EGB_TEST STUDENTRESPONSES r on r.SCHEDULEDTESTID =
sch.ID
join EGB TEST ITEMSTANDARDS ist on ist.ITEMBANKID = ib.ID
join EGB_STANDARDS NEW st on st.ID = ist.STANDARDID
join EGB_SUBJECTS subj on subj.ID = st.SUBJECTID
join EGB_PEOPLE stu on stu.ID = r.STUDENTID
group by stu.LASTNAME+', ' +stu.FIRSTNAME
,subj.SUBJECT
,Sst.CODE+'"' - '+st.STANDARD
, L. TESTNAME
,"DOK ' + CONVERT (VARCHAR, ib.DEPTHOFKNOWLEDGE)

order by stu.LASTNAME+', ' +stu.FIRSTNAME
, subj .SUBJECT
,St.CODE+' - '+st.STANDARD
,min (r.RESPONSEDATE)
, t . TESTNAME
,'DOK ' + CONVERT (VARCHAR, ib.DEPTHOFKNOWLEDGE)
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SELECT RO.[LAST NAME],
RO. [FIRST NAME]
]

R1.[SIS_NUMBER],

R3.
R4.

[ADMIN DATE],
[PERFORMANCE LEVEL],
R5. [PART DESCRIPTION],
[
[

RS. [NAME],
R9. [TEST SCORE],
R11.[

FROM [EPC_STU] R1

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

ON

LEFT OUTER JOIN

INNER JOIN [REV_

ON

Assessment User Guide
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t.TEST NAME,

SCORE_DESCRIPTION],

t.TEST LEVEL
;L. TEST FORM

REV_PERSON_PHOTO] R2

R1.
EPC_

R1

EPC_
R3.
EPC_
R4.
EPC_

[

(

[

(

[

(

[

(

[

( RO
[EPC
( R1
[

(

[

(

[

(

[

(

[

EPC_

R4

EPC_

R5
EPC
R6.
EPC
R7

EPC
( RL.

PERS

STUDENT GU = R2.PERSON GU )

STU_TEST] R3

.STUDENT GU = R3.STUDENT GU )

STU_TEST_ PART] R4

STUDENT TEST GU = R4.STUDENT TEST GU )
STU_TEST_ PART SCORE] R9

STU_TEST PART GU = R9.STU TEST_ PART GU )
TEST SCORE_TYPE] R10

.TEST_SCORE_TYPE GU = R10.TEST SCORE_TYPE GU )
_TEST DEF_SCORE] R11

0.TEST DEF SCORE GU = R11.TEST DEF_SCORE_GU )
TEST PART] R5

.TEST_PART GU = R5.TEST_PART GU )

TEST GROUP_PART TEST] R6

.TEST_PART GU = R6.TEST_PART GU )

TEST GROUP_PART] R7

TEST GROUP_PART GU = R7.TEST GROUP_PART GU )
TEST GROUP] RS

.TEST GROUP_GU = R8.TEST GROUP GU )
STU_SCH_YR] R12

STUDENT GU = R12.STUDENT GU )

ON] RO

ON ( R1.STUDENT GU = RO.PERSON GU )
join EPC_TEST t on t.TEST GU = r3.TEST GU

WHERE ( (( R12.[ORGANIZATION YEAR GU] IN ( 'OODCA4BC-75D8-4118-B47E-
4EQ0C66283FB9"' ) ))
AND (( R12.[STATUS] IS NULL )) )

-- and  R3.TEST GU='4A10DFE3-CFD5-446C-A73A-CDD73142E8CB'
ORDER BY RO.[LAST NAME] ASC,

RO. [FIRST NAME] ASC,

RO. [MIDDLE NAME] ASC,

R1.[SIS_NUMBER] ASC,

R3. [ADMIN DATE]

t.TEST NAME,
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Assessment ltem Analysis

select g.GRADE

,S.SUBJECT

, st .CODE

, st.STANDARD

, COUNT (distinct ib.ID) as 'Item Count'

, COUNT (distinct g.ID) as 'Item on Test Count'

, SUM (case when r.CORRECT=1 then 1 else 0 end) 'Number
Correct'

,COUNT (r.ID) 'Count Items Tested'

,convert (decimal (6,1), SUM(case when r.CORRECT=1 then 1.0
else 0.0 end) / COUNT(r.ID)*100.0,1) 'P-Value'

from EGB TEST ITEMBANK ib

join EGB_TEST QUESTIONS g on q.ITEMBANKID = ib.id
join EGB _TEST t on t.ID = g.TESTID
join EGB_TEST SCHEDULED sch on sch.TESTID = t.id

join EGB_TEST STUDENTRESPONSES r on r.SCHEDULEDTESTID =
sch.ID

join EGB GRADE g on g.ID = ib.GRADEID

join EGB_SUBJECTS s on s.ID = ib.SUBJECTID

join EGB_TEST ITEMSTANDARDS ist on ist.ITEMBANKID = ib.ID

join EGB_STANDARDS NEW st on st.ID = ist.STANDARDID
group by g.GRADE

;S .SUBJECT

, St .CODE

, st .STANDARD
order by g.GRADE

;S .SUBJECT

, St .CODE

, st .STANDARD
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Assessment ltem Analysis by Iltem
select g.GRADE

,S.SUBJECT

,convert (varchar (8000) ,1b.QUESTION) Question

, 1b.DEPTHOFKNOWLEDGE dok

, st.CODE

, st.STANDARD

,COUNT (distinct ib.ID) as 'Item Count'

, COUNT (distinct g.ID) as 'Item on Test Count'

, SUM (case when r.CORRECT=1 then 1 else 0 end) 'Number Correct'

,COUNT (r.ID) 'Count Items Tested'

,convert (decimal (6,1), SUM(case when r.CORRECT=1 then 1.0 else
0.0 end) / COUNT(r.ID)*100.0,1) 'P-Value'
from EGB_TEST_ITEMBANK ib

join EGB_TEST_QUESTIONS q on gq.ITEMBANKID = ib.id

join EGB_TEST t on t.ID = g.TESTID

join EGB_TEST SCHEDULED sch on sch.TESTID = t.id

join EGB_TEST_STUDENTRESPONSES r on r.SCHEDULEDTESTID = sch.ID

join EGB_GRADE g on g.ID = ib.GRADEID

join EGB_SUBJECTS s on s.ID = ib.SUBJECTID

join EGB_TEST_ITEMSTANDARDS ist on ist.ITEMBANKID = ib.ID

join EGB_STANDARDS_NEW st on st.ID = ist.STANDARDID
group by g.GRADE

,S.SUBJECT

, st .CODE

order by g.GRADE

, st.STANDARD
,convert (varchar (8000) , ib.QUESTION)
,1b.DEPTHOFKNOWLEDGE

,S.SUBJECT
, st .CODE
, st.STANDARD

Copyright 2015-2019 Edupoint Educational Systems, LLC



Assessment User Guide

292 Chapter 8: Analysis Tools

Assessment Class Standards/Tests

select C.CLASSNAME
, subj.SUBJECT

, st .CODE+' '+st.STANDARD Standard
, L. TESTNAME
,'"DOK ' + CONVERT (VARCHAR, ib.DEPTHOFKNOWLEDGE) DOK

,convert (datetime, convert (varchar (11) ,min (r.RESPONSEDATE) ) )
TestDate
,convert (decimal (6,1), SUM(case when r.CORRECT=1 then 1.0
COUNT (r.ID)*100.0,1) 'P-Value'

else 0.0 end) /

from EGB TEST ITEMBANK ib

join EGB _TEST QUESTIONS g on g.ITEMBANKID = ib.id
join EGB TEST t on t.ID = g.TESTID
join EGB_TEST SCHEDULED sch on sch.TESTID = t.id
join EGB _TEST STUDENTRESPONSES r on r.SCHEDULEDTESTID =
sch.ID
join EGB TEST ITEMSTANDARDS ist on ist.ITEMBANKID = ib.ID
join EGB _STANDARDS NEW st on st.ID = ist.STANDARDID
join EGB_SUBJECTS subj on subj.ID = st.SUBJECTID
join EGB_ENROLLMENT E ON E.STUDENTID = R.STUDENTID
join EGB CLASS ¢ on c¢.ID = E.CLASSID
WHERE C.CLASSGUID IS NOT NULL
group by C.CLASSNAME
, subj.SUBJECT
,St.CODE+' - '+4+st.STANDARD
, L. TESTNAME
, 'DOK ' + CONVERT (VARCHAR, ib.DEPTHOFKNOWLEDGE)

order by C.CLASSNAME
, subj
,st.C
,min (
,L.TE
, 'DOK

. SUBJECT
ODE+' '+st.STANDARD
r .RESPONSEDATE)
STNAME
' + CONVERT (VARCHAR, ib.DEPTHOFKNOWLEDGE)

Edupoint Proprietary and Confidential



Assessment User Guide

Chapter 8: Analysis Tools 293

Assessment Statistics by Test and Teacher

select t.TESTNAME

, L. TESTDESCRIPTION

, st.CODE

, st.STANDARD

,COUNT (distinct ib.ID) as 'Item Count'

, COUNT (distinct g.ID) as 'Item on Test Count'

, SUM (case when r.CORRECT=1 then 1 else 0 end) 'Number Correct'

, COUNT (r.ID) 'Count Items Tested'

,convert (decimal (6,1), SUM(case when r.CORRECT=1 then 1.0 else
0.0 end) / COUNT(r.ID)*100.0,1) 'P-Value'

from EGB_TEST ITEMBANK ib
join EGB_TEST QUESTIONS g on g.ITEMBANKID
join EGB TEST t on t.ID = gq.TESTID
join EGB_TEST SCHEDULED sch on sch.TESTID = t.id
join EGB_TEST STUDENTRESPONSES r on r.SCHEDULEDTESTID
join EGB_GRADE g on g.ID = ib.GRADEID
join EGB_SUBJECTS s on s.ID = ib.SUBJECTID
join EGB_TEST ITEMSTANDARDS ist on ist.ITEMBANKID = ib.ID
join EGB_STANDARDS NEW st on st.ID = ist.STANDARDID
where t.TEACHERID=@teacherid
group by t.TESTNAME
, L. TESTDESCRIPTION
, st .CODE
, st.STANDARD

ib.id

sch.ID

order by t.TESTNAME
, L. TESTDESCRIPTION
, st .CODE
, st.STANDARD

Copyright 2015-2019 Edupoint Educational Systems, LLC
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Item Bank Summary

select g.GRADE
, S.SUBJECT
, st .CODE
, st .STANDARD
, COUNT (distinct ib.ID)+15 as 'Item Count'
from EGB _TEST ITEMBANK ib
join EGB _GRADE g on g.ID = ib.GRADEID
join EGB_SUBJECTS s on s.ID = ib.SUBJECTID
join EGB_TEST ITEMSTANDARDS ist on ist.ITEMBANKID = ib.ID
join EGB_STANDARDS NEW st on st.ID = ist.STANDARDID
group by g.GRADE, s.SUBJECT
, st .CODE
, st .STANDARD
order by g.GRADE, s.SUBJECT
, st .CODE
, st .STANDARD

Ethnicity / Standards Test Breakdown

select G.GRADE

,ETH.ETHNICITY

, st .CODE

, st.STANDARD

, COUNT (distinct ib.ID) as 'Item Count'

, COUNT (distinct g.ID) as 'Item on Test Count'

, SUM (case when r.CORRECT=1 then 1 else 0 end) 'Number Correct'

,COUNT (r.ID) 'Count Items Tested'

,convert (decimal (6,1), SUM(case when r.CORRECT=1 then 1.0 else 0.0 end)
/ COUNT (r.ID)*100.0,1) 'P-Value'

from EGB TEST ITEMBANK ib
join EGB_TEST QUESTIONS g on q.ITEMBANKID = ib.id
join EGB TEST t on t.ID = g.TESTID
join EGB_TEST SCHEDULED sch on sch.TESTID t.id
join EGB_TEST STUDENTRESPONSES r on r.SCHEDULEDTESTID = sch.ID
join EGB _GRADE g on g.ID = ib.GRADEID
join EGB_SUBJECTS s on s.ID = ib.SUBJECTID
join EGB_TEST ITEMSTANDARDS ist on ist.ITEMBANKID = ib.ID
join EGB_STANDARDS NEW st on st.ID = ist.STANDARDID
JOIN EGB_PEOPLE STU ON STU.ID = R.STUDENTID
JOIN EGB_ETHNICITIES ETH ON ETH.ID = STU.ETHNICITYID
where t.TEACHERID=26
group by G.GRADE
, st .CODE
, st .STANDARD
,ETH.ETHNICITY
order by st.CODE
, st .STANDARD
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Assessment Reports Overview

1. Select Dashboard (Authorize Students and View Results) from the Assessment menu or
navigate to Synergy SIS > Assessments > Assessment Dashboard.

Azzezement -~ RTlI -~ Admin -

Item Bank (Create & Edit ltiems)

Daszshboard (Authorize Students & View Resultz)

Assezsments (Create & Scheduls Azssssments)

Bank Management {Creats & Edit Banks)
Constructed Response Grading

Passages (Create & Edit Passages)

Erms omeibomm

Assessment Menu

2. Click an assessment name or select Results Analysis from Options.
3. Click Reports to open the Report Viewer.

A (YR) Carcll, N 3/4 Grade(1) SEC:0102 (Mann, 0.}/ 2nd Qtr + | [:] |
Student Analys:ls For Navigaton ~  View Options +
Conserving Resources

Conserving Resources High
03/29/2019 7500 10000
Completions <
Medium
Overall Average 50.00 - 74.00
81.82 0
Low

Student Assessment Results Screen
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4. Select areport option to exportin PDF or Excel.

E Creating PDFs or Excel output runs on the Process Server.

Report Viewer

s @ ) -_g £ & 2 0= -]

';“ - . e - 3 e -
= = E
J.j JJI JJ - I.” .JJI Hl J,} JJ ] .J.J
= _J_I —— e | . | . ] B — -
District Results (ASMT?[H) District Results Dy School District Results Dy Teacher Teacher Overall Performance

(ASMT702) (ASMT703) by School (ASMT704)
PDF  Excel

CITTL

District Summary by ltem Type District Summary by ltem Type District Summary by ltem Type

(ASMT708) (ASMTT08 Atl1) (ASMTT03 AltZ)
Close
Report Viewer Window
CODE | NAME | DESCRIPTION | USER | STANDARDS | PERFORMANCE | ITEMS
ASMT201 | StudentAssessment = Proficiency breakdownof = Teacher 4 v
Results student performance
standard by standard
ASMT401 Class Assessment Analysis by Gender and Teacher v 4
Results Ethnicity, Individual
Student Standards
Performance, Class Level
Standards Performance
ASMT402 | ClassBand Student performance Teacher v
Breakdown breakdown by Analysis
Bands
ASMT403 Class Summary by Analysis of item Types Teacher 4 v
ltem Type assessed, and
performance detail by
student
ASMT404 | Performance Level Analysis of performance Teacher v
Distribution comparing District,
School, and Teacher
ASMT406 Teacher ltem Standards average score = Teacher 4
Standard Analysis comparing teacher
averages to the district
ASMT407 @ Teacher Standards Analysis of Standards by Teacher 4 v
Analysis District, School, and
Teacher
ASMT407 Teacher Standard Additional graphic analysis = Teacher v v
Alt Analysis of standards by District,

School, and Teacher
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CODE m DESCRIPTION m STANDARDS | PERFORMANCE | ITEMS

298

ASMT6E01 = School Results Analysis by Gender and Principal
Ethnicity and overall
standards performance
ASMT602 School Results by Analysis by Gender and Teacher v v
Class Ethnicity and Class level
Standards comparison to
district
ASMT603 = School Results by Analysis by Gender and Principal v v
Teacher Ethnicity and Teacher

level Standards
comparison to district

ASMT604 Teacher Overall Comparison of Teacher, Principal v
Performance School and District
Averages
ASMT605 | Site Assessment Standards performance Principal v v
Standards at school level
ASMT606 School Summary by Analysis of item types at Principal 4 v
Iltem Type the teacher level
ASMT701 ' District Results Analysis by Gender and District v v
Ethnicity and overall
standards performance
ASMT702 District Results by Analysis by Gender and District v v
School Ethnicity and Standards
comparison by schools
ASMT703 ' District Results by Analysis by Gender and District v v
Teacher Ethnicity and Teacher
level Standards
comparison
ASMT704 Teacher Overall Comparison of Teacher, District v
Performance by School and District
School Averages
ASMT705 | Student Overall Student performance Teacher v
Performance by compared to Class
Class Averages
ASMT707 Blueprint Analysis of DOK, Items, Al v v
and Standards to be
assessed
ASMT708 ' District Summary by Analysis of tem Types District v v
ltem Type assessed and
performance detail by
Student per School
ASMT708 District Summary by Analysis of Item Types District v v
Alt1 ltem Type assessed and
performance detail by
Teacher per school
ASMT708 | District Summary by Analysis of Item Types District v v
Alt2 ltem Type assessed and
performance detail by
School

Edupoint Proprietary and Confidential
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Proficiency breakdown of student performance standard by standard

Adams Elementary
Student Assessment Result
Carroll, N 3/4 Grade(1)

Student Name:
Aaron Bustamante

Test Name
Week 3 Math Quiz

Overall, Aaron performed at a Proficient proficiency level.

Low Medium High
0% 5% 10% 16% 20% 25% 30% 35% 40% 45% 50% 55% 60% 65%

Below are standards that Aaron was Proficient

Standard

Report: ASMT201
Analysis Band Test Date
my band 1 914/2018
D%  75% 80% 85% 90%  95% 100%

86%

# Correct % Correct

Make estimates appropriate to a given situation or computation with whole numbers

22 100%

Standard

Below are standards that Aaron was Non-Proficient

# Correct % Correct

and answer i by

Fi ing and analyzing displays of data, including frequency tables,
single bar graphs, or single line graphs.

23 67%

0312/2019 10:11 AM Edupoint School District

Page 1 of 20

ASMT201 Output (page 1)
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Adams Elementary

Student Assessment Result
Carroll, N 3/4 Grade(1)

Student Name Test Name ‘Analysis Band
Alan Johnson Week 3 Math Quiz my band 1
Overall, Alan performed at a Not Proficient proficiency level.
Low Medium High
0% 5% 10% 15% 20% 25% 30% 35% 40% 45% 50% 55% 60% 65% 70% 75% 80%  85%

A
43%

Report: ASMT201

Test Date
9/14/2018

90% 95% 100%

Below are standards that Alan was Non-Proficient

Standard # Correct % Correct
Formulate and answer questions by interpreting and analyzing displays of data, including frequency tables, e
single bar graphs, or single line graphs

03/12/2019 10:11 AM Edupoint School District

Page 2 of 20

ASMT201 Output (page 2)
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ASMT401 - Class Assessment Results

Analysis by Gender and Ethnicity, Individual Student Standards Performance, Class Level
Standards Performance

Year: 2018 - 2019
Adams Elementary Report: ASHIT401
Class Assessment Results

Class Assessment Analysis Band Date
Carroll, N 3/4 Grade(1) - 0102 Week 3 Math Quiz my band 1 07/03/2018 - 07/26/2019
58.44%
Low Medium High Average
0% - 49% 50% - 74% 75% - 100%
7 6
Students Per Analysis Band
Gender / Analysis Bands Ethnicity / Analysis Bands
M F [ American Indian or Alaska Native [ Asian [ Hispanic

- Mative Hawaiian or Other Pacific Islander [ White

Low Low

Medium High
03122019 10:11 AM Edupoint School District Page 10f3

w

™

-

. :

Medium High

=

ASMT401 Output (page 1)
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Year: 2018 - 2019
Adams Elementary Remort. ASNT401
Class Assessment Results

Class Assessment Analysis Band Date
Carroll, N 3/4 Grade(1} - 0102 Week 3 Math Quiz my band 1 07/03/2018 - 07/26/2019
Student I3 | scod 03msic3i] osmszciz
Aaron, lzn 1120442 | 7143% 100.00%
Alsjandrez, Wille |982706 | 2857% 50.00%
|Baker. Carlos 151640 | 57 14% 50.00%
'Bustamante, Aaron 130333 | asTi% 100.00% 86.67%
Cervantes Vazque, Howard | 115224 | 42.86% 86.67%
|Covington, Louis 133538 | 1479%
[Flores Aldaba, Wanda 154975 | asTi% 50.00%.
Jahnsen, Alan 158343 | 4286%
Jolley, Wayne 131024 | T143% 100 00%
[Lowe, Ralph 153981 | 7143% 100.00%
Mancera Hemera, Kathyn | 156774 | 42.86% 50.00%.
Sabys, Gennifer [a7a12 | ss7im 100.00% 56.67%
valle, Jane 152330 | 7143% 100.00%
Vanetten, Shirley 129844 | 1429%
Vega Gonzalez, Justin 143218 | 8571% 100.00% 100.00%
Vela, Bonnie 126323 | 4286% 100.00%
Villanueva, Evelyn 120361 | 100.00% 100.00% 100.00%
Walker, Jean 1150747 | 100.00% 100.00% 100.00%
Wesito, Gerald [1as3r7 | T143% 50.00% 100 00%
\Williams, Eugene 139100 | s57.44% 50.00%.
03122019 10:11 AM Edupaoint School District Page 20f 3
ASMT401 Output (page 2)
Adams Elementary Year: 2018 - 2019

Report: ASMT401
Class Assessment Results "’

Class Assessment Analysis Band Date
Carroll, N 3/4 Grade(1) - 0102 Week 3 Math Quiz my band 1 07/03/2018 - 07/26/2019
Make estimates appropriate to a given situation or computation 800/0
03.M.51.C31 N
with whole numbers.
0% 20% 40% 60% 80% 100%
Formulate and answer questions by interpreting and analyzing 57 41 %
03.M.52.C1.2 displays of data, including frequency tables, single bar graphs, or -
single line graphs.
0% 20% 0% 60% 80% 100%
03122019 10:11 AM Edupoint School District Page 3 of 3
ASMT401 Output (page 3)
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ASMT402 - Class Student Band Breakdown

Student performance breakdown by Analysis Bands

Adams Elementary ;‘;:;If'ﬁﬁ%g
Class Student Band Breakdown )
Class Assessment Analysis Band Date
Carroll, N 3/4 Grade(1) - 0102 Week 3 Math Quiz my band 1 07/03/2018 - 07i26i2019
0
58.44%
Low Medium High Average
0% - 49% 50% - 74% 75% - 100%
Medium
STUDENT STUDENT ID SCORE

Alejandrez, Willie 630 28.57% Aaron, lan 629 71.43%
Bahena, Joshua 632 14.29% Baker, Carlos 633 57.14%
Cervantes Vazque, Howard 636 42.86% Jolley, Wayne 646 71.43%
Chavez, Carl 638 28.57% Lowe, Ralph 647 71.43%
Covington, Louis 639 14.29% Valle, Jane 649 71.43%
Johnsen, Alan 645 42.86% Werito, Gerald 655 71.43%
Mancera Herrera, Kathryn 648 42 8B6% Williams, Eugene 656 57 14%
Vanetten, Shirley 650 14.29%
Vela, Bonnie 652 42 86%
03112/2019 10-11 AWM Edupoint School District Page 10f2

ASMT402 Output (page 1)
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Adams Elementary ;z:;f“;gﬁg;g
Class Student Band Breakdown )
Class Assessment Analysis Band Date
Carroll, N 3/4 Grade(1) - 0102 Week 3 Math Quiz my band 1 07/03/2018 - 07i26/2019
High

STUDENT STUDENT ID SCORE

Sabye, Gennifer 634 B85.71%

Bustamante, Aaron 635 85.71%

Flores Aldaba, Wanda 642 85.71%

Vega Gonzalez, Justin 651 85.71%

Villanueva, Evelyn 653 100.00%

Walker, Jean 654 100.00%
03/12/2019 10-11 AM Edupoint School District Page 2 0f 2

ASMT402 Output (page 2)
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ASMT403 — Assessment (Class) Summary by Iltem Type

Analysis of item Types assessed, and performance detail by student

Teacher Name
Carroll, Natalie

Low
0% - 49%

Test Name

Assessment Summary by Item Type
Carroll, N 3/4 Grade(1)

Week 3 Math Quiz

Questions by Item Types

Adams Elementary
Year: 2018 - 2019

Report: ASMT403

Analysis Band
my band 1

Medium High
50%- 74% 75% - 100%

Test Result by Item Types

p— 55.90%
" 50%
40%
30%
20%
10%
0%
Multiple Choice
Student D Overall Multiple Choice
Aaron, lan 529 71.43% 71.43%
Alejandrez, Willie 630
Bahena, Joshua 632
Baker, Carlos 633 57.14% 57.14%
Bustamante, Aaron 635 85.71% 85.71%
Cervantes Vazque, Howard |636 |
03/12/2019 10:11 AM Edupaint School District Page 10f2
ASMTA403 Output (page 1)
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Adams Elementary
Assessment Summary by Item Type ol
Carrall, N 3/4 Grade(1)
Teacher Name Test Name Analysis Band
Carroll, Natalie Week 3 Math Quiz my band 1
Student 1D Overall Multiple Choice
Chavez, Carl 638
Covington, Louis '639 |
Flores Aldaba, Wanda l6az | 85.71%
Johnson, Alan .645 | I
Jolley, Wayne 646 | 71.43% 71.43%
Lowe, Ralph 647 | 71.43%) 71.43%
Mancera Herrera, Kathryn .648 | I
Sabye, Gennifer 634 | 85.71%) 85.71%
Valle, Jane l6ag | 71.43% 71.43%
Vanetten, Shirley .GSU | I
Vega Gonzalez, Justin 651 | 85.71% 85.71%
Vela, Bonnie 652 | |
Villanueva, Evelyn (653 | 100.00%] 100.00%
Walker, Jean 1654 | 100.00% 100.00%
Warito, Gerald l655 | 71.43%) 71.43%
Williams, Eugene l656 | 57.14% 57.14%
03/12/2019 10:11 AM Edupoint Scheol District Page 2 of 2
ASMT403 Output (page 2)
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ASMT404 - Performance Level Distribution

Analysis of performance comparing District, School, and Teacher

Sk Adams Elementary
-~ " - - .
T — Performance Level Distribution Year: 2018 - 2018
it Report: ASMT404
Teacher Name Test Mame Analysis Band
McKenna, Travis Grade 3 Science Diagnostic District Grading Policy
District
Performance Band Count  Percent wA
6% 3% B
A 220 25% g [
D
B 118 13% F
c 218 24%
D 57 6% soe
4% Students
F 282 IM%
Number of Students 896
Exam Average 68% a5
12%
Adams Elementary
Performance Band Count  Percent 255 . :
A 59 23% G
D
B 21 8% 8% 3F
c B5 25%
D 16 5% 261
Students
F 100 38%
Humber of Students 261 25%
Exam Average 61% 23%
&%
McKenna, Travis
Performance Band Count  Percent 50% A
! ]
A & 21% [=
%D
B 4 14% F
c 3 11%
D 1 4% 28
' Students
F 14 50% %
Number of Students 28
1%
Exam Average 59% 21%
14%
091472018 2:57 AM Edupoint School District Page 1of 1
ASMT404 Output

Copyright 2015-2019 Edupoint Educational Systems, LLC



Assessment User Guide

308

Chapter 9: Reports

ASMT406 — Item Standards Analysis for Teachers

Standards average score comparing teacher averages to the district

i
L

Damo School

Adams Elementary
Item Standards Analysis for Teachers

Year: 20158 - 2019
Report: ASMT406

Test Name
Grade 3 Science Diagnostic
Result

Standard Yours District

Identify the sources of water within an environment (e.g., ground water, surface water, atmospheric water, glaciers). 7041 TITI%

Describe the distribution of water on the Earth’s surface. o~ )

Identify the sources of water within an environment (e.g., ground water, surface water, atmospheric water, glaciers). 7344% 68.77%

Describe the distribution of water on the Earth’s surface. E °

Identify the sources of water within an environment (e.g., ground water, surface water, atmospheric water, glaciers). 8498%  B5.30%

Describe the distribution of water on the Earth’s surface. - )

Identify the sources of water within an environment (2.g., ground water, surface water, atmospheric water, glaciers). 6094% 48.11%

Describe the distribution of water on the Earth’s surface. ) B

Identify the sources of water within an environment (e.g., ground water, surface water, atmospheric water, glaciers). 84189 T5.20%

Describe the distribution of water on the Earth’s surface. ) -

Differentiate between weather and climate as they relate to the southwestern United States. 5938%  66.25%

Measure changes in weather (e_g_, precipitation, wind speed, barometric pressure). -

Differentiate between weather and climate as they relate to the southwestern United States. 8281%  74.74%

Measure changes in weather (e.g., precipitation, wind speed, barometric pressure). - .

Differentiate between weather and climate as they relate to the southwestern United States. =

- 4531% 5063%

Measure changes in weather (e.g., precipitation, wind speed, barometric pressure).

Differentiate between weather and climate as they relate to the southwestern United States. 78.13%  67.85%

Measure changes in weather (e.g., precipitation, wind speed, barometric pressure). B :

Compare weather conditions in various locafions (e.g., regions of Arizona, various U S. cities, coastal vs. interior

geographical regions). B906% T991%

precipitation

Compare weather conditions in various locafions (e.g., regions of Arizona, various U.S. cities, coastal vs. interior

geographical regions). 89.06% 81.06%

precipitation

Compare weather conditions in various locafions (e.g., regions of Arizona, various U S. cities, coastal vs. interior

geographical regions). 5625% 67.74%

precipitation

Identify the sources of water within an environment (e.g_, ground water, surface water, atmospheric water, glaciers). 7656%  82.09%

Measure changes in weather (e.g., precipitation, wind speed, barometric pressure). 1558 .

Differentiate between weather and climate as they relate to the southwestern United States. 56253  57.06%

Describe the distribution of water on the Earth’s surface. -
00/17/2018 1:20 PM Edupcint School District Page 1of 1

ASMT406 Output
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ASMT407 — Standards Analysis by District, School and Teacher

Analysis of Standards by District, School, and Teacher

I Adams Elementary
\,;( Standards Analysis by District, School and Teacher ;:foéﬂg ;5;?{
Demo, School District

Teacher Name Test Name Analysis Band
Shaw, Katie ‘Grade 3 Science Diagnostic District Grading Policy

Standard District School Teacher Standard Average - Teacher
1 6.3P0O1 7i62 7202 BBET
2 6.3.PO2 6822 67.25 78.00
3 63PO3 64.89 63.68 7520
4 6.3P0O4 7309 70.19 B88.00

District vs School Average School vs Teacher Average

1 2 3 L 1 2 3 4 5 L

09/14/2018 8:02 AM Edupoint School District Page 10of 1
ASMT407 Output
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ASMT407 Alt — Standards Analysis by District, School and Teacher

Additional graphic analysis of standards by District, School, and Teacher

I Adams Elementary
\,.( Standards Analysis by District, School and Teacher ;';ﬂ;i“;g ;%3
Demo School District

Teacher Name Test Name Analysis Band
Shaw, Katie Grade 3 Science Diagnostic District Grading Policy

Standard District School Teacher
1 63PO1 BB.ET
3 83p03 %%
4 6.3.PO4 88.00
s s3P0se

District vs School Average School vs Teacher Average

1 2 3 4 5 & 1 2 3 4 5 &

00/14/2012 9:00 AM Edupoint School District Page 10of 1
ASMT407 Alt Output
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ASMT601 — School Results

Analysis by Gender and Ethnicity and overall standards performance

wr
/*(
Deme School District
Esesliaza b Sducsiion
Assessment
Grade 3 Science Diagnostic

100

Gender / Analysis Bands
Advanced
Proficient
Basic

Below Basic

0,
. . . 61%
Below Basic Basic Proficient Advanced Average
0% - 59.99% 60% - 79.99% 80% - 89.99% 90% - 100%

Year 2018 - 2019

Adams Elementary Roport ASHTE01

School Scheduled Instance

Analysis Band Date
Assessment 0712412018 - 052412019

Students Per Analysis Band
Ethnicity / Analysis Bands

[l American Indian or Alaska Native  [JJi] Asian [ Hispanic [l Native Hawaiian or Other Pacific Islander [ White

Basic Proficient

Below Basic

09/14/2018 4:09 PM

Edupoint School District Page 10f3

ASMT601 Output (page 1)
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Adams Elementa Year: 2018 - 2019
\‘/\"" ry Report: ASMT601
/L( School Scheduled Instance
D-gu-z'sdrﬂ Di‘ﬂril:l
Assessment Analysis Band Date
Grade 3 Science Diagnostic Assessment 07/2412018 - 05/24/201%
63.P01 Identify the sources of water within an environment (e.g., ground
- water, surface water, atmospheric water, glaciers).
0% 20% 40% 60% 80% 100%
6.3.PO2 Describe the distribution of water on the Earth's surface.
0% 20% 40% 60% 80% 100%
63P03 Differentiate between weather and climate as they relate to the 63 5 68 %
- southwestern United States.
0% 20% 40% 60% 80% 100%
63P04 Measure changes in weather (e.g., precipitation, wind speed, 70_ 1 9 %
e barometric pressure).
0% 20% 40% 60% 80% 100%
09/14/2018 409 PM Edupoint School District Page 2013
ASMT601 Output (page 2)
Adams Elementa Year: 2018 - 2019
\j\"‘ ry Report: ASMT601
/nf School Scheduled Instance
Do, Shos! i
Assessment Analysis Band Date
Grade 3 Science Diagnostic Assessment 07/2412018 - 05/24/2019

76.86%

63PO5c precipitation
40% 100%
Compare weather conditions in various locations (e.g., regions of 76 86%
6.3.PO6 Arizona, various U.S. cities, coastal vs. interior geographical .
regions).
40% 100%
09/14/2018 4:09 PM Edupoint School District Page 3073

ASMT601 Output (page 3)
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ASMT602 — School Schedule Instance By Class

Analysis by Gender and Ethnicity and Teacher level Standards comparison to district

Year. 2018 - 2019
Adams Elementary Ronort ASHTE02
School Scheduled Instance
By Class
Assessment Analysis Band Date
Week 3 Math Quiz my band 1 07/03/2018 - 07/26/2019
59.18%
Low Medium High Average
0% - 49% 50% - T4% 73% - 100%
7 6
Students Per Analysis Band
Gender / Analysis Bands Ethnicity / Analysis Bands
I F [ American Indian or Alaska Native  [Jiij Asian [ Hispanic [ Wafive Hawaiian or Other Pacific Islander [0 White
M
High 4
3.5
3
Medium 25
2 -
15
1
Low
" II II I
0 — — I
0 2 4 6 Low Medium High
03122019 10:11 AM Edupoint School Disirict Page 10f3
ASMT602 Output (page 1)
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Year: 2018 - 2019
Report: ASMTE02

Adams Elementary
School Scheduled Instance

By Class
Assessment Analysis Band Date
Week 3 Math Quiz my band 1 07/03/2018 - 07/26/2019
03MS1C31 | 03MS2C12

Class Teacher Class Avg.  Sid % Diff., Sid % .

Carroll, Natalie 50.00% 75.00% -5.00% -24.07%

67.86% 83.33% 333% 58.33% 083%

Carroll, N 3/4 Grade(1) - 1102 | Carroll, Natalie 58.44% 80.00% 000% 57.41% 0.00%
03M2/2019 10:11 AM Edupoint Scheol District Page 2 of3

ASMT602 Output (page 2)

Assessment
Week 3 Math Quiz

Year: 2018 - 2019
Report: ASMTE02

Adams Elementary
School Scheduled Instance
By Class

Analysis Band Date
my band 1 07/03/2018 - 07/26/2019

Make estimates appropriate to a given situation or computation 800/0
03.M.81.C31 .
with whole numbers.
0% 20% 40% 60% 80% 100%
Formulate and answer questions by interpreting and analyzing 57 41 0/
03.M.82.C1.2 displays of data, including frequency tables, single bar graphs, or - o
single line graphs.
0% 20% 40% 80% 80% 100%
03122019 10:11 AM Edupaint School District Page 3of 3

ASMT602 Output (page 3)
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ASMT603 — School Scheduled Instance By Teacher

Analysis by Gender and Ethnicity and Teacher level Standards comparison to district

| Year: 2018 - 2019
- Adams Elementary it
L School Scheduled Instance
Degmo, Schagl Disirict By Teacher
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019
61%
Low Medium High Average
0% - 40% 50% - 74% 7% - 100%
68 112

Students Per Analysis Band
Gender / Analysis Bands Ethnicity / Analysis Bands

mwm [l Amencan Indian or Alaska Natve [ Asian [ Hispanic [l Natve Hawaiian or Other Pacific Istander  [JJ White
| I3

50
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I Adams Elementary ;igrﬂguﬁgag
EJ School Scheduled Instance
Demo School District By Teacher
Assesament Analysis Band Dat=
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019
632P01 | @3Po2z | @3P02 | 63PO4 | 63PCEc | 63FOE
Teacher Teacher Avg] suﬂa| Diﬂ.l Shd%l Dm| sm%| Diﬁ.l Bbd%l mr| sm%| Diﬁ.l sw%| Diff.
Aldrich, Heidi 75.77%| 75.00% 208% 70.83% 259% S0.00% 16.32% 8560% 1541% S4.52% 7.68% 4.52%  788%
Allen. Stephanie 57 64%| 6370% -823% 6207% -518% -1471% 5286% -17.33% T024% -663% T7D.24% -663%
Aris, Melissa 57.67%| 64.10% 7.02% B4.74% 251% 56.39% ©000% B7.62% 257% 73.02% 2.05% 73.02% 2.85%)
Bahl, Riley 8205%| B571% 1360% 76.19% S04% T778% 1410% 0308% 2280% 0258% 1573% 0250% 1573%
Bowerman, Margaret 7479%| 82.65% 11.83% 71.57% 4.32% 6647% 270% 8533% 15.15% 01.11% 1425% O1.11% 14.25%
Branch. Nancy T0.62%|B172% O70% 70.31% 306% T375% 1007% 87.10% 1601% 9032% 1346% 0032% 1346%
Brunner, Kelley 50.80%| 82.93% 11.31% 73.44% E10% 74.84% 11.18% 87.10% 1A.01% S.58% 1272% 80.58% 1272%
Burch, Kali 74.18%| 78.85% 6.82% 76.28% 0.03% 66.15% 2142% -0.95% T78.21% 1.34% 7B.21%  1.34%
Chri B276%| 6250% -2.52% 60.71% -£.54% 58.57% 511% £475% 7024% -8.62% 70.24% -6.63%
Davis, Nathan 63.55%| 70.00% -1.04% 64.04% -2.31% 5020% 4.30% 0.65% 80.00% 3.14% 80.00%  3.14%
Epting. Kersiin 63.02%| 07.78% 4.25% 6146% -570% 6188% -1.80% -1.52% T111% -5.75% 71.11% -575%
Garrett, Barbara 55.71%| 62.32% -0.70% 54.67% -12.58% 40.60% -14.08% 57.30% -12.70% 68.12% -8.75% 68.12% -8.75%
Howsy. Beth 50.02%| B0.15% 12.13% B3.33% 10.08% 7545% 1178% 83.64% 1345% 03.04% 17.07% B3.84% 17.07%
| Jolin, Josh 64.81%| 65.43% -0.50% B63.58% -2.67% 63.08% -0.60% 6538% 4.80% 70.37% -6.40% 70.37% -0.40%
Madsan. Doug 80.37%| 75.60% 357% 70.83% 258% 57.14% -553% 6286% 7.33% 7262% 405% 7262% —425%
Malin, Randi B60.06%| 71.80% -0.42% B68.52% 1.27% 60.74% -204% B444% 574% 77.78% 001% 77.78% 0.01%
McKenna, Travis 58.07%| 56.04% -1508% 5278% -1447% 5455% -013% 6288% -7.33% 6067% -1020% 06.67% -1020%
Sabye, Gennifer 71.87%| 75.00% 208% 71.81% 4.20% 6645% 277% 70.65% 046% 78.12% 1.26% 78.12% 1.26%
Shaw, Kafie B457%| BBOT¥ 1004% 780D% 1075% 7520% 1152% 8800% 1781% 0200% 1514% 0200% 15 14%
Smith, Colleen 73.63%| 7244%  0.41% 68.03% 1.23% 70.00% 6.32% 7760% 7.51% S206% 5.10% 8205%  5.10%
Smith, Debbie B408%| BB51% 1048% 7874% 1148% 7310% 043% 8483% 14064% O770% 2084% O7.70% 20 84%
Sunil, Usha 61.05%| 64.97% 7.88% 63.70% -246% 50.62% 508% 66.15% 4.03% 78.02% 008% 76.02%  0.06%
Syhvia, Tyson B8132%| BBO7% 1404% 7600% 875% 7760% 1307% 0040% 2021% 9200% 1514% 0200% 15 14%
Thursam, Jeff 70.75%| 74.60% 255% 60.70% 245% T7143% 7.75% 8105% 10.67% S1.67% 450% O1.67%  4.80%
| Tobin, Denise 53.63%| 63.10% -803% B6250% -475% 5280% -1088% 5583% -14.35% 6173% -1514% 61.73% -15 14%
Vilari, Jess 43.57%| 54.35% —17.88% 50.57% -15.50% 40.00% -14.50% 55.70% -14.40% 57.58% -10.00% 57.58% -10.20%
Weismann, Marcy 5034%| 6200% -1002% 5760% -056% 5815% -752% 6600% -410% T7246% -440% 7246% -240%
Williams, Kevin 57.54%| B478% 7.28% 61.57% -588% 60.00% -2.65% B581% 4.38% T157% -5.0% 7157% -5.90%
Yglecias, Greg B8122%| B580% 1378% B8210% 1485% 68809% 521% 7333% 315% 0250% 1573% 0250% 1573%
08/14/2012 4:08 PM Edupaint School District Page 205
ASMT603 Output (page 2)
I Adams Elementary ;‘;:gé";gég&g
)( School Scheduled Instance
Dema Schoel District By Teacher
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 0712412018 - 05/24/2019
83P01 | @aPo2z | 83P03 | 63PO4 | B3PO5Sc | 63POG
[Teacner | Teacherawg| S| DR| Stase| o S|  on| S| o sww| o sww| o
|Yorio, Stephanie | 54.80%| 83.33% 11.31% 78.57% 11.32% S0.00% 16.32% 8671% 15.53% 0524% 12.37% 05.24% 18.37%
08/14/2018 4:08 PM Edupsint School District Page2of5
ASMT603 Output (page 3)




Assessment User Guide

Chapter 9: Reports 317

Year: 2018 - 2019
Adams Elementary it
School Scheduled Instance
By Teacher
Analysis Band Dats
Grade 3 Science Diagnostic my band 4 071247218 - 0512472019
6.3P0 1 Identify the sources of water within an environment (e.g., ground 72 . 02 0/;)
water, surface water, atmospheric water, glaciers).
0% 20% 40% 60% a0% 100%
67.25%
63P0O2 Describe the disfribution of water on the Earih’s surface. -
0% 20% 40% 8% 0% 100%
63P02 Differentiate between weather and climate as they relate to the 63 _68(%)
southwestern United States_
0% 20% 40% 80% a0% 100%
3P0 4 Measure changes in weather (e.g., precipitation, wind speed, 70 1 9%
barometric pressure).

0% 20% 40% 80% 0% 100%
0R/14/2018 4:08 PM Edupaint School District Fage4of5
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A Adams Elementary Year: 2018 - 2019
\. - Report: ASMTE03
e School Scheduled Instance
By Teacher
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05242019

0,
6.3.PO5c precipitation 76-86 A)

0% 0% 40% 60% 80% 100%

Compare weather conditions in various locations (e_g., regions of 0,
6.3.POB Arizona, various U.S. cities, coastal vs. interior geographical 76'86 /0
regions).
0% 20% 40% 80% 0% 100%
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ASMT604 — Teacher Overall Performance

Comparison of Teacher, School and District Averages

i

Adams Elementary

Year: 2016 -2018

\/u Teacher Overall Performance Report: ASMTEDS
Demo, Schosl Dstric
Assessment Date
Grade 3 Science Diagnostic 071242018 - 057247219
Teacher Teacher % School Avg % School Delta District Avg % District Delta
Burch, Kali 74.18% §1.00% 13.17% B7.55% 6.63%
Burghardt, Christopher 62.76% 61.00% 1.75% B7.55% -4.79%
Carroll, Natalie D.00%, 61.00% -51.00% B7.55% -67.55%
Davis, Nathan 63.55% 61.00% 2.55% 67.55% -4.00%
Epting, Kerstin 63.62% 61.00% 261% B67.55% -3.93%
McKenna, Travis 58.6T% 61.00% -2.33% B7.55% -B.87%
Sabye, Gennifer 71.87T% 61.00% 10.87% B7.55% 4.33%
Shaw, Katie B84 57% 61.00% 2357% B7.55% 17.03%
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ASMTG605 - Site Assessment Standards

Standards performance at school level

ST
D-mu.sd!wl District
Assessment
‘Grade 3 Science Diagnostic
F D
0% - 59.89% 80% - B2.98%

63PO1

6.3P0O2

63P0O3

6.3.PO4

63PO5e |

63PO6

Year: 2018 - 2019

Adams Elementary Report: ASMT605

Site Assessment Standards

Date
07/24/2018 - 05/24/2019

Analysis Band
District Grading Policy

61%

Average

B
B0% - B0 00%

C
TO% - 7999%

261
Total
Students
A

09/14/2015 &:30 AM
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I Adams Elementary Year. 2018 - 2019
)«( Site Assessment Standards Report ASMITA0S
Demo Schaol District
Assessment Analysis Band Date
Grade 3 Science Diagnostic District Grading Policy 07/24/2018 - 05/242019
Student Standard Score Weighted Distribution
53F01 @] ‘
63P0O2 . ‘
63P03 . ‘
63P04 . ‘
0% 1E:% 2[:% 30:% 4(;% 50‘% BDI% 7I.’:5f. Bd% Ed% IDD%I
00/14/2018 8:30 AM Edupoint School District Page 20of 2
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ASMT606 — Assessment Summary by Item Type

Analysis of item types at the teacher level

i Adams Elementary
‘Year: 2018 - 2019
)g( Assessment Summary by ltem Type Repor: ASMTE06
Demo School District
e, Shiogl Dty
Test Name Analysis Band
‘Grade 3 Science Diagnostic District Grading Policy
F D C B A
0% - 50.00% 80% - 60.00% T0% -70.00% B80% - 80.00% 0% - 100%
Questions by Item Types Test Result by Item Types
100%
3-HT
M5 0%
8%
4 B5.18% 64.86% X
e B4.50% £0.85%
1TE  gom -
14 Questions %
40%
3% -
20%
10%
% -
Hot Text Multiple Choice Text Entry
Teacher Hot Text| Multiple Choice| Multiple Select
Burch, Kali Anderson, Sean 100.00% 100.00% 100.00%
Bunton, Christopher 100.00% 100.00% 100.00%
Delgadillo Gonza, Emest 100.00% 100.00% 100.00%
Espino, Pamela 100.00% 100.00% 100.00%
Espinoza, Andrew 100.00% 100.00% 100.00%
Estrada Gonzalez, Helen 92.86% 100.00% 87.50%
09/21/2018 2:43 PM Edupoint School District Page 1of 11
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I Adams Elementary
M Assessment Summary by ltem Type mﬁmﬁg
Demo School District

Test Name Analysis Band

Grade 3 Science Di i District Grading Policy

Teacher Hot Text| Multiple Choice| Multiple Select Text Entry
Garcia, Karen 100.00% 100.00% 100.00%
Saldivar, Billy 100.00% 100.00%
Sanchez, Shawn 100.00%
Sanchez, Walter 0.00%
Silago, Donald 0.00%
Simpson, Kevin 0.00%
Sims, Daniel 100.00% 0.00%
Singley, Adam 100.00% 0.00%
Soto, Thomas 0.00%
Stacey, Rommel 100.00%
Stamp, Norma i .0 100.00%
Suarez, Tina 0 100.00'
Tafoya, Juan 100.00% 100.00%
Tautimer, Carl 50.00% 100.00%
Thomas, Mary 50.00% 100.00%
Tohee, Kenneth 50.00% 100.00%
Torres, Diane 50.00% 100.00%
Torres, Randy 0.00% 0.00%
Tran, Arthur 0.00% 0.00%

gl , Chri Acuna, Annig 0.00% 0.00%

Amador, Gregory 0.00% 0.00%
Bamrera Melo, Debra 0.00% 0.00%
Celaya, Karen 0.00% 0.00%
Charley, Brian 0.00% 0.00%
Daggett, Jose 0.00% 0.00%
Dunnuck, Deborah 50.00% 100.00%
Frausto, Sean 50.00%
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ASMT701 - District Scheduled Instance

Analysis by Gender and Ethnicity and overall standards performance

i Edupoint School District Year: 2018 - 2019
Re - ASMT701
pX| District Scheduled Instance sport
Demo, Shosl Disict
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 0772412018 - 05/24/2019
70.08%
Low Medium High Average
0% - 49% 50% - 74% 75% - 100%
236 460
Students Per Analysis Band
Gender / Analysis Bands Ethnicity / Analysis Bands
| I [l American Indian or Alaska Mative [l Asian [ Hispanic || Native Hawaiian or Other Pacific Islander  [1] White
M

High

Medium

Low Medium High

03/11/2019 5:39 PM Edupoint School District Page 10f 3
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Assessment
Grade 3 Science Diagnostic

Edupoint School District
District Scheduled Instance

Analysis Band
my band 1

73.73%

Year: 2018 - 2019
Report: ASMT701

Date
07/24/2018 - 05/24/2019

Identify the sources of water within an envirenment (e.g., ground
6.3P0O1 . -
water, surface water, atmospheric water, glaciers).
0% 20% 40% 60% 80% 100%
68.29%
6.3.PO2 Describe the distribution of water on the Earth’s surface. "
0% 20% 40% 60% 80% 100%
63P03 Differentiate between weather and climate as they relate to the 65 020/0
- southwestern United States.
0% 20% 40% 60% 80% 100%
63P04 Measure changes in weather (e.g., precipitation, wind speed, 73290/0
barometric pressure).
0% 20% 40% 60% 80% 100%
03/11/2019 5:39 PM Edupoint School District Page 2 of 3
ASMT701 Output (page 2)
Edupoint School District EZ:;:DASM%?
District Scheduled Instance )
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019
0,
6.3P0O5.c precipitation 80'02 /D
0% 20% 40% 60% 80% 100%
Compare weather conditions in various locations (e.g., regions of 80 020/
63PO6 Arizona, various U.5. cities, coastal vs. interior geographical - o
regions).
0% 20% 40% 60% 80% 100%
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ASMT702 — District Scheduled Instance By School

Analysis by Gender and Ethnicity and Standards comparison by schools

i iatri Year: 2018 - 2019
\J\._ I_Edt.!polnt School District Report ASMIT702
L District Scheduled Instance
Domp,Schosl Diririct By School
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24i2018 - 05/24/2019
70.08%
Low Medium High Average
0% - 49% 50% - T4% 75% - 100%
236 460
Students Per Analysis Band
Gender / Analysis Bands Ethnicity / Analysis Bands
| I [l American Indian or Alaska Native  [Jiij Asian [ Hispanic || Nafive Hawaiian or Other Pacific Islander  [[] White
L
High
Medium
Low
0 1(‘10 2f‘lﬂ Low Medium High
03/11/2019 5:33 PM Edupoint School Disfrict Page 10f 4
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\j\_‘ Edupoint School District ‘é""’":“;ghﬁ_"fgg
. eport:
1 District Scheduled Instance
Demo School District By School
Eresiince in Educsion
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019
63PO1 | 63PO2 | 63PO3 | 63P0O4 | 63PD5c | 63RO
School | SchoolAvg. Std%| Diff| Sid%| Diff| Sid%| Diff| Sd%| Diff| Sd% Diff| Sd% Dift
Adams Elementary 68.76% 72.15% -158% 67.39% -090% 63.84% -1.18% 70.32% -2.97% 76.97% -3.05% 76.97% -3.05%
Grant Elementary | 69.91%_ 73.41%_ -0.32% 69.10% 0.81% 64.93% -0.09% 72.17%_ -1.12% 80.37% 0.35% 80.37% 0.35%_
Jefferson Elementary 7263% 76.06% 233% 69.38% 110% 67.82% 279% 76.42% 3.13% 8274% 272% 8274% 272%
Washington Elementary 69.30% 73.63% -0.10% B67.40% -0.89% 63.68% -1.34% 74.76% 1.47% 80.45% 0.44% 80.45% 0.44%
03/11/2019 5:39 PM Edupoint School District Page 2 of 4
ASMT702 Output (page 2)
Edupoint School District ;"“;"};‘;ﬁ_ﬂn‘g
- eport:
District Scheduled Instance
By School
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019
Identify the sources of water within an environment (e.g.. ground 73 730/0
63PO1 . .
water, surface water, atmospheric water, glaciers).
0% 20% 40% 60% 80% 100%
0,
63P02 Describe the distribution of water on the Earth’s surface. 6829 /0
0% 20% 40% 60% 80% 100%
§3P03 Differentiate between weather and climate as they relate to the 65 020/0
southwestern United States.
0% 20% 40% 60% 80% 100%
§3P04 Measure changes in weather (e.g., precipitation, wind speed, 73290/0
- barometric pressure).
0% 20% 40% 60% 80% 100%
0371172019 5:39 PM Edupaoint School District Page 3of 4
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Year: 2018 - 2019

\,'A__ Edupoint School District Report ASVIT702
1l District Scheduled Instance )
Demo School District By School
Excellence In Education
Assessment Analysis Band Date
‘Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019
0,
6.3P0O5.c precipitation 80'02 /0
0% 20% 40% 60% 80% 100%
Compare weather conditions in various locations (e.g., regions of 0
6.3P0O6 Arizona, various U.S. cities, coastal vs. interior geographical 80‘02 /0
regions).
0% 20% 40% 60% 0% 100%
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ASMT703 — District Scheduled Instance By Teacher

Analysis by Gender and Ethnicity and Teacher level Standards comparison

I Edupoint School District Vear 2018 - 2019
Report ASMT703
X District Scheduled Instance e
Do SeranL e By Teacher
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 072412018 - 05/24/2019
70.08%
Low Medium High Average
0% - 49% 50% - 74% 75% - 100%
236 460
Students Per Analysis Band
Gender / Analysis Bands Ethnicity / Analysis Bands
I F [ American Indian or Alaska Mative [l Asian [ Hispanic [ Mative Hawaiian or Other Pacific Islander [ White

L
High

Medium

Low Medium High
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i
PR

Edupcint School District
District Scheduled Instance

Year 2018 - 2019
Report: ASMT703

Dems School Dist By Teacher
Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019

6.3.P0 1 6.3.P02 6.3.P03 6.3.P0 4 6.3.P0 5.c 6.3.P06
Teacher Schoal Teacher Avg. | Sd%| Dt St Dt  Std%|  Diff| Sid%| Dt Swd%| Dt Sd% Dt
Adrich, Heidi | Grant Elsmentary 75.77% | 7500% 127% 7083% 254% 8000% 1495% B8560% 1231% BAEM% 451% BASM%  451%
Allen, Stephanie | Grant Elementary 57.64% | BaTo% -994% B207% -672% -16.06% 5286% -2043% T0.24% -978% 7024% -9.78%
Aris, Melissa |Washington Elementary 59.89% 64.10% -9.63% ©4.74% -3.55% 55.38% -964% 67.62% -5.67% 73.02% -7.00% 73.02% -7.00%
Bahl, Riley Grant Elementary 52.65% 8571% 11.98% 76.19% 7.90% 77.76% 1275% 93.08% 1978% 9259% 1250% 9259% 12.56%

Margaret | Washi y |7479% | 8a385% 1012% 7T157% 308% 6647% 145% 8533% 1204% 9111% 1109% 9111% 1108%
Branch, Nancy |Washington Elementary | 79.02% | B172% 799% T031% 202% T7375% 673% 8710% 1380% S032% 1031% 9032% 1031%
Brunner, Kelley |Washington Elementary | 80.80% | 8333% 960% 73.44% 5.14% 7434% 081% 87.10% 1350% B958% O057% 8058% 057%
Burch, Kali Adams Elementary 74.18% | 7885% 5.12% 76.28% 7.99% 6615% 1.13% 69.23% -406% 78.21% -1.81% T7821% -181%
Burghardt, Christopher | Adams Elementary 62.76% | 6250% 1123% 6071% 756% SB57% 645% 60.71% 1258% 7024% 978% 7024% 978%
Carroll, Natalie | Adams Elementary 10000% | 100.00% 2627% 10000% 3171% 10000% 3495% 10000% 2671% 10000% 1995% 100.00% 1995%
Cordova, Kalie | Adams Elementary 84.57% | BB6T% 1494% 7B00% O71% 7520% 10.18% 8800% 1471% 9200% 1193% 9200% 1198%
Davis, Nathan Adams Elementary 63.55% | 7099% -274% 6494% -335% 5029% 574% 7033% -246% 80.00% -0.02% £000% -0.02%
Eping, Kerstin Adams Elementary 63.62% 6778% -595% ©146% -6.83% 6188% -3.15% 6B67% -463% 7111% -891% 7111% -891%
Garrett, Barbara |Jeflerson Elementary 55.71% 6232% -11.41% 54.67% -1363% 49.60% -1542% 57.39% -1590% 68.12% -11.90% 68.12% -11.90%
Howey, Beth |Jeflerson Elementary  86.69% 90.15% 16.42% 83.33% 15.04% 7545% 1043% 83.64% 10.34% 93.04% 13.92% 9394% 13.92%
Jolin, Josh Jefierson Elementary | 64.81% | 6543% -5.30% 63.58% -471% 6308% -195% ©538% -791% 70.37% -965% T03ITH -9.65%
Madson, Doug Grant Elementary 63.37% 75.60% 1.06% 70.83% 2.54% 57.14% 7.90% ©62.80% -1043% 7262% T.40% T262% -7.40%
Malin, Randi |Washington Elementary |69 05% | 7160% 213% B55% 003% 6074% 475% 6444% 585% TT78% 204% T778% 224%
MeKenna, Travis | Adams Elementary 58.67% 56.94% -16.79% 52.78% -15.51% 54.55% -1043% 62.86% -10.43% 66.67% -13.35% 66.67% -13.35%
Sabye, Gennifer Adams Elementary 71.87% 75.00% 127% 7161% 3.32% 66.45% 143% 70.65% -265% 78.12% -1.80% T7B.12% -1.89%
Smith, Colleen Grant Elementary 73.63% | 7244% -129% 66.03% -227% T7000% 496% 77.69% 440% B205% 204% G205% 204%
Smith, Debbie |Jeflerson Elementary | 54.95% | BB51% 1477% 78T4% 1044% 7310% G08% 8433% 1154% OT70% 1763% S770% 1768%
Sunil, Usha | Grant Elementary 61.08% | B437% -936% B379% -450% SG62% -640% 6615% -714% TBO2% -309% TR -309%
Sylvia, Tyson Jefierson Elementary | 84.57% 86.67% 12.94% 76.00% 7.71% 77.60% 1258% 90.40% 17.11% 92.00% 11.98% 9200% 11.98%
Thursam, Jeff Jefierson Elementary | 70.78% | 7460% 087% €9.70% 140% T143% G640% B105% 776% B167% 165% B167% 165%
Tobin, Denise |Washington Elemsntary  56.63% 63.10% -10.64% ©250% -579% 5280% -1222% 5583% -17.46% 6173% -18.20% 61.73% -18.29%
Vilani, Jess |Jeflerson Elementary | 48.57% 5435% -19.38% 50.67% -17.63% 49.09% -1593% S5579% -17.50% 57.58% -2244% 57.58% -22.44%
Weismann, Marcy |Washington Elementary 59.34% 62.00% -11.73% 57.69% -10.60% 56.15% -8.87% ©6.09% -7.20% 72.46% -7.55% 7246% -7.55%
Williams, Kevin Grant Elementary 57.54% 6476% -3.97% ©1.57% -6.72% 60.00% -5.02% ©581% -7.4%% 7157% -8.45% T157% -B.45%
0371212019 9:06 AM Edupoint School District Page 2 of §
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District Scheduled Instance oo
By Teacher

Assessment Analysis Band Date
Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019

6.3.PC 1 6.3.P02 6.3.P03 6.3.F04 6.3.P0 5.c 6.3.F06
Teacher |Schaol Teacher Avg Sid%| Df| SwW% D SW%  Df| SiW%| Dif| Sw% D SW% Dl
Yglecias, Greg | Grant Elementary 81.22% | 8580% 1207% 8210% 13.81% 68.80% 3.87% 7333% 004% 9259% 1253% 9250% 1258%
Yorio, Stephanie Jefierson Elementary | 84.69% | 8333% 960% 7BST% 1023% E000% 1496% B571% 1242% 9524% 1522% 9524% 1522%
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e

Demo Sch

Ercellence I

Assessment

Edupoint School District
District Scheduled Instance
By Teacher

Grade 3 Science Diagnostic

Identify the sources of water within an environment (e.g., ground

Analysis Band
my band 1

73.73%

Year: 2018 - 2019
Report: ASMT703

Date
07/24/2018 - 05/24/2019

63P01 water, surface water, atmospheric water, glaciers)
0% 20% 40% 60% 80% 100%
0,
63P02 Describe the distribution of water on the Earth’s surface 6829 /0
0% 20% 40% 60% 80% 100%
63P03 Differentiate between weather and climate as they relate to the 65 . 02‘%}
: southwestern United States.
0% 20% 0% 60% 80% 100%
53P0 4 Measure changes in weather (e.g., precipitation, wind speed, 73290/0
. barometric pressure).
0% 20% 40% 60% 80% 100%
03112/2019 9:06 AM Edupoint School District Page 4 of 5
ASMT703 Output (page 4)
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1 District Scheduled Instance )
By Teacher
Assessment Analysis Band Date
‘Grade 3 Science Diagnostic my band 1 07/24/2018 - 05/24/2019
0
63 P0O5c precipitation 80'02 A)
0% 20% 40% 60% 80% 100%
Compare weather conditions in various locations (.g., regions of 80 020/
6.3.PO6 Arizona, various U.S. cities, coastal vs. interior geographical . o
regions).
0% 20% 40% 60% 80% 100%
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ASMT704 — Teacher Overall Performance

Comparison of Teacher, School, and District Averages

\j;‘ Edupoint School District ;Z:;;D;‘SM%%?;
I Teacher Overall Performance )
Demeo Schoal District
School Assessment Date
All Grade J Science Diagnostic 0772412018 - 05/24/2019
School Teacher Teacher % School Avg %  School Delta District Avg %  District Delta
Adams Elementary Burch, Kali 74.18% 70.08% 4.09% 70.08% 4.09%
Adams Elementary Burghardt, Christopher 62.76%| 70.08% -7.33% 70.08% -7.33%
Adams Elementary Carroll, Natalia 100.00% 70.08% 29.92% 70.08% 29.92%
Adams Elementary Cordova, Katie 84.57%| 70.08% 14.49% 70.08% 14.49%
Adams Elementary Davis, Nathan 63.55% 70.08% -6.54% 70.08% -6 54%
Adams Elementary Epting, Kerstin 63.62%| 70.08% -6.47% 70.08% -6.47%
Adams Elementary McKenna, Travis 58 67% 70.08% -11.41% 70.08% -11.41%
Adams Elementary Sabye, Gennifer 71.87%| 70.08% 1.79%)| 70.08% 1.79%
Grant Elementary Aldrich, Heidi 75.77% 70.08% 568% 70.08% 568%
Grant Elementary Allen, Stephanie 57.64% 70.08% -12.45% 70.08% -12.45%
Grant Elementary Bahl, Riley 82.65% 70.08% 1257% 70.08% 1257%
Grant Elementary Madson, Doug 68.37%| 70.08% -1.72% 70.08% -1.72%
Grant Elementary Smith, Colleen 73.63% 70.08% 354% 70.08% 354%
Grant Elementary Sunil, Usha 61.08%| 70.08% -9.00% 70.08%, -9.00%
Grant Elementary Williams, Kevin 57.54% 70.08% -1254% 70.08% -12.54%
Grant Elementary Yglecias, Greg 81.22%| 70.08% 11.13%, 70.08% 11.13%
Jefferson Elementary Garrett, Barbara 55.71% 70.08% -1437% 70.08% -1437%
Jefferson Elementary Howey, Beth 86.69%| 70.08% 16.61%, 70.08% 16.61%
Jefferson Elementary Jolin, Josh 64.81% 70.08% -527T% 70.08% -527%
Jefferson Elementary Smith, Debbie 84.98% 70.08% 14.89% 70.08%, 14.89%
Jefferson Elementary Sylvia, Tyson 84.57% 70.08% 14.49% 70.08% 14.49%
Jefferson Elementary Thursam, Jeff 70.78%| 70.08% 0.70%/ 70.08% 0.70%
Jefferson Elementary Vilani, Jess 48 57% 70.08% -2151% 70.08% -2151%
03/11/2019 5:39 PM Edupeint School District Page 10f2
ASMT704 Output (page 1)

Copyright 2015-2019 Edupoint Educational Systems, LLC



Assessment User Guide

332 Chapter 9: Reports

\{; Edupoint School District ;z:;i“;gﬁf%z
-~ Teacher Overall Performance )
Demo Sch

Ertalismen I &
School Assessment Date
All Grade 3 Science Diagnostic 07/24/2018 - 05/24/2019
School Teacher Teacher % School Avg %  School Delta District Avg % District Delta
Jefferson Elementary Yorio, Stephanie 84.69%| 70.08% 14.61%, 70.08%)| 14.61%
Washington Elementary Aris, Melissa 59.89% 70.08% -10.19% 70.08%!| -10.19%
Washington Elementary Bowerman, Margaret T4.79% 70.08% 471%)| 70.08%| 471%
Washington Elementary Branch, Nancy 79.02%) 70.08% 8.94% 70.08%)| 8.94%
Washington Elementary Brunner, Kelley 80.80%| 70.08% 10.72% 70.08%| 10.72%
Washington Elementary Malin, Randi 69.05%) 70.08% -1.03% 70.08%| -1.03%
Washington Elementary Tobin, Denise 56.63% 70.08% -13.45% 70.08% -13.45%
Washington Elementary Weismann, Marcy 59.34%| 70.08% -10.74% 70.08%)| -10.74%
031172019 5:39 PM Edupoint School District Page 2 of 2
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ASMT705 — Student Overall Performance

Student performance compared to Class Averages

Edupoint School District ngf;gﬁéi
Student Overall Performance )
Assessment Date
Grade 3 Science Diagnostic 07/24/2018 - 05242019
Class Student 1] Student % Class Average % Delta
Sabye, G 4th Grade(1) - 0426 Miranda- Shirley 797 64.29% 61.83% 2.46%
Sabye, G 4th Grade(1) - D436 Meza- Ruby 796 35.71% 61.83% -26.12%
Sabye, G 4th Grade(1) - 0426 Mendez Garcia- Gloria 795 T143% 61.83% 9.60%
Sabye, G 4th Grade(1) - 0436 Mejia- Mildred 794 T1.43% 61.83% 9.60%
Sabye, G 4th Grade(1) - 0426 Medlin- Carlos 793 TE.57% 61.83% 16.74%
Sabye, G 4th Grade(1) - 0436 Medina- Cheryl 792 T8.5T% 61.83% 16.74%
Sabye, G 4th Grade(1) - 0426 Mathers- Rebecca 791 TE.57% 61.83% 16.74%
Sabye, G 4th Grade(1) - 0436 MacHado- Ernest 790 64.29% 61.83% 2.46%
Sabye, G 4th Grade(1) - 0436 Ludwig- Jean 789 35.71% 61.83% -26.12%
Sabye, G 4th Grade(1) - 0436 Loza- Charles 788 35.71% 61.83% -26.12%
Sabye, G 4th Grade(1) - 0436 Lowery- Carl 787 T1.43% 61.83% 9.60%
Sabye, G 4th Grade(1) - 0436 Lopez- Judith 786 T1.43% 61.83% 9.60%
Sabye, G 4th Grade(1) - 0436 Longoria- Sean 785 57.14% 61.83% -4.69%
Sabye, G 4th Grade(1) - 0436 Leigh- Daniel 784 57.14% 61.83% -4.69%
Sabye, G 4th Grade(1) - 0436 Ledezma- Todd 783 64.29% 61.83% 2.46%
Sabye, G 4th Grade(1) - 0436 Laird- Jane 782 64.29% 61.83% 2.46%
Sabye, G 4th Grade(1) - 0436 Lafnear- Lisa 781 57.14% 61.83% -4.69%
Sabye, G 4th Grade(1) - 0436 Ketchum- Karen 780 57.14% 61.83% -4.69%
Sabye, G 4th Grade(1) - 0436 Jones- Diana 778 100.00% 61.83% 3B.17%
Sabye, G 4th Grade(1) - 0436 Jones Davis- Alice 779 100.00% 61.83% 38.17%
Sabye, G 4th Grade(1) - 0426 Guerra- Aaron 777 TE.57% 61.83% 16.74%
Sabye, G 4th Grade(1) - 0436 ‘Grover- Louise 776 T8.5T% 61.83% 16.74%
Sabye, G 4th Grade(1) - 0426 Garcia Aguilar- George 775 14.29% 61.83% -A7.54%
08/14/2015 8:36 AM Edupoint School District Page 1of3
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Edupoint School District
Student Overall Performance

Year: 2018 - 2019
Report: ASMT705

Assessment Date
Grade 3 Science Diagnosfic 07/24/218 - 0524219
Class Student 1D Student % Class Average % Delta
Sabye, G 4th Grade(1) - 0436 Dillen- Walter 774 14.29% 61.83% -47.54%
Sabye, G 4th Grade(1) - 0426 Diaz- Kathy 773 T143% 61.83% 9.60%
Sabye, G 4th Grade(1) - 0436 Chavamia- Julie iz 71.43% 61.83% 9.60%
Sabye, G 4th Grade(1) - 0436 Celaya- Julie 7 T143% 61.83% 9.60%
Sabye, G 4th Grade(1) - 0436 Buchanon- Angela 7o 100.00% 61.83% 38.17%
Sabye, G 4th Grade(1) - 0436 Brown- Carl 769 28.57% 61.83% -33.26%
Sabye, G 4th Grade(1) - 0436 Avalos Vazquez- Jessica 768 28.57T% 61.83% -33.26%
Sabye, G 4th Grade(1) - 0436 Amonsot- Sarah 767 28.5T% 61.83% -33.26%
Sabye, G 4th Grade(1) - 0436 Aguirre- Kathy 766 78.57% £1.83% 16.74%
Sabye, G 4th Grade(1) - 0443 Yazzie- Nicole 293 T1.43% 81.92% -10.49%
Sabye, G 4th Grade(1) - 0443 Tarres- Alice 230 T857% 81.92% -3.35%
Sabye, G 4th Grade(1) - 0443 Thompson- Rose 289 TBET% 81.92% -3.35%
Sabye, G 4th Grade(1) - 0443 Tetter- Carolyn 288 T8.5T% 81.92% -3.35%
Sabye, G 4th Grade(1) - 0443 Taylor- Emest 287 52.86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Tanori- Helen 286 B5.71% 81.92% 3.79%
Sabye, G 4th Grade(1) - 0443 Stewart- Beverly 285 52 86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 ‘Soriano- Brian 284 92.86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Smith- Juan 283 92.86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Senteno- Jason 282 100.00% 81.92% 18.08%
Sabye, G 4th Grade(1) - 0443 Segura- Jose 281 100.00% 81.92% 18.08%
Sabye, G 4th Grade(1) - 0443 Santos- John 280 92 86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Sandoval- Kathleen 219 92.86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Saldana- Susan 278 92.86% 81.92% 10.94%
00/14/2018 2:38 AM Edupoint School District Page 20f3
ASMT705 Output (page 2)
Edupoint School District ;zzgf;gﬁég
Student Overall Performance )
Assessment Date
Grade 3 Science Diagnostic 0772472018 - 052472019
Class Student 1D Student % Class Average % Delta
Sabye, G 4th Grade(1) - 0443 Sakala- Julia 277 IET1% 81.92% -46.21%
Sabye, G 4th Grade(1) - 0443 Romero- Roger 276 3571% 81.92% 46 21%
Sabye, G 4th Grade(1) - 0443 Rojas Orozeo- Charles 275 78.5T% 81.92%| -3.35%
Sabye, G 4th Grade(1) - 0443 Raygoza- Michelle 274 T8.5T% 81.92% -3.35%
Sabye, G 4th Grade(1) - 0443 Rapisura- Ruby 273 85.71% 81.92% 379%
Sabye, G 4th Grade(1) - 0443 Ramos- Kevin 272 100.00% 81.92% 18.08%
Sabye, G 4th Grade(1) - 0443 Pounds- Lawrence 271 92.86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Gonzalez- Martha 270 T143% 81.92% -10.49%
Sabye, G 4th Grade(1) - 0443 Galindo Romero- Samuel 269 71.43% 81.92%| -10.49%
Sabye, G 4th Grade(1) - 0443 Finley- Lawrence 268 71.43% 81.92% -10.49%
Sabye, G 4th Grade(1) - 0443 Encinas- Kimberly 267 78.57T% 81.92% -3.35%
Sabye, G 4th Grade(1) - 0443 Duarte- Alice 266 92 86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Cohoe- Patrick 265 92.86% 81.92% 10.94%
Sabye, G 4th Grade(1) - 0443 Carranza Maclel- Shawn 264 85.71% 81.92%| 3.79%
Sabye, G 4th Grade(1) - 0443 Calles Iraheta- Daniel 263 100.00% 81.92% 18 .06%
Sabye, G 4th Grade(1) - 0443 Briand- Aaron 262 71.43% 81.92% -10.49%
Sabye, G 4th Grade(1) - 0443 Bonilla- Eric 261 T143% 81.92% -10.49%
Sabye, G 4th Grade(1) - 0443 Antonio Gonzalez- Frank 260 64 29% 81.92% -17 63%
00/14/2018 2:36 AM Edupoint School District Page3of3
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The Assessment Blueprint is an analysis of Item Types, Depth of Knowledge, and Standards that
will be assessed. You can access the blueprint from Assessment Details which you can access in

multiple ways.

I Edupoint School District
)-»f Synergy Assessment Blueprint
Deme, Schoe) Disiict
Test Mame Grade Subject
‘Grade 3 Science Diagnostic Grade 03 Science
DOK Summary
DOK Level ’&'.'::':;ﬁ; Percentage
1 (Recally 7 50.00%
2 (SkillConcept) 3 2143%
3 (Strategic Thinking) 3 21.43%
4 (Extended Thinking) 1 T14%
Total 14

21.43%

Item Type Summary

Number of
8
ftem Type Questions Percentage
Hot Text (HT) 3 21.43%

Multiple Choice (MC)
Multiple Select (MS)
Text Entry (TE)

] s714%
2 14.29%
1 TA4% ¢

Total

o

Report: ASMTTOT

Total Possible Points
14.00

I 1 (Recell)

2 (skilliConcept)
[ 3 (Stategic Thinking)
I ¢ (Extended Thinking)

8
3
‘H J
2
1
HT MC M5 TE

001472018 ©:07 AM

Edupoint School District

Page 10f5

ASMT707 Output (page 1)

Copyright 2015-2019 Edupoint Educational Systems, LLC



Assessment User Guide

336 Chapter 9: Reports

I Edupoint School District
\/-'\ Synergy Assessment Blueprint Report. ASMTTOT
Demo School
Test Name Grade Subject Total Possible Points
Grade 3 Science Diagnostic Grade 03 Science 14.00
Items Detail
Question # Standard Passage Title Item Type DOK Blooms Points
6.3P0O1
1 6.3P02 M3 2 1.00
6.3PO1
2 §3PO 2 M3 2 1.00
6.3.PO1
3 6.3P0 2 HT 2 1.00
6.3.P01
4 63P02 HIT 3 1.00
63P0O1
5 &3P0 2 HT 3 1.00
63P0O3
6 53P04 TE 3 1.00
83P0O3
T 63P04 MC 4 1.00
63P0O3
B8 53PO0 4 MC 1 1.00
6.3P0O3
9 63P04 MC 1 1.00
6.3 PO5.c
10 6.3P06 MC 1 1.00
B3PO5c
7 63POG MC 1 1.00
63PO5c
12 63POB MC 1 1.00
8.3P01
13 63P04 MC 1 1.00
6.3.P0O2
14 63P03 MC 1 1.00
00/14/2018 0:07 AM Edupoint School District Page 2of&
ASMT707 Output (page 2)
v Edupoint School District
\/-" Synergy Assessment Blueprint Report: ASMT707
Demo School District
Test Mame Grade Subject Total Possible Points
Grade 3 Science Diagnostic Grade 03 Science 14.00
Standards Summary
Number of
Code Standard Questions Percentage
6.3.PO5Sc precipitation 3 10.71%
63.PO2 Describe the distribution of water on the Earth's surface. [ 21.43%
63.PO6 Compare weather conditions in various locations (e.g., regions of Arizona, various U.5S. cities, coastal vs. interior 3 10.71%
geographical regions)
63.PO1 Identify the sources of water within an environment (e.g., ground water, surface water, atmospheric water, glaciers). 13 21.43%
6.3P0O4 Measure changes in weather (e.g., precipitation, wind speed, b fric pressure). 5 17.86%
6.3.PO3 Differentiate between weather and climate as they relate to the southwestern United States. 5 17.86%
001472018 ©:07 AM Edupoint School District Page2of§
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i Edupoint School District
\}J Synergy Assessment Blueprint Report ASMT707
Deme, School Bislrict
Test Name Grade Subject Total Possible Points:
‘Grade 3 Science Diagnostic Grade 03 Science 14.00
Standard by DOK Matrix
Count by DOK
Standard - Total | Percentage
1 2 3 4| Non Specified

63P0O3 3 1 1 5 17.86%

63P02 1 3 2 6 21.43%

6.3.PO5.C 3 3 10.71%

63PO4 3 1 1 5 17.86%

6.3PO6 3 3 10.71%

63 P01 1 3 2 6 21.43%
Total Standards 14 6 6 2 0 28 100.00%
08/14/2018 8:07 AM Edupoint School District Page 4 of 5
ASMT707 Output (page 4)

i Edupoint School District
\,J Synergy Assessment Blueprint Report. ASMT7OT
Demo Sehool District
Test Mame Grade Subject Total Possible Points
‘Grade 3 Science Diagnostic Grade 03 Science 14.00

Standard by ltem Type Matrix

Standard Count by Item Type Total
HT MC MS TE
53P01 3 1 2 6
53P02 3 1 2 6
6.3.P03 4 1 5
6.3.P0O4 4 1 5
6.3.PO5.C 3 3
6.3.PO6 3 3
Total Standards 6 16 4 2 28
09/14/2018 :07 AM Edupoint School District Page Sof 5
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ASMT708 — Assessment (District) Summary by Item Type

Analysis of Iltem Types assessed and performance detail by Student per School

V. Edupoint School District
AR Assessment Summary by Item Type i
Demio School Satia
Test Name Analysis Band
Grade 3 Science Diagnostic my band 1
Low Medium High
0.00% - 49 00% 50.00% - 7400% 75.00% - 100.00%
Questions by Item Types Test Result by Iltem Types

100%

69.92%
0%
60%
14 Questions e
40%
0%
20%
10% -f
0%
Multiple Choice
School Student ID Overall Multiple Choice
Adams El Y Acuna, Annie 731
Aguirre, Kathy 766 78.57% 78.57%
Amador, Gregory 732
Ambriz, Gregory 362
Amonsot, Sarah 767
Anderson, Sean 536 100.00% 100.00%
03/11/2019 5:38 PM Edupoint School District Page 10f32
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Edupoint School District
Assessment Summary by Item Type

Year: 2018 - 2019
Report: ASMT708

Deme,
Test Name Analysis Band
Grade 3 Science Diagnostic my band 1
School Student 1D Overall Multiple Choice
Andrade, Chris 593 50.00%) 50.00%
Antonio Gonzalez, Frank | 260 64.29% 64.29%
Arciva, Pamela 461 | 100.00% 100.00%
Avalos Vazquez, Jessica .768 | [
Ayon, Paula 462 78.57%) 78.57%
Baez, Todd 594 85.71% 8571%
Barraza, Ronald |595 | 100.00% 100.00%
Barrera Melo, Debra .733 | [
Barthlow, Cheryl /596 | 100.00% 100.00%
Beltran Del Rio, Jason |98 | 92.86% 92.86%
Bellran, Gary 597 92.86% 92.86%
Benallie, Kathleen 1363 |
Bogan, Carlos 365
Bonilla, Eric 261 71.43%) 71.43%
Briand, Aaron 262 71.43% 71.43%
Brown, Carl 1769 |
Brown, David 463 6429% 64.29%
Buchanon, Angela 770 100.00% 100.00%
Bunten, Christopher 1537 | 100.00% 100.00%
Burghardt, Christopher 136566 | 100.00% 100.00%
Cabrera, Joshua |99 | 92.86% 92 86%
Calles Iraheta, Daniel 263 | 100.00% 100.00%
Carmona, Helen .95 | [
Camanza Maclel, Shawn | 264 3571% 8571%
Celaya, Jose .464 64.29% 64.29%
Celaya, Julie 1771 7143% 71.43%
Celaya, Karen 734 |
Cerano, George 465 85.71% 8571%
031172019 5:39 PM Edupaoint School District Page 2 of 32
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ASMT708 Alt1 — Assessment (District) Summary by Item Type

Analysis of Iltem Types assessed and performance detail by Teacher per school

\J —
»
Demo Schoaol District

Test Name
Grade 3 Science Diagnostic

Low
0.00% - 49.00%

Questions by Item Types

Edupoint School District

Assessment Summary by Item Type Year 2018 - 2019

Report: ASMT708

Analysis Band
my band 1

Medium High
50.00% - 74.00% 75.00% - 100.00%

Test Result by Item Types

69.92%
70%
60%
1 14 Questions e
40%
30%
20%
10%
0%
Multiple Choice
School Teacher Overall Multiple Choice
Adams Elementary Burch, Kali 74.18% 74.18%
Burghardt, Christopher 62.76% 62.76%
Carroll, Natalie 100.00% 100.00%
Cordova, Katie 84.57% 84.57%
Davis, Nathan 63.55% 63.55%
Epting, Kerstin 63.62% 63.62%
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e Edupoint School District
R Assessment Summary by Item Type i
Do, Sehosi ke
Test Name Analysis Band
Grade 3 Science Diagnostic my band 1
School Teacher Overall Multiple Choice
McKenna, Travis 58 67%- h8.67%
Sabye, Gennifer 71.87% 71.88%
Grant Elementary Aldrich, Heidi T5.77% T5.77%
Allen, Stephanie 57.64% 57.64%
Bahl, Riley 8265% 82.65%
Madson, Doug 68.37% 68.37%
Smith, Colleen T363% 73.63%
Sunil, Usha 61.08% 61.08%
Williams, Kevin 57.54% 57.54%
Yglecias, Greg 81.22% 81.22%
Jefferson Elementary .Garren, Barbara 55.71 %7 55.71%
Howey, Beth 86.69% 86.69%
Jolin, Josh 64.81% 64.81%
Smith, Debbie a4, 93%‘ 84.98%
Sylvia, Tyson 8457% 84.57%
Thursam, Jeff 70.78% 70.78%
Vilani, Jess I
Yorio, Stephanie 4. 69%‘ 84.69%
Washington Elementary | Aris, Melissa 59.89% 59.89%
Bowerman, Margaret 74.79% 74.79%
Branch, Nancy ri:} 02%‘ 79.02%
Brunner, Kelley 80 80%‘ 80.80%
Malin, Randi 69.05% 69.05%
Tobin, Denise 56.63% 56.63%
Weismann, Marcy 59.34% 59.34%
031172019 5:39 PM Edupaoint School District Page 2 of 2
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ASMT708 Alt2 — Assessment (District) Summary by Item Type

Analysis of Iltem Types assessed and performance detail by School

\J ~—
'
Demo School District

Test Name
Grade 3 Science Diagnostic

Low
0.00% - 49.00%

Questions by Item Types

Edupoint School District

Assessment Summary by Item Type Year: 2018 - 2019

Report: ASMT708

Analysis Band
my band 1
Medium High
50.00% - 74.00% 75.00% - 100.00%

Test Result by Item Types

100%

69.92%

0%

60%

14 Questions S

40%

30%

20%

10%

0%

Multiple Choice
School Overall Multiple Choice
Adams El y 68.76% 68.76%
Grant EI y 69.14% 69.14%
Jefferson El; y T2.77%! T2.77%
i El y 69.30%! 69.30%
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